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1.1 Informazioni su questo manuale

Figura 1-1: Il *bisogno* di manuali (xkcd.com).

Il Manuale dell'utente di MX è il prodotto di un grande gruppo di volontari della comunità di 
MX Linux. Come tale, conterrà inevitabilmente errori e omissioni, anche se abbiamo lavorato 
duramente per ridurli al minimo. Vi preghiamo di inviarci feedback, correzioni o suggerimenti 
utilizzando uno dei metodi elencati di seguito. Gli aggiornamenti avverranno secondo le 
necessità.

Questo manuale è stato progettato per guidare i nuovi utenti attraverso i passi per ottenere una 
copia di MX Linux, installarlo, configurarlo per lavorare con il proprio hardware e utilizzarlo 
quotidianamente. Si propone di fornire un'introduzione generale leggibile e privilegia gli 
strumenti grafici quando disponibili. Per argomenti dettagliati o poco frequenti, l'utente 
dovrebbe consultare il Wiki e altre risorse o postare sul forum di MX Linux.

MX Fluxbox non è incluso in questa sezione perché differisce talmente tanto da Xfce e KDE da 
allungare e complicare questo manuale. Ogni installazione di MX Fluxbox è accompagnata da 
un documento di aiuto separato.

I nuovi utenti potrebbero trovare alcuni dei termini utilizzati in questo manuale poco familiari o 
confusi. Abbiamo cercato di limitare l'uso di termini e concetti difficili, ma alcuni sono 
semplicemente inevitabili. Il Glossario che si trova alla fine del documento fornisce definizioni 
e commenti che aiutano a comprendere i passaggi più difficili.

Tutti i contenuti sono © 2021 di MX Linux Inc. e rilasciati sotto licenza GPLv3. La citazione deve essere letta:

Progetto di documentazione comunitaria MX Linux. 2023. Manuale d'uso di MX Linux.

Feedback:

• Email: manual AT mxlinux DOT org

• Forum: Documentazione e video MX

1 Introduzione

https://forum.mxlinux.org/
https://forum.mxlinux.org/viewforum.php?f=101


1.2 Informazioni su MX Linux

L'atteggiamento degli utenti nei confronti di MX Linux, o di qualsiasi altro sistema operativo, è 
molto vario. Alcuni desiderano semplicemente un apparecchio che funzioni, come una 
caffettiera che produce una bevanda calda su richiesta. Altri potrebbero essere curiosi di sapere 
come funziona effettivamente, cioè perché si ottiene il caffè e non una melma densa. Questa 
sezione ha lo scopo di orientare il secondo gruppo. Il primo gruppo potrebbe preferire saltare 
alla Sezione 1.3: "Informati!".

MX Linux è una versione desktop della fusione tra la raccolta di software libero GNU e il kernel 
Linux, entrambi nati all'inizio degli anni Novanta. GNU/Linux, o più semplicemente e 
comunemente chiamato "Linux", è un sistema operativo (OS) libero e open-source che ha un 
approccio unico e di grande successo a tutto ciò che riguarda il kernel, gli strumenti e la struttura 
dei file (Sezione 7). Viene fornito agli utenti attraverso distribuzioni o "distro", tra le quali una 
delle più antiche e popolari è Debian, su cui è costruito MX Linux.

1.2.1 Linux

Per fornire una rapida panoramica, ecco un diagramma e una descrizione semplificati di un 
sistema operativo Linux, adattati da Anatomy of the Linux kernel.

• In cima si trova lo spazio utente, noto anche come spazio delle applicazioni. Qui 
vengono eseguite le applicazioni utente fornite dalla distribuzione o aggiunte dall'utente. 
C'è anche l'interfaccia GNU C Library (glibc) che collega le applicazioni al kernel. (Da 
qui il nome alternativo "GNU/Linux" mostrato nel diagramma).

• Al di sotto dello spazio utente si trova lo spazio kernel, dove esiste il kernel Linux. Il 
kernel è dominato dai driver hardware.

Sistema di file

https://www.gnu.org/
https://en.wikipedia.org/wiki/Linux
https://en.wikipedia.org/wiki/Linux_distribution
https://en.wikipedia.org/wiki/Debian


Uno dei primi problemi con cui molti nuovi utenti di Linux si scontrano è il funzionamento del 
file system. Molti nuovi utenti hanno cercato invano di trovare l'unità C:\ o D:\, per esempio, ma 
Linux gestisce i dischi rigidi e gli altri supporti di memorizzazione in modo diverso da 
Windows. Invece di avere un albero di file system separato su ogni dispositivo, MX Linux ha un 
unico albero di file system (chiamato la radice del file system), che è indicato come "/" e 
contiene ogni dispositivo collegato. Quando un dispositivo di archiviazione viene aggiunto al 
sistema, il suo file system viene collegato a una directory o a una sottodirectory del file system; 
questa operazione si chiama montaggio di un'unità o di un dispositivo. Inoltre, ogni utente ha 
una sottodirectory dedicata sotto /home, e per impostazione predefinita è qui che si cercano i 
propri file. Per maggiori dettagli, vedere la Sezione 7.

La maggior parte delle impostazioni dei programmi e del sistema su MX Linux sono 
memorizzate in file di configurazione di testo semplice; non esiste un "registro" che richiede 
strumenti speciali per essere modificato. I file sono semplici elenchi di parametri e valori che 
descrivono il comportamento dei programmi all'avvio.

Attenzione

I nuovi utenti hanno aspettative derivanti dalla loro precedente esperienza. Questo è naturale, 
ma può portare all'inizio a confusione e frustrazione. Due nozioni fondamentali da tenere a 
mente:

1. MX Linux non è Windows. Come indicato in precedenza, non esiste un registro o 
un'unità C:\ e la maggior parte dei driver è già presente nel kernel.

2. MX Linux non è basato sulla famiglia Ubuntu, ma su Debian. Ciò significa che i 
comandi, i programmi e le applicazioni (soprattutto quelli contenuti negli "Archivi 
personali dei pacchetti" o PPA) della famiglia Ubuntu potrebbero non funzionare 
correttamente o addirittura mancare.

1.2.2 MX Linux

MX Linux, rilasciato per la prima volta nel 2014, è una collaborazione tra le comunità antiX ed 
ex MEPIS che utilizza i migliori strumenti e talenti di ciascuna distro e include il lavoro e le idee 
originariamente create da Warren Woodford. È un sistema operativo di peso medio progettato 
per combinare un desktop elegante ed efficiente con una configurazione semplice, un'elevata 
stabilità, prestazioni solide e un ingombro medio.

Facendo affidamento sull'eccellente lavoro upstream di Linux e della comunità open-source, 
con MX-23 distribuiamo il nostro fiore all'occhiello Xfce 4.18 come ambiente desktop, insieme 
a KDE/Plasma.
5.27. e Fluxbox 1.3.7 come versioni indipendenti separate. Tutti poggiano su una base Debian 
Stable (Debian 12, "Bookworm"), attingendo anche al nucleo del sistema antiX. I continui 
backport e le aggiunte esterne ai nostri repo servono a mantenere i componenti aggiornati con gli 
sviluppi richiesti dagli utenti.

L'MX Dev Team è composto da un gruppo di volontari con background, talenti e interessi 
diversi. Per i dettagli, vedere Chi siamo. Un ringraziamento speciale per il forte e continuo 
sostegno a questo progetto va ai Packager di MX Linux, ai produttori di video, ai nostri grandi 
volontari e a tutti i nostri traduttori!

https://antixlinux.com/
https://en.wikipedia.org/wiki/MEPIS
https://www.xfce.org/about/tour418
https://wiki.debian.org/DebianStable
https://mxlinux.org/about-us


1.3 Informatevi!

Le icone sul desktop rimandano a due documenti utili: le FAQ e il Manuale d'uso.



• Le FAQ forniscono un rapido orientamento ai nuovi utenti rispondendo alle domande 
più frequenti sul Forum.

• Il Manuale d'uso fornisce una panoramica dettagliata del sistema operativo. Poche 
persone lo leggono da cima a fondo, ma può essere consultato rapidamente 1) usando 
lo schema per saltare all'argomento generale che interessa, oppure 2) premendo Alt + 
F1 per aprirlo e Ctrl + F per cercare una voce particolare.

• Altre fonti di informazione sono il Forum, il Wiki, la raccolta di video online e vari 
account sui social media. Queste risorse sono più facilmente raggiungibili dalla pagina 
iniziale.

1.4 Supporto e EOL

Che tipo di supporto è disponibile per MX Linux? La risposta a questa domanda dipende dal 
tipo di supporto che si intende:

• Problemi basati sull'utente. Per MX Linux esiste una serie di meccanismi di 
supporto, da documenti e video a forum e motori di ricerca. Per maggiori dettagli, 
consultare la pagina del supporto comunitario.

• Hardware. L'hardware è supportato nel kernel, dove è in corso un continuo 
sviluppo. Un hardware molto nuovo potrebbe non essere ancora supportato e un 
hardware molto vecchio, anche se ancora supportato, potrebbe non essere più 
sufficiente per le esigenze del desktop e delle applicazioni. Tuttavia, la maggior parte 
degli utenti troverà il supporto per il proprio hardware.

• Desktop. Xfce4 è un desktop maturo che rimane in fase di sviluppo. La versione 
fornita con MX Linux (4.18) è considerata stabile; gli aggiornamenti importanti 
saranno applicati non appena disponibili. L'ambiente KDE/Plasma viene mantenuto 
costantemente.

• Applicazioni. Le applicazioni continuano a essere sviluppate dopo il rilascio di 
qualsiasi versione di MX Linux, il che significa che le versioni fornite diventano più 
vecchie con il passare del tempo. Questo problema viene affrontato attraverso una 
combinazione di fonti: Debian (compresi i Debian Backports), i singoli sviluppatori 
(compresi gli MX Devs) e il Community Packaging Team, che accetta il più possibile 
le richieste di aggiornamento degli utenti. MX Updater segnala quando sono 
disponibili nuovi pacchetti da scaricare.

• Sicurezza. Gli aggiornamenti di sicurezza di Debian copriranno gli utenti di MX 
Linux per un massimo di 5 anni. Consultare MX Updater per la notifica della loro 
disponibilità.

Note per i traduttori
Alcune indicazioni per chi traduce il Manuale d'uso:

https://forum.mxlinux.org/
https://mxlinux.org/wiki/
https://mxlinux.org/
https://mxlinux.org/
https://mxlinux.org/support
https://mxlinux.org/support


• I testi in inglese dell'ultima versione si trovano in un repo GitHub. Le traduzioni sono 
memorizzate nella directory "tr".

https://github.com/jerry3904/mxum


◦ È possibile lavorare all'interno del sistema GitHub: clonare il repository 
principale, apportare le modifiche e quindi fare una richiesta di pull per ottenere 
la revisione per l'unione con la sorgente.

◦ In alternativa, è possibile scaricare ciò che interessa e lavorarci localmente prima di 
comunicare che è pronto con un'e-mail a manual AT mxlinux DOT org o postando 
sul forum.

• In termini di importanza, si consiglia di iniziare con le sezioni 1-3, che forniscono le 
informazioni più rilevanti per i nuovi utenti. Una volta terminate, queste possono 
essere distribuite agli utenti come traduzione parziale, mentre le sezioni successive 
vengono tradotte.

• Le traduzioni disponibili sono riportate nel Wiki di MX/antiX.

https://help.github.com/articles/cloning-a-repository/
https://help.github.com/articles/about-pull-requests/
https://mxlinux.org/wiki/help-files-other/users-manual-translations


 2 Installazione
2.1 Introduzione
Un supporto live MX Linux (chiavetta USB o DVD) avvia il computer senza accedere al disco 
rigido. Copia un file system virtuale nella RAM che funge da centro di un sistema operativo 
temporaneo per il computer. Quando si termina la sessione live, tutto il computer torna come 
prima, immutato (contrasto con la Sezione 6.6.1).
Ciò offre una serie di vantaggi:

• Consente di eseguire MX Linux sul computer senza installarlo.
• Consente di determinare se MX Linux è compatibile con l'hardware in uso.
• Vi aiuterà a capire come funziona MX Linux e a esplorare alcune delle sue caratteristiche.
• È possibile decidere se MX Linux è ciò che si desidera senza modificare in modo 

permanente il sistema attuale.

L'esecuzione da un LiveMedium presenta anche alcuni svantaggi:

• Poiché l'intero sistema funziona da una combinazione di RAM e supporto, MX Linux 
richiederà più RAM e potrebbe funzionare più lentamente rispetto all'installazione sul 
disco rigido.

• Alcuni hardware insoliti che richiedono driver specializzati o una configurazione 
personalizzata potrebbero non funzionare in una sessione live di sola lettura (come un 
DVD), dove non è possibile installare file permanenti. La nostra chiavetta USB con 
persistenza non presenta questo problema.

2.1.1 PAE o non PAE?
MX Linux è disponibile per due architetture, a 32 e 64 bit, entrambe dotate di Physical Address 
Extension (PAE). PAE è un modo per consentire a un sistema operativo a 32 bit di accedere alla 
RAM oltre i 4 GB circa. È possibile utilizzare una versione non PAE su un sistema PAE, ma non 
viceversa. Se la vostra macchina non è in grado di gestire PAE (ad esempio, è molto vecchia), vi 
consigliamo di installare la nostra distro sorella antiX Linux.

Se non si è sicuri di aver bisogno della versione PAE o non PAE, utilizzare il metodo seguente 
adatto al sistema operativo in uso.

• Linux. Aprite un terminale e digitate questo comando (se necessario, installate prima 
inxi): inxi -f. Se la voce Flags della CPU non include PAE nell'elenco, non sarà 
possibile installare MX Linux.

• Mac. Le versioni Intel di OS X supportano PAE.
• Windows

• Windows2000 e precedenti: nonPAE
• Windows XP e Vista. Fare clic con il pulsante destro del mouse su Risorse del 

computer > Proprietà, scheda Generale. Se in basso è presente la dicitura 
Physical Address Extension (=PAE), allora PAE è la versione corretta da 
installare.

• Windows 7. Aprite la finestra del Prompt dei comandi facendo clic sul pulsante 
Start > Tutti i programmi > Accessori > Prompt dei comandi. Verrà visualizzata 

https://en.wikipedia.org/wiki/32-bit
https://en.wikipedia.org/wiki/64-bit_computing
http://en.wikipedia.org/wiki/Physical_Address_Extension
http://en.wikipedia.org/wiki/Physical_Address_Extension
https://antixlinux.com/


una finestra di terminale. Inserite questo codice nel prompt dei comandi dove è 
posizionato il cursore:



wmic os get PAEEnabled
Se PAE è abilitato, si otterrà un risultato simile a questo: PAEEnabled. Questo 
ritorno può essere seguito o meno dalla parola TRUE.

• Windows 8 e successivi. PAE abilitato per impostazione predefinita.

2.1.2 Versione a 32 o 64 bit?

Qual è l'architettura della vostra CPU?
Seguire il metodo appropriato di seguito per scoprire se la macchina è a 32 o 64 bit.*

• Linux. Aprite un terminale e digitate il comando lscpu, quindi esaminate le prime righe 
per conoscere l'architettura, il numero di core, ecc.

• Windows. Consultate questo documento Microsoft.
• Apple. Consultate questo documento Apple.

*Se invece volete conoscere l'architettura del sistema operativo, il comando uname -m funziona su tutte le distro 
Linux e macOS.

In generale, se disponete di una CPU a 64 bit e della RAM necessaria per il vostro particolare 
computer e processore, dovreste utilizzare la versione a 64 bit. Questo perché i 64 bit sono 
generalmente più veloci, anche se nell'uso quotidiano la differenza potrebbe non essere notata. 
A lungo termine, inoltre, un numero crescente di applicazioni di grandi dimensioni sarà 
probabilmente limitato alle versioni a 64 bit. Si noti che un'applicazione o un sistema operativo 
a 32 bit può funzionare su una CPU a 64 bit, ma non il contrario.

Per ulteriori informazioni, vedere qui.

Quanta memoria (RAM) avete?
• Linux. Aprite un terminale e inserite il comando free -h e guardate il numero nella 

colonna Total.
• Windows. Aprite la finestra Sistema utilizzando il metodo consigliato per la vostra 

versione e cercate la voce "Memoria installata (RAM)".
• Apple. Fate clic sulla voce "Informazioni su questo Mac" nel menu Apple di Mac OS 

X e cercate le informazioni sulla RAM.

2.1.3 Requisiti di sistema

Per un sistema MX Linux installato su un disco rigido, sono normalmente necessari i seguenti 
componenti.

Minimo

• Un'unità CD/DVD (e un BIOS in grado di eseguire l'avvio da tale unità) o una 
chiavetta USB da 4 GB (e un BIOS in grado di eseguire l'avvio da USB)

• Un moderno processore i686 Intel o AMD

• 1 GB di RAM

https://support.microsoft.com/en-us/kb/827218
https://support.apple.com/en-us/HT201948
https://www.techsupportalert.com/content/32-bit-and-64-bit-explained.htm


• 6 GB di spazio libero sul disco rigido



Consigliato

• Un'unità CD/DVD (e un BIOS in grado di eseguire l'avvio da tale unità) o una 
chiavetta USB da 8 GB, se si utilizza la persistenza (e un BIOS in grado di 
eseguire l'avvio da USB).

• Un moderno processore i686 Intel o AMD

• 2 GB di RAM o più

• Almeno 20 GB di spazio libero sul disco rigido

• Una scheda video con capacità 3D per il supporto di desktop 3D

• Una scheda audio SoundBlaster, AC97 o HDA compatibile

NOTA: alcuni utenti di MX Linux 64-bit riferiscono che 2 GB di RAM sono sufficienti per un 
uso generale, anche se si consiglia di utilizzare almeno 4 GB di RAM se si eseguono processi 
(come la rimasterizzazione) o applicazioni (come un editor audio o video) che richiedono molta 
memoria.

2.2 Creazione di un supporto avviabile

2.2.1 Ottenere l'immagine ISO
MX Linux è distribuito come immagine ISO, un file immagine del disco nel formato del file 
system ISO 9660. È disponibile in due formati nella pagina di download.

• Il rilascio originale di una determinata versione.
• Si tratta di una versione statica che, una volta rilasciata, rimane inalterata.
• Più lungo è il tempo trascorso dal rilascio, meno è attuale.

• Un aggiornamento mensile di una determinata versione. Questa immagine ISO 
mensile viene creata dalla release originale utilizzando MX Snapshot (vedere 
Sezione 6.6.4).

• Include tutti gli aggiornamenti dalla versione originale e quindi elimina la 
necessità di scaricare un gran numero di file dopo l'installazione.

• Inoltre, consente agli utenti di eseguire una sessione live con la versione 
più recente dei programmi.

• Disponibile solo come download diretto!

 Creare una live-usb antiX/MX da Windows

Acquisto
Le unità USB, i computer e così via disponibili con immagine ISO preinstallata sono elencati nella 

http://en.wikipedia.org/wiki/ISO_9660
http://www.mxlinux.org/download-links
https://youtu.be/GTxphqvKYss


pagina hardware.

https://mxlinux.org/hardware/


Figura 2-1: Distribuzione dei mirror MX Linux (settembre 2021).

Scaricare
MX Linux può essere scaricato in due modi dalla pagina di download.

• Diretto. I download diretti sono disponibili dal nostro Direct Repo o dai nostri mirror. 
Salvare l'immagine ISO sul disco rigido. Se una fonte sembra lenta, provatene un'altra. 
Disponibile sia per la versione originale che per l'aggiornamento mensile.

• Torrent. La condivisione di file BitTorrent fornisce un protocollo Internet per un 
efficiente trasferimento di massa dei dati. Il trasferimento è decentralizzato in modo da 
utilizzare connessioni con una buona larghezza di banda e ridurre al minimo la pressione 
sulle connessioni a bassa larghezza di banda. Un ulteriore vantaggio è che tutti i client 
BitTorrent eseguono il controllo degli errori durante il processo di download, quindi non 
è necessario eseguire un controllo md5sum separato al termine del download. È già stato 
fatto!
Il Team Torrent di MX Linux mantiene uno swarm BitTorrent seminato dell'ultima 
immagine ISO di MX Linux (solo la versione originale), registrata su archive.org entro 
24 ore dal rilascio ufficiale. I link ai torrent si trovano nella pagina dei download.

• Andare alla pagina di download e fare clic sul link torrent corretto per la propria 
architettura. Il browser dovrebbe riconoscere che si tratta di un torrent e chiedere come 
gestirlo.
In caso contrario, fare clic con il tasto sinistro del mouse sul torrent per visualizzare la 
pagina e fare clic con il tasto destro per salvarlo. Facendo clic sul torrent scaricato si 
avvierà il client torrent (Transmission per impostazione predefinita), mostrando il 
torrent nell'elenco; evidenziarlo e fare clic su Avvia per iniziare il processo di 
download. Se avete già scaricato l'immagine ISO, assicuratevi che si trovi nella stessa 
cartella del torrent appena scaricato.

2.2.2 Controllare la validità dell'immagine ISO scaricata

https://mxlinux.org/download-links
http://en.wikipedia.org/wiki/BitTorrent
https://mxlinux.org/download-links


Dopo aver scaricato un'immagine ISO, il passo successivo è quello di verificarla. Sono 
disponibili diversi metodi.



md5sum
Ogni immagine ISO è accompagnata da un file md5sum corrispondente. È necessario verificare 
l'md5sum del file scaricato rispetto a quello ufficiale. Se l'immagine ISO scaricata è autentica, 
il suo md5sum sarà identico a quello ufficiale. I passaggi seguenti consentono di verificare 
l'integrità dell'immagine ISO scaricata su qualsiasi piattaforma OS.

• Finestre
Gli utenti possono verificare più facilmente con il creatore di USB avviabili Rufus; è 
anche disponibile uno strumento chiamato WinMD5FREE da scaricare e utilizzare 
gratuitamente.

• Linux
In MX Linux, navigare nella cartella in cui sono stati scaricati la ISO e il file md5sum. 
Fare clic con il pulsante destro del mouse sul file md5sum > Verifica integrità dati. Verrà 
visualizzata una finestra di dialogo che dice "<nome della ISO>: OK" se i numeri sono 
identici. È anche possibile fare clic con il pulsante destro del mouse sull'ISO > Calcola 
md5sum e confrontarlo con un'altra fonte.
Se questa opzione non è disponibile, aprite un terminale nella posizione in cui avete 
scaricato la ISO (i gestori di file di Linux di solito hanno un'opzione Apri terminale 
qui), quindi digitate:

md5sum nomefile.iso
Assicuratevi di sostituire "filename" con il nome effettivo del file (digitate le prime due 
lettere, poi premete Tab e verrà compilato automaticamente). Confrontate il numero 
ottenuto con questo calcolo con il file md5sum scaricato dal sito ufficiale. Se sono 
identici, la vostra copia è identica alla versione ufficiale.

• MacOS
Gli utenti Mac devono aprire una console e accedere alla directory con i file ISO e 
md5sum. Quindi, eseguire questo comando:

md5 -c nomefile.md5sum
Assicurarsi di sostituire il nome del file con il nome effettivo del file.

sha256sum
Una maggiore sicurezza è fornita da sha256 e sha512. Scaricate il file per verificare l'integrità 
dell'ISO.

• Windows: il metodo varia a seconda della versione. Effettuate una ricerca in rete su 
"windows <versione> verifica somma sha256".

• Linux: seguire le indicazioni per md5sum, sopra, sostituendo
"sha256sum" o "sha512sum" per "md5sum".

• MacOS: aprire una console, passare alla directory con i file ISO e sha256 ed eseguire 
questo comando:

shasum -a 256 /percorso/al/file

Firma GPG
I file ISO di MX Linux sono firmati dagli sviluppatori di MX Linux. Questo metodo di 
sicurezza permette all'utente di essere sicuro che l'ISO sia quello che dice di essere: 
un'immagine ISO ufficiale degli sviluppatori. Istruzioni dettagliate su come eseguire questo 

https://rufus.akeo.ie/
http://www.winmd5.com/
https://en.wikipedia.org/wiki/SHA-2


controllo di sicurezza sono disponibili nel Wiki tecnico di MX/antiX.

https://mxlinux.org/wiki/system/signed-iso-files


2.2.3 Creare un LiveMedium

DVD
Masterizzare una ISO su un DVD è facile, a patto che si seguano alcune importanti linee guida.

• Non masterizzare l'immagine ISO su un CD/DVD vuoto come se fosse un file di dati! 
Un'immagine ISO è un'immagine formattata e avviabile di un sistema operativo. È 
necessario scegliere Masterizza immagine disco o Masterizza ISO nel menu del 
programma di masterizzazione di CD/DVD. Se la si trascina semplicemente in un 
elenco di file e la si masterizza come un normale file, non si otterrà un LiveMedium 
avviabile.

• Utilizzare un DVD-R o DVD+R scrivibile di buona qualità con capacità di 4,7 GB.

USB
È possibile creare facilmente una chiavetta USB avviabile che funzioni con la maggior parte 
dei sistemi. MX Linux include lo strumento MX Live USB Maker (vedere Sezione 3.2) per 
questo compito.

• Se si desidera creare una chiavetta USB su Windows, si consiglia di utilizzare Rufus, 
che supporta il nostro bootloader, o una versione recente di Unetbootin.

• Se utilizzate Linux, offriamo il nostro live-usb-maker-qt come Appimage a 64 bit.
• Se la chiavetta USB si avvia ma viene visualizzato il messaggio di errore gfxboot.c32: 

not a COM32R image, si dovrebbe comunque essere in grado di avviare il sistema 
digitando "live" al prompt della riga successiva. La riformattazione della chiavetta USB 
e il riflash dell'immagine ISO dovrebbero eliminare l'errore.

• Se i creatori di USB grafici falliscono, è possibile utilizzare il comando "dd", che ora è 
un'opzione di MX Live USB Maker.

• ATTENZIONE: fare attenzione a identificare correttamente la chiavetta USB di 
destinazione, poiché il comando dd sovrascriverà completamente i dati presenti 
sull'unità di destinazione.

• Per verificare il nome/lettera del dispositivo corretto per la chiavetta USB, 
aprire un terminale, digitare lsblk e premere Invio.
Verrà visualizzato un elenco di tutti i dispositivi collegati al sistema. Dovreste 
essere in grado di identificare la vostra chiavetta USB in base alle dimensioni di 
memoria elencate.

• Per i dettagli, consultare il Wiki MX/antiX.

Figura 2-3: Tipico output del 
comando lsblk, che mostra due dischi rigidi, ciascuno con due partizioni.

https://github.com/MX-Linux/lum-qt-appimage/releases/tag/19.11.02
https://github.com/MX-Linux/lum-qt-appimage/releases/tag/19.11.02
https://mxlinux.org/wiki/system/dd-command


2.3 Pre-installazione

2.3.1 Provenienti da Windows
Se si intende installare MX Linux in sostituzione di Microsoft Windows®, è bene consolidare ed 
eseguire il backup dei file e degli altri dati attualmente archiviati in Windows. Anche se si 
prevede di eseguire il dual-boot, è necessario eseguire un backup di questi dati in caso di 
problemi imprevisti durante l'installazione.

Backup dei file
Individuare tutti i file, come documenti d'ufficio, immagini, video e musica:

• In genere, la maggior parte di questi si trova nella cartella Documenti.
• Cercare vari tipi di file dal menu Applicazioni di Windows per assicurarsi di averli 

trovati e salvati tutti.
• Alcuni utenti fanno il backup dei loro font per riutilizzarli in MX Linux con 

applicazioni (come LibreOffice) che possono aprire documenti Windows.
• Una volta individuati tutti i file, masterizzateli su un CD o DVD o copiateli su un 

dispositivo esterno come una chiavetta USB.

Backup dei dati di e-mail, calendario e contatti
A seconda del programma di posta elettronica o di calendario utilizzato, i dati della posta 
elettronica e del calendario potrebbero non essere salvati in una posizione ovvia o con un nome 
di file ovvio. La maggior parte delle applicazioni di posta elettronica o di pianificazione (come 
Microsoft Outlook®) sono in grado di esportare questi dati in uno o più formati di file. Per sapere 
come esportare i dati, consultare la documentazione della guida dell'applicazione.

• Dati e-mail: Il formato più sicuro per le e-mail è il testo semplice, poiché la maggior 
parte dei programmi di posta elettronica supporta questa funzione; assicurarsi di 
comprimere il file per garantire che tutti gli attributi del file siano mantenuti. Se si 
utilizza Outlook Express, la posta è memorizzata in un file .dbx o .mbx, che può essere 
importato in Thunderbird (se installato) su MX Linux. Utilizzare la funzione di ricerca 
di Windows per individuare questo file e copiarlo nel backup. La posta di Outlook deve 
essere importata in Outlook Express prima di essere esportata per l'uso in MX Linux.

• Dati del calendario: esportare i dati del calendario in formato iCalendar o vCalendar, se 
si desidera utilizzarli in MX Linux.

• Dati di contatto: i formati più diffusi sono CSV (comma separated values) o vCard.

Conti e password
Anche se di solito non vengono memorizzati in file leggibili di cui è possibile eseguire il backup, 
è importante ricordare di annotare le informazioni relative ai vari account che potrebbero essere 
state salvate nel computer. I dati di accesso automatico ai siti web o ai servizi come il vostro ISP 
dovranno essere inseriti di nuovo, quindi assicuratevi di memorizzare su disco le informazioni 
necessarie per accedere di nuovo a questi servizi. Alcuni esempi sono:

• Informazioni di accesso all'ISP: Sono necessari almeno il nome utente e la password del 
provider di servizi Internet e il numero di telefono per connettersi se si utilizza una 
connessione dial-up o ISDN. Altri dettagli potrebbero includere il numero di uscita, il 
tipo di composizione (a impulsi o a toni) e il tipo di autenticazione (per la connessione 



telefonica); l'indirizzo IP e la maschera di sottorete, il server DNS, l'indirizzo IP del 
gateway, il server DHCP, il VPI/VCI, l'MTU, il tipo di incapsulamento o le impostazioni 
DHCP (per varie forme di banda larga). Se non si è sicuri di ciò che serve, consultare il 
proprio ISP.



• Rete wireless: È necessario disporre della chiave di accesso o della passphrase e del nome della rete.
• Password web: Le password di vari forum web, negozi online o altri siti sicuri sono 

necessarie.
• Dettagli dell'account e-mail: Sono necessari il nome utente e la password, nonché gli 

indirizzi o gli URL dei server di posta. Potrebbe essere necessario anche il tipo di 
autenticazione. Queste informazioni dovrebbero essere recuperabili dalla finestra di 
dialogo Impostazioni account del client di posta elettronica.

• Messaggistica istantanea: Il nome utente e la password dell'account di messaggistica 
istantanea, l'elenco degli amici e le informazioni di connessione al server, se necessario.

• Altro: Se si dispone di una connessione VPN (ad esempio verso l'ufficio), di un 
server proxy o di un altro servizio di rete configurato, assicurarsi di conoscere le 
informazioni necessarie per riconfigurarlo in caso di necessità.

Preferiti del browser
I preferiti del browser web (segnalibri) sono spesso trascurati durante un backup e di solito non 
sono memorizzati in un luogo ovvio. La maggior parte dei browser contiene un'utilità per 
esportare i segnalibri in un file, che può essere importato nel browser Web scelto in MX Linux. 
Per indicazioni specifiche e aggiornate, consultare il gestore dei segnalibri del browser utilizzato.

Licenze software
Molti programmi proprietari per Windows non sono installabili senza una chiave di licenza o 
una chiave CD. A meno che non vogliate abbandonare definitivamente Windows, assicuratevi di 
avere una chiave di licenza per tutti i programmi che la richiedono. Se si decide di reinstallare 
Windows (o se la configurazione del dual-boot va male), non sarà possibile reinstallare questi 
programmi senza la chiave.
Se non si riesce a trovare la licenza cartacea fornita con il prodotto, è possibile individuarla nel 
Registro di Windows o utilizzare un keyfinder come ProduKey. Se tutto il resto fallisce, 
provare a contattare il produttore del computer per chiedere aiuto.

Esecuzione di programmi Windows
I programmi Windows non vengono eseguiti all'interno di un sistema operativo Linux, quindi 
gli utenti di MX Linux sono incoraggiati a cercare gli equivalenti nativi (vedere la Sezione 4). 
Le applicazioni critiche per l'utente possono essere eseguite sotto Wine (vedere Sezione 6.1), 
anche se il successo varia.

2.3.2 Computer Apple Intel
L'installazione di MX Linux su computer Apple con chip Intel può essere problematica; la 
difficoltà dipende dall'esatto hardware coinvolto. Agli utenti interessati a questa installazione si 
consiglia di cercare e consultare il materiale Debian e i forum per gli sviluppi recenti. Un certo 
numero di utenti Apple ha installato MX Linux con successo, quindi dovreste avere fortuna se 
cercate o postate domande sul forum di MX Linux.

Collegamenti
Installazione di Debian su computer Apple 
Forum Debian

http://www.nirsoft.net/utils/product_cd_key_viewer.html
https://wiki.debian.org/InstallingDebianOn/Apple
http://forums.debian.net/


2.3.3 Domande frequenti sul disco rigido

Dove devo installare MX Linux?
Prima di iniziare l'installazione, è necessario decidere dove installare MX Linux.

• Intero disco rigido
• Partizione esistente su un disco rigido
• Nuova partizione su un disco rigido

È sufficiente selezionare una delle prime due opzioni durante l'installazione; la terza opzione 
richiede la creazione di una nuova partizione. È possibile farlo durante l'installazione, ma si 
consiglia di farlo prima di avviare l'installazione. Su MX Linux, di solito si utilizza GParted 
(Xfce) o Partition Manager (KDE) per creare e gestire graficamente le partizioni.
Una configurazione di installazione tradizionale di Linux prevede diverse partizioni server, una 
ciascuna per root, home e swap, come mostrato nella figura seguente. Si dovrebbe iniziare con 
questa configurazione se si è alle prime armi con Linux. Potrebbe essere necessaria anche una 
partizione di sistema EFI (ESP) formattata in FAT32 per le macchine con supporto UEFI. Sono 
possibili altre disposizioni delle partizioni, ad esempio alcuni utenti esperti combinano le 
partizioni root e home, con una partizione separata per i dati.

Figura 2-2: GParted mostra tre partizioni (sda1), (sda2) e swap (sda3). Le dimensioni delle 
unità sono a discrezione dell'utente (vedere la Sezione 1.3 per i requisiti minimi).

ALTRO: Manuale GParted

Creare una nuova partizione con GParted

Partizionare un sistema multiboot

Come posso modificare le partizioni?
Uno strumento molto pratico, chiamato Disk Manager, fornisce una presentazione grafica di 
tutte le partizioni della macchina (escluso lo swap) con una semplice interfaccia per montare, 
smontare e modificare alcune proprietà delle partizioni del disco in modo rapido e semplice. Le 
modifiche vengono scritte automaticamente e immediatamente in /etc/fstab e sono quindi 

https://en.wikipedia.org/wiki/EFI_system_partition
http://gparted.org/display-doc.php?name=help-manual
https://www.youtube.com/watch?v=lf8eXhCKghg
https://www.youtube.com/watch?v=khg6_sdrOBQ


conservate per l'avvio successivo.



AIUTO: Gestione dischi

Cosa sono le altre partizioni della mia installazione di Windows?
I computer domestici recenti con Windows vengono venduti con una partizione di diagnostica e 
una di ripristino, oltre a quella che contiene l'installazione del sistema operativo. Se in GParted 
compaiono più partizioni di cui non si era a conoscenza, probabilmente si tratta di quelle e 
vanno lasciate stare.

Devo creare una partizione home separata?
Non è necessario creare una partizione home separata, poiché il programma di installazione 
creerà una directory /home all'interno di / (root). Tuttavia, la presenza di una partizione separata 
facilita gli aggiornamenti e protegge dai problemi causati dagli utenti che riempiono l'unità con 
molte immagini, musica o video.

Quanto dovrebbe essere grande la / (radice)?
• (In Linux, la barra "/" indica la partizione principale). La dimensione di base installata 

è di poco inferiore a 5 GB, quindi si consiglia un minimo di 6 GB per consentire le 
funzioni di base.

• Questa dimensione minima non consente di installare molti programmi e può causare 
difficoltà nell'esecuzione di aggiornamenti, nell'esecuzione di VirtualBox e così via. La 
dimensione consigliata per un uso normale è quindi di 20 GB.

• Se la partizione home (/home) si trova all'interno della directory root (/) e si 
memorizzano molti file di grandi dimensioni, è necessario avere una partizione root più 
grande.

• Gli appassionati di giochi di grandi dimensioni (ad esempio, Wesnoth) devono tenere 
presente che avranno bisogno di una partizione principale più grande del solito per i 
dati, le immagini e i file audio; un'alternativa è quella di utilizzare un'unità dati 
separata.

È necessario creare una partizione di swap?
Swap è lo spazio su disco utilizzato per la memoria virtuale. È simile al file "page" che 
Windows utilizza per la memoria virtuale. Il programma di installazione creerà una partizione di 
swap per voi (vedere la Sezione 2.5.1). Se si intende ibernare (e non solo sospendere) il sistema, 
si consigliano alcune dimensioni dello spazio di swap:

• Se la RAM è inferiore a 1 GB, lo spazio di swap deve essere almeno pari alla quantità 
di RAM e al massimo il doppio della RAM, a seconda della quantità di spazio 
disponibile sul disco rigido del sistema.

• Per i sistemi con grandi quantità di RAM, lo spazio di swap dovrebbe essere almeno pari 
alla dimensione della memoria.

• Tecnicamente un sistema Linux può funzionare senza swap, anche se possono 
verificarsi alcuni problemi di prestazioni anche su sistemi con grandi quantità di 
RAM.

Cosa significano nomi come "sda"?
Prima di iniziare l'installazione, è fondamentale capire come il sistema operativo Linux tratta i 
dischi rigidi e le loro partizioni.

https://mxlinux.org/wiki/help-files/help-disk-manager/


• Nomi delle unità. A differenza di Windows, che assegna una lettera a ogni partizione 
del disco rigido, Linux assegna un nome di dispositivo breve a ogni disco rigido o altro 
dispositivo di archiviazione del sistema. I nomi dei dispositivi iniziano con sd più una 
singola lettera (ad esempio, "sda", "sdb", ecc.) per le unità SATA e iniziano con 
nvme0n più un singolo numero (ad esempio, "nvme0n1", "nvme0n2", ecc.) per le unità 
NVMe. Esistono anche metodi più avanzati per assegnare un nome alle unità, il più 
comune dei quali è l'UUID (Universally Unique IDentifier), usato per

https://en.wikipedia.org/wiki/NVM_Express
https://en.wikipedia.org/wiki/Universally_unique_identifier


Accesso a Live Medium

Nel caso in cui si voglia uscire e rientrare, installare nuovi pacchetti e così via, ecco i 
nomi utente e le password:

• Utente abituale

• nome: demo

• password: demo

• Superutente (Amministratore)

• nome: root

• password: root

assegnare un nome permanente che non verrà modificato dall'aggiunta o dalla rimozione 
di apparecchiature.

• Nomi delle partizioni. All'interno di ogni unità, ogni partizione viene indicata con un 
numero aggiunto al nome del dispositivo. Pertanto, per SATA, sda1 sarebbe la prima 
partizione della prima unità disco, mentre sdb3 sarebbe la terza partizione della 
seconda unità. Per NVMe, nvme0n1p1 sarebbe la prima partizione della prima unità 
disco, mentre nvme0n2p3 sarebbe la terza partizione della seconda unità.

• Partizioni estese. In origine i dischi rigidi dei PC potevano contenere solo quattro 
partizioni. Queste sono chiamate partizioni primarie in Linux e sono numerate da 1 a 4. 
È possibile aumentarne il numero trasformando una delle partizioni primarie in una 
partizione estesa, dividendola poi in partizioni logiche (limite 15) numerate da 5 in poi. 
Linux può essere installato in una partizione primaria o logica.

2.4 Prima occhiata

2.4.1 Avviare il LiveMedium

CD/DVD dal vivo
È sufficiente inserire il CD/DVD nel vassoio e riavviare.

Chiavetta USB live
Potrebbe essere necessario eseguire alcuni passaggi per far sì che il computer si avvii 
correttamente utilizzando la chiavetta USB.

• Per l'avvio con la chiavetta USB, molti computer dispongono di tasti specifici da 
premere durante l'avvio per selezionare il dispositivo. I tasti tipici del menu del 
dispositivo di avvio sono Esc, uno dei tasti funzione, Return o Shift. Osservare 
attentamente la prima schermata visualizzata al riavvio per individuare il tasto corretto.

• In alternativa, potrebbe essere necessario entrare nel BIOS per modificare l'ordine dei dispositivi di 
avvio:



• Avviare il computer e premere il tasto richiesto (ad esempio, F2, F10 o Esc) 
all'inizio per accedere al BIOS.

• Fare clic sulla scheda Avvio (o sulla freccia).
• Identificare ed evidenziare il dispositivo USB (di solito, l'unità disco USB), 

quindi spostarlo in cima all'elenco (o inserire, se il sistema è impostato per 
questo). Salvare e uscire.

• Se non siete sicuri o non vi sentite a vostro agio nel modificare il BIOS, chiedete 
assistenza nel forum MX.

• Sui computer più vecchi, privi di supporto USB nel BIOS, è possibile utilizzare il 
LiveCD di Plop Linux che caricherà i driver USB e presenterà un menu. Per i 
dettagli, consultare il sito web.

• Una volta che il sistema è impostato per riconoscere la chiavetta USB durante il 
processo di avvio, è sufficiente inserire la chiavetta e riavviare il computer.

UEFI

 Problemi di avvio UEFI e alcune impostazioni da controllare!

Se sul computer è già installato Windows 8 o successivo, è necessario adottare misure speciali 
per gestire la presenza di (U)EFI e Secure Boot. La maggior parte degli utenti è invitata a 
disattivare Secure Boot entrando nel BIOS all'avvio della macchina. Purtroppo, la procedura 
esatta da seguire varia a seconda del produttore:

Nonostante le specifiche UEFI richiedano il pieno supporto delle tabelle di 
partizione MBR, alcune implementazioni del firmware UEFI passano 
immediatamente all'avvio CSM basato sul BIOS a seconda del tipo di tabella di 
partizione del disco di avvio, impedendo di fatto l'avvio UEFI da partizioni EFI 
System su dischi con partizione MBR. (Wikipedia, "Unified Extensible Firmware 
Interface", recuperato il 10/12/19)

L'avvio e l'installazione UEFI sono supportati su macchine a 32 e 64 bit, nonché su macchine a 
64 bit con UEFI a 32 bit. Tuttavia, le implementazioni UEFI a 32 bit possono ancora presentare 
problemi. Per la risoluzione dei problemi, consultare il Wiki MX/antiX o chiedere nel Forum 
MX.

Schermo nero
A volte si finisce per vedere una schermata nera vuota, con un cursore lampeggiante nell'angolo. 
Questo rappresenta un fallimento nell'avvio di X, il sistema di finestre utilizzato da Linux, ed è 
spesso dovuto a problemi con il driver grafico utilizzato. Soluzione: riavviare e selezionare le 
opzioni di avvio Safe Video o Failsafe nel menu; i dettagli su questi codici di avvio sono 
disponibili nel Wiki. Vedere la sezione 3.3.2.

https://forum.mxlinux.org/
http://www.plop.at/
https://www.youtube.com/watch?v=cLFUZ6LtqiE
https://en.wikipedia.org/wiki/Unified_Extensible_Firmware_Interface
https://mxlinux.org/wiki/system/uefi
https://forum.mxlinux.org/
https://forum.mxlinux.org/
https://mxlinux.org/wiki/system/boot-parameters


2.4.2 Schermo di apertura standard

Figura 2-3: schermata di avvio LiveMedium dell'immagine ISO x64.

All'avvio di LiveMedium viene presentata una schermata simile a quella mostrata nella figura 
precedente; la schermata di un sistema installato è molto diversa. Nel menu principale possono 
comparire anche voci personalizzate.

Voci del menu principale
Tabella 1: Voci di menu in Live boot

Ingresso Commento
MX-XX.XX 

(<DATA DI 
RILASCIO>)

Questa voce è selezionata per impostazione predefinita ed è il 
modo standard con cui la maggior parte degli utenti avvia il 

sistema live. È sufficiente premere Return per avviare il sistema.
Avvio da disco rigido Avvia tutto ciò che è attualmente installato sul disco rigido del 

sistema.
Test di memoria Esegue un test per verificare la RAM. Se il test viene superato, è 

possibile che vi sia ancora un problema hardware o anche un 
problema di RAM; se il test fallisce, c'è qualcosa che non va 

nella RAM.

Nella riga inferiore, lo schermo visualizza una serie di voci verticali, sotto le quali si trova una 
riga di opzioni orizzontali; per i dettagli, premere F1 quando si è in questa schermata.

Opzioni
• F2 Lingua. Impostare la lingua per il bootloader e il sistema MX. Questa viene 

trasferita automaticamente sul disco rigido al momento dell'installazione.
• F3 Fuso orario. Impostare il fuso orario del sistema. Questo verrà trasferito 

automaticamente sul disco rigido al momento dell'installazione.
• F4 Opzioni. Opzioni per il controllo e l'avvio del sistema live. La maggior parte di 

queste opzioni non viene trasferita sul disco rigido al momento dell'installazione.
• F5 Persisti. Opzioni per mantenere le modifiche alla LiveUSB quando la macchina si spegne.



• F6 Opzioni video sicure/failsafe. Opzioni per le macchine che non si avviano su X per impostazione 
predefinita.



• F7 Console. Imposta la risoluzione delle console virtuali. Può entrare in conflitto con 
l'impostazione della modalità Kernel. Può essere utile se si sta avviando l'installazione 
da riga di comando o se si sta cercando di eseguire il debug del processo di avvio 
iniziale. Questa opzione verrà trasferita al momento dell'installazione.

ALTRO: Processo di avvio di Linux, Wiki MX/antiX

2.4.3 Schermata di apertura UEFI

Figura 2-4: Schermata di avvio LiveMedium di x64 (da MX-21 in poi) quando viene rilevato UEFI.
Se l'utente utilizza un computer impostato per l'avvio UEFI (vedere MX/antiX Wiki), apparirà 
invece la schermata di apertura dell'avvio live UEFI con scelte diverse.

• I menu vengono utilizzati per impostare le opzioni di avvio al posto dei menu dei tasti funzione.
• L'opzione superiore avvia il sistema operativo con tutte le opzioni selezionate attivate.
• Le opzioni avanzate impostano elementi come la persistenza e altre voci presenti nei 

menu dei tasti funzione di avvio tradizionali.
• Lingua - Tastiera - Fuso orario imposta queste opzioni.

http://en.wikipedia.org/wiki/Linux_startup_process
https://mxlinux.org/wiki/system/boot-parameters
https://www.mxlinux.org/wiki/system/uefi


Figura 2-5: Esempi di schermate per LiveMedium (a sinistra) e per le opzioni installate.

Se si desidera che le opzioni di avvio siano permanenti, assicurarsi di selezionare un'opzione di salvataggio.

2.4.4 Schermata di accesso

Figura 2-6: A sinistra: schermata di login di Xfce, con il pulsante di sessione in alto al 
centro. A destra: Schermata di accesso di KDE/Plasma.
A meno che non si sia selezionato l'autologin, il processo di avvio dell'installazione termina con 
la schermata di login; in una sessione live viene mostrata solo l'immagine di sfondo, ma se si 
effettua il logout dal desktop si vedrà la schermata completa. (Su schermi piccoli, l'immagine 
può apparire ingrandita; questa è una proprietà del display manager utilizzato da MX Linux.
All'estremità destra della barra superiore sono presenti tre piccole icone, da destra a sinistra:

• Il pulsante di accensione sul bordo contiene le opzioni di sospensione, riavvio e spegnimento.
• Il pulsante della lingua consente all'utente di selezionare la tastiera appropriata per 

la schermata di accesso.
• Il pulsante degli ausili visivi risponde alle esigenze speciali di alcuni utenti.



Al centro si trova il pulsante della sessione che consente di scegliere il desktop manager da 
utilizzare: Xsession predefinito, Xfce Session e altri eventualmente installati (Sezione 6.3). 
Fluxbox non è più incluso di default, ma può essere installato con MX Package Installer.
Se si desidera evitare di dover effettuare il login a ogni avvio (sconsigliato in caso di problemi 
di sicurezza), è possibile passare a "autologin" nella scheda "opzioni" di MX User Manager.

Le versioni MX KDE/Plasma vengono fornite con una schermata di accesso diversa, 
contenente un selezionatore di sessioni, una tastiera su schermo e funzioni di 
accensione/spegnimento/riavvio.

2.4.5 Diversi desktop

MX-Xfce

Figura 2-7: Il desktop Xfce predefinito.

MX-KDE

Figura 2-8: Il desktop predefinito di KDE/Plasma.

Il desktop è creato e gestito da Xfce o KDE/Plasma; l'aspetto e la disposizione di ciascuno di 
essi sono stati pesantemente modificati per MX Linux. Si notino le due caratteristiche 
dominanti del primo sguardo: il pannello e la schermata di benvenuto.

Pannello
Il desktop predefinito di MX Linux presenta un singolo pannello verticale sullo schermo. 
L'orientamento del pannello può essere facilmente modificato in MX Tools > MX Tweak. Le 
caratteristiche comuni del pannello sono:

http://docs.xfce.org/xfce/getting-started


• Pulsante di accensione, apre una finestra di dialogo per il log out, il riavvio, lo spegnimento e la 
sospensione (Xfce)

• Orologio in formato LCD - clic per un calendario (xfce)
• Taskswitcher/Pulsanti finestra: area in cui vengono mostrate le applicazioni aperte.
• Browser Firefox
• Gestore di file (Thunar)
• Area di notifica

• Aggiornare il manager
• Gestione degli appunti
• Responsabile di rete
• Gestore del volume
• Manager di potenza
• Espulsore USB

• Pager: visualizza gli spazi di lavoro disponibili (per impostazione predefinita 2, fare clic con il pulsante 
destro del mouse per modificarli).

• Menu delle applicazioni ("Whisker" su Xfce)
• Altre applicazioni possono inserire icone nel pannello o nell'area di notifica 

quando sono in esecuzione.

Schermata di benvenuto

Figura 2-9: Schermate di benvenuto e Informazioni su MX linux (installato).
Quando l'utente si avvia per la prima volta, al centro dello schermo appare una schermata di 
benvenuto con due schede: "Welcome" offre un orientamento rapido e link di aiuto (Figura 2-
7), mentre "About" visualizza una serie di informazioni sul sistema operativo, sul sistema in 
esecuzione, ecc. Quando si esegue una sessione live, le password per gli utenti demo e root 
vengono visualizzate in basso. Una volta chiuso, in esecuzione o installato, è possibile 
visualizzarlo nuovamente utilizzando il menu o gli Strumenti MX.

È molto importante che i nuovi utenti esaminino attentamente i pulsanti, in quanto ciò 

http://gottcode.org/xfce4-whiskermenu-plugin


risparmierà molta confusione e fatica nell'uso futuro di MX Linux. Se il tempo a disposizione è 
limitato, si consiglia di



scorrere il documento delle FAQ collegato al Desktop, dove vengono fornite le risposte alle 
domande più comuni.

Suggerimenti e trucchi

Figura 2-10: Impostazioni è il punto di riferimento per apportare modifiche. Il contenuto varia.

Alcune cose utili da sapere all'inizio:

• Se si verificano problemi con l'audio, la rete e così via, vedere Configurazione (Sezione 3).
• Regolare il volume generale del suono scorrendo con il cursore sull'icona 

dell'altoparlante o facendo clic con il pulsante destro del mouse sull'icona 
dell'altoparlante > Apri Mixer.

• Per impostare il sistema sul proprio layout di tastiera, fare clic su Menu 
Applicazioni > Impostazioni > Tastiera, scheda Layout e selezionare il modello 
dal menu a discesa. È anche possibile aggiungere tastiere di altre lingue.

• Regolare le preferenze per il mouse o il touchpad facendo clic su Menu applicazioni 
> Impostazioni > Mouse e touchpad.

• Il cestino può essere facilmente gestito nel file manager, dove si trova la sua icona nel 
riquadro di sinistra. Fare clic con il pulsante destro del mouse per svuotarlo. Può anche 
essere aggiunto al Desktop o al pannello. È importante sapere che l'uso dell'eliminazione, 
sia evidenziando e premendo il pulsante di eliminazione sia tramite una voce del menu 
contestuale, rimuove l'elemento per sempre e non sarà più possibile recuperarlo.

• Per mantenere il sistema aggiornato, verificare che l'indicatore (riquadro 
delineato) degli aggiornamenti disponibili su MX Updater diventi verde. Per i 
dettagli, vedere la sezione 3.2.

• Comode combinazioni di tasti (gestite in Tutte le impostazioni > Tastiera > Scorciatoie applicazione).

Tabella 2: Combinazioni di tasti utili
Tastiera Azione

F4 Fa scendere un terminale dall'alto dello schermo
Chiave di 
Windows

Richiama il menu Applicazione

Ctrl-Alt-Esc Cambia il cursore in una x bianca per uccidere qualsiasi programma.
Ctrl-Alt-Bksp Chiude la sessione (senza salvarla!) e riporta alla schermata di accesso.



Ctrl-Alt-Canc Blocca il desktop su Xfce; logout su KDE/Plasma
Ctrl-Alt-F1 Esce dalla sessione X per tornare alla riga di comando; usare Ctrl-Alt-F7 per 

tornare indietro.
Alt-F1 Apre il manuale d'uso di MX Linux (solo Xfce, menu su KDE/Plasma).



Alt-F2 Viene visualizzata una finestra di dialogo per l'esecuzione di un'applicazione.
Alt-F3 Apre il Finder delle applicazioni, che consente anche di modificare le voci di 

menu (solo Xfce).
Alt-F4 Chiude un'applicazione in primo piano; sul desktop, fa apparire la finestra di 

dialogo di uscita.
PrtScr Apre l'utilità screenshot per l'acquisizione dello schermo

Applicazioni
Le applicazioni possono essere avviate in vari modi.

Figura 2-11: SINISTRA: menu di Xfce 
Whisker (il contenuto varia). A destra: menu 
di KDE/Plasma.

• Fare clic sull'icona del menu Applicazione, nell'angolo in basso a sinistra.
• Si apre la categoria Preferiti e si può passare il mouse su altre categorie sul lato 

destro per vedere i contenuti nel riquadro sinistro.
• Nella parte superiore si trova una potente casella di ricerca incrementale: basta 

digitare alcune lettere per trovare qualsiasi applicazione senza doverne 
conoscere la categoria.

• Fare clic con il tasto destro del mouse sul desktop > Applicazioni.
• Se si conosce il nome dell'applicazione, è possibile utilizzare Application Finder, avviato 

facilmente in due modi.
• Fare clic con il tasto destro del mouse sul desktop > Esegui comando ...
• Alt-F2
• Alt-F3 (Xfce) porta a una versione avanzata che consente di controllare i 

comandi, le posizioni ecc.

• Sul desktop di KDE/Plasma, basta iniziare a digitare

• Utilizzare una sequenza di tasti definita dall'utente per aprire un'applicazione preferita.

• Xfce- Fare clic su Menu applicazioni > Impostazioni: Tastiera, scheda Scorciatoie 
applicazione.

• KDE/Plasma - Scorciatoie globali nel menu



Figura 2-12: Application Finder che identifica l'applicazione.



Altro

Informazioni sul sistema
• Fare clic su Menu applicazioni > Informazioni rapide sul sistema per inserire i risultati del comando

inxi -Fxrz negli appunti, pronto per essere incollato nei messaggi del forum, nei file di testo, ecc.
• KDE/Plasma - Fare clic su Menu applicazioni > Sistema > Infocenter per 

ottenere una bella visualizzazione grafica.

Video e audio
• Per le impostazioni di base del monitor, fare clic su Menu applicazioni> Impostazioni > Display
• La regolazione dell'audio si effettua tramite il Menu Applicazioni > Multimedia > 

PulseAudio Volume Control (o facendo clic con il pulsante destro del mouse 
sull'icona Volume manager).

NOTA: per la risoluzione di problemi quali il display, l'audio o Internet, consultare la Sezione 
3: Configurazione.
Collegamenti

• Documentazione di Xfce
• Domande frequenti su Xfce
• KDE

2.4.7 Uscita
Quando si apre il menu dell'applicazione, nell'angolo in alto a destra compaiono per 
impostazione predefinita quattro pulsanti di comando (è possibile modificare la visualizzazione 
facendo clic con il pulsante destro del mouse sull'icona del menu > Proprietà, scheda Comandi). 
Da sinistra a destra:

• Tutte le impostazioni (Tutte le impostazioni)
• Schermata di blocco
• Utenti dello switch
• Disconnettersi

Figura 2-13: pulsanti di comando 

In alto: Xfce

Giusto: KDE/Plasma
È importante uscire correttamente da 
MX Linux al termine della sessione, in 
modo che il sistema possa essere chiuso 
in modo sicuro. Tutti i programmi in 
esecuzione vengono prima avvisati 
della chiusura del sistema, in modo da 
avere il tempo di salvare i file in corso 

http://www.xfce.org/about
https://wiki.xfce.org/faq
https://userbase.kde.org/Welcome_to_KDE_UserBase


di modifica,



uscire dai programmi di posta e di news, ecc. Se si spegne semplicemente il computer, si rischia 
di danneggiare il sistema operativo.

Opzioni simili ai pulsanti di comando sono disponibili nel menu LASCIA di KDE/Plasma.

Permanente
Per abbandonare definitivamente una sessione, selezionare una delle seguenti opzioni nella finestra di dialogo 
Esci:

• Esci. Questa opzione interrompe tutte le operazioni in corso, chiede di salvare i file 
aperti se non sono stati chiusi da soli e riporta alla schermata di accesso con il sistema 
ancora in funzione.

• Il comando in fondo alla schermata, "Salva sessione per gli accessi futuri", è 
selezionato per impostazione predefinita. Il suo compito è quello di salvare lo 
stato del desktop (applicazioni aperte e loro posizione) e di ripristinarlo all'avvio 
successivo. Se si sono verificati problemi con il funzionamento del desktop, è 
possibile deselezionarlo per ricominciare da capo; se ciò non risolve il problema, 
fare clic su Tutte le impostazioni > Sessione e avvio, scheda Sessione, e premere 
il pulsante Cancella sessioni salvate.

• Riavvia o Spegni. Opzioni autoesplicative che modificano lo stato del sistema stesso. 
È disponibile anche utilizzando l'icona nell'angolo superiore destro della barra di 
accesso.

SUGGERIMENTO: in caso di problemi, Ctrl-Alt-Bksp interrompe la sessione e riporta alla 
schermata di accesso, ma i programmi e i processi aperti non vengono salvati.

Temporaneo
È possibile abbandonare temporaneamente la sessione in uno dei seguenti modi:

• Schermata di blocco. Questa opzione è facilmente accessibile da un'icona nell'angolo in 
alto a destra del menu delle applicazioni. Protegge il desktop da accessi non autorizzati 
mentre si è lontani, richiedendo la password utente per tornare alla sessione.

• Avviare una sessione parallela come utente diverso. È possibile farlo dal pulsante di 
comando Cambia utente nell'angolo in alto a destra del menu dell'applicazione. In questo 
modo si lascia la sessione corrente al suo posto e si può avviare una sessione per un altro 
utente.

• Sospensione tramite pulsante di alimentazione. Questa opzione è disponibile dalla 
finestra di dialogo Log Out e pone il sistema in uno stato di basso consumo. Le 
informazioni sulla configurazione del sistema, sulle applicazioni aperte e sui file attivi 
vengono memorizzate nella memoria principale (RAM), mentre la maggior parte degli 
altri componenti del sistema viene spenta. È molto utile e generalmente funziona molto 
bene in MX Linux. Invocata dal pulsante di accensione, la sospensione funziona bene 
per molti utenti, anche se il suo successo varia a seconda della complessa interazione tra 
i componenti del sistema: kernel, display manager, chip video, ecc. In caso di problemi, 
si consiglia di provare le seguenti modifiche:

• Cambiare driver grafico, ad esempio da radeon ad AMDGPU (per le GPU 
più recenti) o da nouveau al driver proprietario Nvidia.

• Regolare le impostazioni in Menu Applicazioni > Impostazioni > Power 
Manager. Ad esempio: nella scheda Sistema, provare a deselezionare "Blocca 



schermo quando il sistema va in sospensione".
• Fare clic su Menu Applicazioni > Impostazioni > Salvaschermo e regolare i 

valori di Gestione risparmio energetico dello schermo nella scheda Avanzate.
• Schede AGP: aggiungere l'opzione "NvAgp" "1" alla sezione Device di xorg.conf.



• Sospendere utilizzando la chiusura del coperchio del portatile. Alcune configurazioni 
hardware potrebbero avere problemi in questo senso. L'azione di chiusura del 
coperchio può essere regolata nella scheda Generale di Power Manager, dove "Spegni 
display" si è dimostrato affidabile nell'esperienza degli utenti MX.

• Ibernazione. L'opzione di ibernazione è stata rimossa dalla casella di logout nelle 
versioni precedenti di MX Linux perché gli utenti hanno riscontrato diversi problemi. 
Può essere attivata in MX Tweak, scheda Altro. Consultare anche il Wiki MX/antiX.

2.5 Processo di installazione

2.5.1 Passi di installazione dettagliati

 Installazione di base di MX Linux (con 

partizionamento)  Installazione criptata di MX Linux 
(con partizionamento)

 Impostazione della cartella Home

Per iniziare, avviare il LiveMedium, quindi fare clic sull'icona del programma di installazione 
nell'angolo in alto a sinistra. Se l'icona non è presente, fare clic su F4 e immettere: minstall-
pkexec (password di root su LiveMedium: root).

Figura 2-14: Schermata iniziale dell'Installatore.

Commenti
• Il lato destro della schermata del programma di installazione presenta le scelte dell'utente 

man mano che l'installazione procede; il lato sinistro fornisce chiarimenti sul contenuto 
del lato destro.

• Impostazioni tastiera permette di cambiare la tastiera per il processo di installazione.

https://mxlinux.org/wiki/system/hibernate
https://youtu.be/jSYycsZPm_Q
https://youtu.be/jSYycsZPm_Q
https://youtu.be/tQjftZsoySg
https://youtu.be/tQjftZsoySg
https://www.youtube.com/watch?v=twDhZFBMgJ0


Figura 2-15: Installatore impostato su Installazione personalizzata.

Commenti
• Utilizzare il disco. Se non si è sicuri di quale sia la partizione desiderata, utilizzare i 

nomi visualizzati in GParted. Il disco selezionato verrà esaminato sommariamente da 
SMART per verificarne l'affidabilità. Se vengono rilevati problemi, viene visualizzata 
una schermata di avviso. Si dovrà decidere se accettare il rischio e continuare, se 
selezionare un altro disco o se terminare l'installazione. Per ulteriori informazioni, fare 
clic su Menu applicazioni > Sistema > GSmartControl e "Esegui test" sull'unità.

Figura 2-16: Avviso SMART di rischio di guasto

• Installazione regolare utilizzando l'intero disco. Selezionare questa opzione se si 
intende utilizzare l'intero disco rigido per MX Linux. Il disco verrà ripartizionato e 
tutti i dati esistenti andranno persi.

• Per impostazione predefinita, vengono create una partizione root e una partizione 
swap. Se si sceglie di utilizzare la crittografia, viene creata anche una partizione 
/boot.

• Se si desidera avere una partizione home separata, si può usare il cursore per 
dividere lo spazio disponibile tra partizione root e home.

• Un messaggio a comparsa chiederà di confermare l'utilizzo dell'intero disco.

• Personalizza il layout del disco: Se sul disco vengono rilevate partizioni esistenti, 
questa opzione sarà quella predefinita. Sarà possibile utilizzare la schermata di 
selezione delle partizioni per utilizzare le partizioni esistenti.

https://en.wikipedia.org/wiki/S.M.A.R.T


Figura 2-17: Selezione della partizione.

Figura 2-18: Fate clic con il tasto destro del mouse su un disco per visualizzare le opzioni del modello.

Commenti
• Scegliere Partizioni. Specificare le partizioni root e swap che si desidera utilizzare. 

Usare la colonna USO PER per scegliere l'uso che si vuole fare di una partizione. Se 
è stata creata una partizione separata per la directory home, specificarla qui, altrimenti 
lasciare /home impostata su root.

• Molti utenti preferiscono collocare la propria home directory in una partizione 
diversa da quella di / (root), in modo che qualsiasi problema o sostituzione 
totale della partizione di installazione lasci inalterate tutte le impostazioni e i 
file individuali dell'utente.

• A meno che non si utilizzi l'encrpytion o si sappia cosa si sta facendo, lasciare 
l'avvio impostato su root.

• In questa schermata è disponibile una semplice gestione delle partizioni. Fare 
clic con il tasto destro del mouse su un disco per visualizzare i modelli di 
partizione. I modelli sono adatti solo per le modifiche all'intero disco, quindi se 
si desidera ridimensionare o mettere a punto in altro modo il layout delle 



partizioni, è necessario utilizzare un programma



gestore di partizioni esterno (ad esempio, GParted) disponibile facendo clic sul 
pulsante Partition Manager in basso a destra del selezionatore di partizioni.

• Preferenze.
• Selezionare Conserva dati in /home se si sta eseguendo un aggiornamento e i dati 

sono già presenti in una partizione o cartella esistente. Questa opzione non è 
generalmente consigliata a causa del rischio che le vecchie configurazioni non 
corrispondano alla nuova installazione, ma può essere utile in situazioni 
specifiche, ad esempio per riparare un'installazione.

• Selezionare Verifica blocchi danneggiati se si desidera eseguire una scansione 
dei difetti fisici del disco rigido durante la formattazione. Questa opzione è 
consigliata agli utenti con unità più vecchie.

• È possibile modificare l'etichetta della partizione in cui si desidera installare (ad 
esempio, in "Installazione di prova MX- 23") nella colonna Etichetta.

• Infine, è possibile selezionare il tipo di file system che si desidera utilizzare 
sul disco rigido. In MX Linux si consiglia il tipo predefinito ext4, se non si ha 
una scelta particolare.

• È possibile perfezionare le impostazioni del cifrario con il pulsante "Impostazioni 
di crittografia avanzate" o mantenere le impostazioni predefinite.

Figura 2-19: Il programma di installazione chiede il metodo di avvio.

Commenti
• Mentre il sistema operativo linux principale viene copiato sul disco rigido, è possibile 

fare clic sul pulsante "Avanti" per inserire alcune informazioni di configurazione 
aggiuntive. La Figura 2-18 mostra le opzioni di installazione del bootloader GRUB.

• La maggior parte degli utenti medi accetterà le impostazioni predefinite, che 
installeranno il bootloader all'inizio del disco. Questa è la posizione abituale e non causa 
alcun danno.

• Gli utenti UEFI devono scegliere la partizione ESP che desiderano utilizzare. 
L'impostazione predefinita è la prima trovata.

• Quando si fa clic su Avanti, un messaggio a comparsa controllerà che si accetti la 
posizione del bootloader GRUB. L'installazione di GRUB può richiedere alcuni minuti 
in alcune situazioni.



• Si noti che la partizione mostrata (sda) è solo un esempio; la scelta della 
partizione potrebbe essere diversa.



Figura 2-20: Impostazione dei nomi della rete di computer.

Commenti
• Molti utenti scelgono un nome unico per il proprio computer: laptop1, MyBox, 

StudyDesktop, UTRA, ecc. Si può anche lasciare il nome predefinito.
• Se non si dispone di una rete di computer, è sufficiente fare clic su Avanti.
• Se non si intende ospitare cartelle di rete condivise sul proprio PC, è possibile 

disabilitare Samba. Questo non influirà sulla capacità del PC di accedere alle 
condivisioni ospitate altrove sulla rete.

Figura 2-21: Impostazioni di Locale, Fuso orario e Servizio.

Commenti
• Le impostazioni predefinite saranno di solito corrette, a patto che si sia fatto attenzione 

a inserire eventuali eccezioni nella schermata di avvio di LiveMedium.
• Le impostazioni possono essere modificate nuovamente una volta avviato Xfce.



Figura 2-22: Abilitazione/disabilitazione dei servizi.

Commenti
• Questa schermata viene visualizzata solo se si è fatto clic su "Visualizza" nella 

schermata Impostazione locale, fuso orario e servizi.
• I servizi sono applicazioni e funzioni associate al kernel che forniscono funzionalità ai 

processi di livello superiore. Se non si ha familiarità con un servizio, è meglio lasciarlo 
perdere.

• Queste applicazioni e funzioni richiedono tempo per avviarsi e richiedono memoria, 
quindi se siete preoccupati per la capacità del vostro computer, potete consultare questo 
elenco per gli elementi di cui siete sicuri di non avere bisogno.

• Se in seguito si desidera modificare o regolare i servizi di avvio, è possibile utilizzare 
uno strumento a riga di comando chiamato sysv-rc-conf. Sysv-rc-conf è installato 
per impostazione predefinita e deve essere eseguito come root.

Figura 2-23: Configurazione utente.



Commenti
• Il livello di sicurezza delle password scelte dipenderà in larga misura dall'impostazione 

del computer. Un desktop domestico ha generalmente meno probabilità di essere 
scassinato.

• Se si seleziona Autologin, si potrà bypassare la schermata di accesso e accelerare il 
processo di avvio. Lo svantaggio di questa scelta è che chiunque abbia un qualche tipo di 
accesso al computer sarà in grado di accedere direttamente al vostro account. È possibile 
modificare le preferenze di Autologin nella scheda "Opzioni" di MX User Manager.

• È possibile trasferire le modifiche apportate al desktop live all'installazione su disco 
rigido selezionando l'ultima casella. Alcune informazioni critiche (ad esempio, il nome 
del punto di accesso wireless) verranno trasferite automaticamente.

• Se non si imposta una password di root, le autenticazioni della GUI saranno impostate 
sulla password dell'utente, se non lo sono già.

Figura 2-24: Installazione completata.

Commenti
• Una volta terminata la copia del sistema e completate le fasi di 

configurazione, viene presentata la schermata "Installazione completata" e si 
è pronti a partire!

• Se non si desidera riavviare il sistema al termine dell'installazione, deselezionare 
l'opzione di riavvio automatico prima di fare clic su Fine.

2.6 Risoluzione dei problemi

2.6.1 Nessun sistema operativo trovato
Al riavvio dopo un'installazione, a volte capita che il computer segnali che non è stato trovato 
alcun sistema operativo o disco di avvio. Potrebbe anche non mostrare un altro sistema 
operativo installato, come Windows. Di solito, questi problemi significano che GRUB non è 
stato installato correttamente, ma è facile da correggere.

• Se si avvia con UEFI, assicurarsi che Secure Boot sia disattivato nelle impostazioni 
del BIOS/UEFI del sistema.



• Se è possibile avviare almeno una partizione, aprire un terminale root ed 
eseguire questo comando:
aggiornare-grub

• Altrimenti, procedere con MX Boot Repair.
• Avvio del LiveMedium.
• Avviare Strumenti MX > Riparazione avvio.
• Assicurarsi che sia selezionato "Reinstall GRUB Bootloader", quindi fare clic su OK.
• Se il problema non si risolve, è possibile che il disco rigido sia difettoso. In 

genere, all'inizio dell'installazione è stata visualizzata una schermata di avviso 
SMART.

2.6.2 I dati o altre partizioni non sono accessibili.
Le partizioni e le unità diverse da quella designata per l'avvio potrebbero non essere avviate o 
richiedere l'accesso root dopo l'installazione. Ci sono un paio di modi per cambiare questa 
situazione.

• Per le unità interne, utilizzare Start > Impostazioni > Tweak MX, scheda Altro: 
selezionare "Abilita il montaggio delle unità interne da parte di utenti non root".

• GUI. Usare Disk Manager per controllare tutto ciò che si vuole montare all'avvio e 
salvare; al riavvio dovrebbe essere montato e si potrà accedere al file manager 
(Thunar).

• CLI. Aprire un file manager e navigare nel file /etc/fstab; utilizzare l'opzione del clic 
destro per aprirlo come root in un editor di testo. Cercare la riga contenente la partizione 
o l'unità a cui si desidera accedere (potrebbe essere necessario digitare blkid in un 
terminale per identificare l'UUID). Modificatela seguendo questo esempio per una 
partizione dati.

UUID=9501<snip>912 /data ext4 utenti 0 2
Questa voce fa sì che la partizione venga montata automaticamente all'avvio e permette di 
montarla e smontarla come un normale utente. Questa voce farà anche in modo che il file 
system venga controllato periodicamente all'avvio. Se non si vuole che venga montata 
automaticamente all'avvio, cambiare il campo delle opzioni da "user" a "user,noauto".

• Se non si vuole che venga controllato regolarmente, cambiare il "2" finale con uno "0". 
Poiché si dispone di un filesystem ext4, si suggerisce di attivare il controllo automatico.

• Se l'elemento è montato ma non viene visualizzato nel file manager, aggiungere un 
ulteriore "comment=x-gvfs-show" alla riga del file fstab, per forzare il montaggio a 
essere visibile. Nell'esempio precedente, la modifica sarà simile a questa:

UUID=9501<snip>912 /data ext4 users,comment=x-gvfs-show 0 2 
NOTA: nessuna di queste procedure modifica i permessi di Linux, che vengono applicati a 
livello di cartella e di file. Vedere la Sezione 7.3.

2.6.3 Problemi di portachiavi
Un portachiavi predefinito dovrebbe essere creato automaticamente e l'utente non dovrà fare 
nulla. Se si utilizza l'autologin, quando un'applicazione accede al portachiavi, all'utente viene 
chiesto di inserire una nuova password per creare un nuovo portachiavi predefinito. Per 
maggiori dettagli, consultare il Wiki tecnico di MX/Antix.

Si noti che se agenti malintenzionati ottengono l'accesso fisico al computer, l'utilizzo di una 
password vuota ne faciliterà l'accesso. Ma sembra abbastanza chiaro che se un agente 

https://mxlinux.org/wiki/system/gnome-keyring


malintenzionato ha accesso fisico al vostro computer, è comunque tutto finito.

2.6.4 Bloccaggio



Se MX Linux si blocca durante l'installazione, di solito è dovuto a un problema di hardware 
difettoso del computer o a un DVD difettoso. Se si è stabilito che il problema non è il DVD, 
potrebbe essere dovuto a una RAM difettosa, a un disco rigido difettoso o a qualche altro 
componente hardware difettoso o incompatibile.

• Aggiungere una delle opzioni di avvio utilizzando F4 all'avvio o consultando la 
Wiki MX/antiX. Il problema più comune è dovuto al driver grafico.

• L'unità DVD potrebbe avere dei problemi. Se il sistema lo supporta, creare una 
chiavetta USB avviabile di MX Linux e installare da lì.

• Spesso i sistemi si bloccano a causa del surriscaldamento. Aprite il telaio del computer 
e assicuratevi che tutte le ventole del sistema siano in funzione all'accensione. Se il 
BIOS lo supporta, controllare le temperature della CPU e della scheda madre (inserire 
i sensori in un terminale root, se possibile) e confrontarle con le specifiche di 
temperatura del sistema.

Spegnere il computer e rimuovere l'hardware non essenziale, quindi tentare nuovamente 
l'installazione. L'hardware non essenziale può includere dispositivi USB, seriali e a porta 
parallela; schede di espansione PCI, AGP, PCIE, slot per modem o ISA rimovibili (escluso il 
video, se non è presente il video a bordo); dispositivi SCSI (a meno che non si stia eseguendo 
l'installazione da o verso uno di essi); dispositivi IDE o SATA non installati da o verso uno di 
essi; joystick, cavi MIDI, cavi audio e qualsiasi altro dispositivo multimediale esterno.

https://mxlinux.org/wiki/system/boot-parameters


3 Configurazione

 VIDEO: Cose da fare dopo l'installazione di MX Linux

Questa sezione contiene le istruzioni di configurazione per far funzionare correttamente il 
sistema a partire da una nuova installazione di MX Linux e una breve guida alla 
personalizzazione.

3.1 Dispositivi periferici

3.1.1 Smartphone (Samsung, Google, LG, ecc.)

 VIDEO: Smartphone e MX-16 (samsung galaxy s5 e iphone 6s)

Android

Condivisione di file con un dispositivo Android.

1. È possibile accedere ai telefoni Android tramite un browser web installando 
un'applicazione dal Play Store di Google, come AirDroid.

2. Possono anche essere montati direttamente.

• La maggior parte dei telefoni con sistema operativo Android 4.xx e successivi 
include la funzionalità MTP e si può utilizzare la seguente procedura.

• Collegare il telefono e toccare il link visualizzato per assicurarsi che l'opzione 
di archiviazione id sia impostata su "scambio di file" o qualcosa di simile.

• Aprire MX File Manager. Quando in Dispositivi viene visualizzato il nome del 
telefono (o: Memoria), fare clic su di esso. Se non viene visualizzato, riavviare 
il telefono. Il telefono potrebbe visualizzare una finestra di dialogo che chiede 
di autorizzare l'accesso.

• Navigare fino alla posizione desiderata.

• Alcuni file possono essere visualizzati e gestiti con le applicazioni MX Linux: fare 
clic su Dispositivo nel riquadro di sinistra, quindi fare doppio clic su Unità CD, se 
necessario.

• KDE Connect è anche un'opzione per condividere file con un telefono Android. 
KDE Connect è disponibile nel menu delle applicazioni di MX KDE. Se non è già 
installato sul vostro telefono Android, è disponibile su Google Play Store.

https://youtu.be/aESEb8lTvz4
https://www.youtube.com/watch?v=YoMRRXP3Pic
http://web.airdroid.com/


• Per impostazione predefinita, il firewall blocca la connessione dal dispositivo 
Android. Dovrà essere disattivato o dovrà essere impostata una regola del firewall 
per consentire la connessione.

• Musica: utilizzare il lettore musicale predefinito (Strawberry)

• Immagini: utilizzare l'applicazione predefinita per la visualizzazione delle 
immagini (nomacs) o installare un'applicazione diversa utilizzando MX 
Package Installer.

Figura 3-1a: Thunar collegato a un telefono Android Samsung.

Figura 3-1b: Dolphin collegato a un telefono Android Samsung.

iPhone Apple
MX iDevice Mounter consente di accedere tramite Thunar ai dispositivi più vecchi. I telefoni 
più recenti non sono più accessibili con questo processo.



3.1.2 Stampante

Figura 3-2: schermata Nuova stampante di Print Setting.

Stampante allegata

MX Linux offre due utility per la configurazione e la gestione delle stampanti. Print Settings di 
solito funziona bene, ma in caso di problemi si consiglia di passare a CUPS in un browser 
inserendo "localhost:631:" nella barra degli indirizzi di un browser web.

• Applicazione Impostazioni di stampa

◦ Fare clic sul menu Start > Sistema > Impostazioni di stampa

◦ Fare clic sul pulsante "+Aggiungi".

▪ Attendere nella schermata Nuova stampante mentre l'applicazione cerca le 
stampanti collegate e wireless.

▪ Mostra il software consigliato per ogni stampante trovata.

▪ Seguire le istruzioni per concludere l'installazione della stampante.

• In caso di problemi, a volte è possibile risolverli passando a CUPS.

◦ Inserite http://localhost:63/admin in un browser web

◦ In questa pagina è possibile aggiungere stampanti, esaminare lavori, ecc.

HELP: il Wiki Debian.

https://wiki.debian.org/SystemPrinting


Stampante di rete

Samba su MX Linux consente di stampare attraverso la rete verso stampanti condivise su altri 
computer (Windows, Mac, Linux) e dispositivi NAS (Network Attached Storage) che offrono 
servizi Samba (Sezione 3.5).

Utilizzo delle impostazioni di stampa

• Fare clic sul menu Start > Sistema > Impostazioni di stampa

• Selezionare Server > Nuovo > Stampante

• Selezionare Stampante di rete > Stampante Windows via SAMBA.

• Nella finestra di dialogo per smb:// inserire nome del server/nome della 
stampante o indirizzo del server/nome della stampante. Ad esempio: 
smb://bigserver/usbprinter1 oppure smb://192.168.0.100/printer2

• Se avete difficoltà a identificare i nomi dei server e delle stampanti, fate clic sul 
menu Start > Sistema > Samba per maggiori dettagli.

• Lasciare selezionato il pulsante Richiedi all'utente se è richiesta l'autenticazione, 
quindi fare clic su Avanti.

• Lasciate selezionato il pulsante Seleziona stampante dal database e fate clic su Avanti.

• Selezionate il driver e poi Avanti.

• Se necessario, descrivere la stampante e applicare.

• Quando la stampante appare nella finestra, fare clic con il pulsante destro del 
mouse su Proprietà > Stampa pagina di prova per verificare che la connessione e 
il driver funzionino correttamente.

Risoluzione dei problemi

• Nell'applicazione Impostazioni di stampa è integrata un'utilità per la risoluzione dei 
problemi. Fare clic su Guida > Risoluzione dei problemi.

• Per le stampanti HP, il pacchetto aggiuntivo HP Printing ( ) installerà nell'area di 
notifica un'utile applet che fornisce strumenti per la risoluzione dei problemi.

• Se la stampante smette improvvisamente di stampare, verificare che sia ancora 
abilitata facendo clic sul menu Start > Sistema > Impostazioni di stampa, quindi 
fare clic con il pulsante destro del mouse sulla stampante e abilitarla nuovamente.

• Se la stampante non viene riconosciuta o non funziona correttamente, consultare il 

https://wiki.samba.org/index.php/Main_Page


Wiki MX/antiX per un aiuto dettagliato su come ottenere il driver corretto.

https://mxlinux.org/wiki/hardware/printer-drivers


3.1.3 Scanner

Gli scanner sono supportati in Linux da SANE (Scanner Access Now Easy), un'interfaccia di 
programmazione delle applicazioni (API) che fornisce un accesso standardizzato a qualsiasi 
hardware di scansione di immagini raster (scanner piano, scanner portatile, videocamere e 
fotocamere, frame-grabber, ecc.)

Fasi di base

È possibile gestire lo scanner in MX Linux con Simple Scan. È molto facile da usare e può 
esportare in PDF con un solo clic.

Risoluzione dei problemi

• Alcuni scanner richiedono un frontend (interfaccia di sistema con lo scanner) diverso: è 
possibile installare gscan2pdf, fare clic su Modifica > Preferenze e utilizzare il menu a 
discesa per selezionarne un altro (ad esempio, scanimage).

• Assicuratevi che il vostro scanner sia elencato come supportato da SANE in questo elenco.

• Se si continuano a riscontrare problemi, consultare il Wiki MX/antiX per trovare soluzioni.

3.1.4 Webcam

Molto probabilmente il video della vostra webcam funzionerà in MX Linux; potete verificarlo 
lanciando il menu Start > Multimedia > webcamoid e usando le impostazioni in fondo alla 
finestra per regolare il vostro sistema. Se non sembra funzionare, c'è una recente discussione 
dettagliata sui driver e sulla configurazione nel Wiki di Arch. L'audio della webcam a volte è più 
complicato, si veda la Sezione 4.1 su Skype.

3.1.5 Immagazzinamento

Unità disco (come SCSI, SATA e SSD), fotocamere, unità USB, telefoni, ecc. - sono tutte 
forme diverse di archiviazione.

Montaggio in magazzino

Per impostazione predefinita, i dispositivi di archiviazione collegati al sistema vengono montati 
automaticamente nella directory
/media/<nome utente>/ e per ognuno si apre una finestra del browser dei file (questo 
comportamento può essere modificato in Thunar: Modifica > Preferenze o KDE: Impostazioni di 
sistema > Archiviazione rimovibile).

http://www.sane-project.org/sane-mfgs.html
https://mxlinux.org/wiki/hardware/scanner
https://wiki.archlinux.org/index.php/Webcam


Non tutti i dispositivi di archiviazione, in particolare le unità e le partizioni interne aggiuntive, 
vengono montati automaticamente quando vengono inseriti nel sistema e potrebbero richiedere 
l'accesso come root. Le opzioni possono essere regolate con MX Tweak > Altro e Impostazioni 
> Unità e supporti rimovibili.



Permessi di archiviazione

L'ampiezza dell'accesso dell'utente allo storage dipende dal file system che contiene. La 
maggior parte dei dispositivi di archiviazione esterni commerciali, in particolare i dischi rigidi, 
sono preformattati come fat32 o ntfs.

Sistema di file di 
archiviazione

Permessi

FAT32 Nessuno.
NTFS Per impostazione predefinita, le autorizzazioni/proprietà sono 

concesse all'utente che monta il 
dispositivo.

ext2, ext4 e la maggior 
parte dei file 
system Linux

Montato per impostazione predefinita con proprietà 
impostata su Root. Regolazione dei 
permessi: vedere la Sezione 7.3.

È possibile modificare la necessità di Root per l'accesso ai dispositivi di archiviazione interni 
con file system Linux utilizzando MX Tweak, scheda Altro (Sezione 3.2).

Unità a stato solido

Le macchine più recenti possono essere dotate di un'unità SSD interna: un'unità a stato solido 
che non ha componenti in movimento. Queste unità tendono ad accumulare blocchi di dati che 
non sono più considerati in uso, rallentando questa unità molto veloce. Per evitare che ciò 
accada, MX Linux esegue un'operazione di TRIM con cadenza settimanale che può essere 
visualizzata aprendo il file /var/log/trim.log.

3.1.6 Dispositivi Bluetooth

I dispositivi Bluetooth esterni, quali tastiera, altoparlante, mouse e così via, normalmente 
funzionano automaticamente. In caso contrario, procedere come segue:

• Xfce: fare clic sul menu Start > Impostazioni > Bluetooth Manager (oppure: fare 
clic con il pulsante destro del mouse sull'icona Bluetooth nell'area di notifica > 
Dispositivi).

• KDE: fare clic sul menu Start > Impostazioni > Impostazioni di sistema > Hardware > Bluetooth

• Verificare che l'adattatore sia abilitato e che sia visibile facendo clic sul menu Start > 
Impostazioni > Adattatori Bluetooth.

• Assicurarsi che il dispositivo desiderato sia visibile; in Bluetooth Manager fare 
clic su Adapter > Preferences e selezionare l'impostazione di visibilità.

• Se la periferica desiderata è presente nella finestra Dispositivi, selezionarla e fare clic su Impostazione.

• In caso contrario, fare clic sul pulsante Cerca e premere Connetti sulla riga del 

https://en.wikipedia.org/wiki/Solid-state_drive
https://en.wikipedia.org/wiki/Trim_(computing)


dispositivo per avviare l'associazione.



• Per un telefono, è probabile che si debba confermare il numero di accoppiamento sia 
sul telefono che sul desktop.

• Dopo l'accoppiamento con il dispositivo Bluetooth, la finestra di dialogo Setup 
chiede di confermare il tipo di configurazione Bluetooth da associare al dispositivo.

• Al termine del processo di configurazione, il dispositivo dovrebbe essere funzionante.

Trasferimento di oggetti

Per poter passare oggetti (documenti, foto, ecc.) da un desktop MX Linux a un dispositivo 
come un telefono utilizzando la tecnologia Bluetooth, è necessario procedere come segue:

• Installare obex-data-server dai repo.

• Porterà con sé libopenobex2.

• In rari casi, il pacchetto obex-data-server può bloccare l'uso del mouse o 
della tastiera Bluetooth.

• Verificare che il telefono e il desktop siano entrambi abilitati al Bluetooth e siano visibili.

• Inviare il file.

• Dal desktop di MX Linux: fare clic con il tasto destro del mouse sull'icona 
Bluetooth nell'area di notifica > Invia file (oppure utilizzare Bluetooth 
Manager)

• Dal telefono: seguite le istruzioni appropriate per il vostro dispositivo.

• Tenere d'occhio il dispositivo ricevente per confermare l'accettazione 
dell'oggetto trasferito.

È anche possibile utilizzare hcitool alla riga di comando.

Collegamenti

• Risoluzione dei problemi di Blueman

• Wiki Arco

• Wiki Debian sull'accoppiamento

3.1.7 Pastiglie a penna
Le tavolette con penna Wacom vengono rilevate automaticamente e supportate in modo nativo 
su Debian. I dettagli nel Wiki MX/antiX.

http://www.linuxjournal.com/content/bluetooth-hacks
https://github.com/blueman-project/blueman/wiki/Troubleshooting
https://wiki.archlinux.org/index.php/Blueman
https://wiki.debian.org/BluetoothUser#Pairing
https://www.wacom.com/en-us/
https://mxlinux.org/wiki/hardware/wacom/


Collegamenti
• Il progetto Linux Wacom

3.2 Strumenti MX di base

Un certo numero di applicazioni sono state sviluppate specificamente per MX Linux, adattate 
o portate da antiX, o adattate da fonti esterne per risparmiare all'utente la fatica di compiti 
importanti che spesso comportano passaggi poco intuitivi. (Snapshot e altri strumenti avanzati 
sono trattati nella Sezione 6.6).

Figura 3-3: Cruscotto di MX Tools (Xfce installato). I cruscotti di Live e KDE sono 
leggermente diversi.

3.2.1 MX Updater (ex Apt-Notifier)

Questa versatile applet (solo per Xfce, KDE usa Discover) si trova nell'area delle notifiche e 
segnala la disponibilità di pacchetti. Assicuratevi di controllare le importanti opzioni disponibili

https://linuxwacom.github.io/
https://userbase.kde.org/Discover


attraverso il menu contestuale (tasto destro del mouse). Se non appare, lanciare MX Updater 
per aggiornarlo. Solo Xfce, KDE usa Discover.

Figura 3-4: Schermata di visualizzazione e aggiornamento da MX Updater.

Si noti la scelta tra upgrade e dist-upgrade.

• full-upgrade (dist-upgrade): è l'azione predefinita. Aggiornerà tutti i pacchetti che 
hanno aggiornamenti, anche quelli in cui l'aggiornamento comporterà la rimozione 
automatica di altri pacchetti esistenti o l'aggiunta di nuovi pacchetti all'installazione, in 
modo che tutte le dipendenze siano risolte.

• upgrade: consigliato solo agli utenti più esperti. Aggiorna solo i pacchetti aggiornabili 
che non comportano la rimozione o l'installazione di altri pacchetti. L'uso di questa 
opzione significa che alcuni pacchetti aggiornabili potrebbero rimanere "bloccati" sul 
sistema.

• Nelle Preferenze è disponibile un'opzione per l'aggiornamento non presidiato. 
Questo avviene in background e non aggiunge nuovi pacchetti o rimuove quelli 
esistenti, utilizzando il metodo "upgrade" piuttosto che dist-upgrade.

• Altre opzioni sono disponibili nel file di configurazione: ~/.config/MX-Linux/apt-

notifier.conf HELP: qui.

3.2.2 Configurazione di Bash

Bash (il linguaggio di shell predefinito in MX Linux) può ora essere impostato con questa 
piccola applicazione. Essa consente all'utente avanzato di apportare modifiche agli alias e alla 
tematizzazione del prompt del terminale nel file bashrc nascosto dell'utente.

https://mxlinux.org/wiki/help-files/help-mx-apt-notifier


Figura 3-5: la scheda per aggiungere o modificare un alias.

Aiuto: qui.

3.2.3 Opzioni di avvio

Figura 3-6: Schermata principale che mostra le varie opzioni.

https://mxlinux.org/wiki/help-files/help-bash-config/


Le opzioni di avvio includono i parametri del kernel, i temi di GRUB, le immagini Splash e altri 
elementi. Questa applicazione consente agli utenti di gestirle in modo semplice e veloce. 
L'opzione "Manage UEFI Boot Options" appare solo quando il PC è avviato in modalità UEFI. 
Esempio seguente

AIUTO: qui.

3.2.4 Riparazione degli stivali

Il bootloader è il primo programma software ad essere eseguito ed è responsabile del 
caricamento e del trasferimento del controllo al kernel. A volte capita che il bootloader di 
un'installazione convenzionale (GRUB2) diventi disfunzionale; questo strumento consente di 
ripristinare il bootloader in uno stato funzionale da un avvio LIVE.

Figura 3-7: Schermata principale di Boot Repair, con l'opzione più comune selezionata.

AIUTO: qui.

https://mxlinux.org/wiki/help-files/help-mx-boot-options
https://mxlinux.org/wiki/help-files/help-mx-boot-repair


3.2.5 Voci di sistema della luminosità

Questo strumento inserisce un'icona nel Systray che visualizza una piccola applicazione con la 
quale l'utente può regolare la luminosità dello schermo.

Figura 3-8: pronti a regolare la luminosità.

3.2.6 Scansione di salvataggio di Chroot

Questo strumento consente di accedere a un sistema anche se il file 

initrd.img è rotto. AIUTO: qui.

Figura 3-9: risultati della scansione per i sistemi Linux.

3.2.7 Correggere le chiavi GPG (in precedenza Check apt GPG)

Se si tenta di installare dei pacchetti non autenticati, si incorre in un errore di apt: Non è stato 
possibile verificare le seguenti firme perché la chiave pubblica non è disponibile. Questa utile 
utility evita di eseguire i numerosi passaggi necessari per ottenere tale chiave.

https://mxlinux.org/wiki/system/chroot-rescue-scan/


Figura 3-10: Risultati della verifica delle chiavi pubbliche del repo con quelle di Fix GPG.

AIUTO: qui.

3.2.8 Pulizia MX

Figura 3-11: Cleanup pronto a lavorare.

Questa piccola applicazione offre un modo semplice e sicuro per rimuovere i file non necessari 
e ripristinare lo spazio. Lo strumento di rimozione del kernel viene utilizzato per rimuovere i 
kernel più vecchi non più in uso.

AIUTO: qui.

https://mxlinux.org/wiki/help-files/help-mx-check-apt-gpg
https://mxlinux.org/wiki/help-files/help-mx-cleanup/


3.2.9 Installatore di codec

Un codec è un software che consente di codificare/decodificare un flusso di dati o un segnale 
digitale. La maggior parte dei codec viene installata in MX Linux, ma alcuni sono limitati. 
Verranno installati anche Libdvdcss2 (per la lettura di DVD commerciali) e libtxc-dxtn0 (per 
alcune texture di giochi 3D). Questo strumento consente di installare facilmente alcuni codec 
con restrizioni, trasferendo la responsabilità all'utente.

Figura 3-12: Schermata principale del programma di installazione dei codec.

AIUTO: qui.

3.2.10 MX Conky
L'applicazione denominata MX Conky funziona insieme a Conky Manager per manipolare con 
estrema facilità i dettagli di un Conky, in particolare il colore, nella collezione MX Conky. Nel 
menu è presente anche un'applicazione "Conky Toggle" per spegnere e accendere qualsiasi 
Conky configurato.

Figura 3-13: Conky pronto a modificare i dettagli di un Conky predefinito.

AIUTO: qui.

https://mxlinux.org/wiki/help-files/help-mx-codecs-installer
https://teejeetech.in/conky-manager/
https://mxlinux.org/wiki/help-files/help-mx-conky


3.2.11 Programmatore di lavori

Questa pratica applicazione presenta un frontend grafico all'applicazione a riga di comando 
crontab, facilitando l'impostazione dei lavori.

Figura 3-15: Programmatore di lavori.

HELP: file dei lavori locali: /usr/share/job-scheduler/locale/

3.2.12 Creatore di USB dal vivo

Questo semplice strumento consente di creare rapidamente una Live-USB partendo da un file 
ISO, da un CD/DVD live, da una Live-USB esistente o anche da un sistema live in esecuzione.

Figura 3-16: Live USB Maker.

Aiuto: qui

https://mxlinux.org/wiki/system/crontab/


3.2.13 Assistente di rete

Questa applicazione semplifica il processo di risoluzione dei problemi di rete, rilevando 
l'hardware, modificando lo stato di uno switch hardware, consentendo la gestione dei driver 
Linux e fornendo strumenti di rete generali.

Figura 3-18: Network Assistant rileva l'hardware wireless.

AIUTO: qui.

3.2.14 Programma di installazione dei driver Nvidia

Il programma di installazione dei driver grafici Nvidia semplifica notevolmente una procedura 
importante: l'installazione di un driver grafico proprietario utilizzando lo script sottostante ddm-
mx. Facendo clic sull'icona del programma di installazione dei driver Nvidia si accede a un 
terminale e, nella maggior parte dei casi, l'utente non deve fare altro che accettare le 
impostazioni predefinite.

AIUTO: qui.

3.2.15 Installatore di pacchetti

 VIDEO: Installare le applicazioni con MX Package Installer

https://mxlinux.org/wiki/help-files/help-mx-network-assistant
https://mxlinux.org/wiki/help-files/help-amd-ati-and-nvidia-installers
https://www.youtube.com/watch?v=4kXSMfPkQSA


Il semplice gestore di pacchetti personalizzato per MX Linux consente di cercare, installare o 
rimuovere sia i pacchetti più diffusi sia qualsiasi pacchetto presente nei repository MX/Debian 
Stable, MX Test, Debian Backports e Flatpak in modo rapido, sicuro e semplice.

Figura 3-20: Il programma di installazione dei pacchetti mostra i pacchetti più diffusi per lo sviluppo.

AIUTO: qui.

3.2.16 Informazioni rapide sul sistema

Figura 3-21: Schermata principale

Questo utile strumento consente all'utente di consultare facilmente i file di registro. Il registro 
predefinito è Quick System Info, necessario per i messaggi del forum: si noti il pulsante "Copia 
per il forum" che permette con un semplice clic di inserire il contenuto del registro già 
formattato.

https://mxlinux.org/wiki/help-files/help-mx-package-installer


3.2.17 Gestore delle operazioni di pronti contro termine

Ci sono molte ragioni per cui l'utente potrebbe voler cambiare il mirror predefinito, da un 
server offline a un cambiamento nella posizione fisica del computer. Questo ottimo strumento 
consente di cambiare i repo con un solo clic, risparmiando molto tempo e fatica.

È inoltre disponibile un pulsante che consente di testare tutti i repo (MX o Debian) e di selezionare il più 
veloce.

Figura 3-21: Scelta del repository da usare in Repo Manager.

AIUTO: qui.

3.2.18 Configurazione di Samba

MX Samba Config è uno strumento che aiuta gli utenti a gestire le loro condivisioni di rete 
samba/cifs. Gli utenti possono creare e modificare le condivisioni di cui sono proprietari, nonché 
gestire i permessi di accesso degli utenti per tali condivisioni.

AIUTO: qui

https://mxlinux.org/wiki/help-files/help-mx-repo-manager
https://mxlinux.org/wiki/help-files/help-mx-samba-config/


3.2.19 Scheda audio

Spesso i computer dispongono di più di una scheda audio e l'utente che non sente nulla può 
concludere che il suono non funziona. Questa piccola applicazione intelligente permette 
all'utente di selezionare quale scheda audio deve essere utilizzata dal sistema.

Figura 3-22: Effettuare la selezione in Scheda audio.

AIUTO: qui.

3.2.20 Tastiera di sistema

Figura 3-23: La schermata principale è pronta per consentire all'utente di selezionare una tastiera diversa.

Nel caso in cui l'utente abbia trascurato di selezionare la tastiera di sistema dal menu di accesso, 
non l'abbia impostata nella sessione Live o abbia semplicemente bisogno di apportare una 
modifica, questa piccola applicazione offre un modo semplice per eseguire l'operazione dal 
menu Start.

AIUTO: qui.

https://mxlinux.org/wiki/help-files/help-sound-card
https://mxlinux.org/wiki/help-files/help-mx-system-keyboard


3.2.21 Lingue del sistema

Figura 3-24: Presentazione dei locali da generare per l'utente.

Nel caso in cui l'utente abbia trascurato di selezionare la localizzazione del sistema dal menu di 
accesso, non l'abbia impostata nella sessione Live o abbia semplicemente bisogno di una 
modifica, questa piccola applicazione offre un modo semplice per eseguire l'operazione dal 
menu Start.

AIUTO: qui.

3.2.22 Suoni di sistema (solo Xfce)

Questo piccolo strumento raccoglie in un'unica posizione le varie azioni e scelte coinvolte 
nell'impostazione dei suoni del sistema, come login/logout, azioni, ecc.

Figura 3-25: Impostazione dei suoni di login e logout in Suoni di sistema.

AIUTO: qui.

3.2.23 Data e ora

MX Date & Time consente di effettuare regolazioni di ogni tipo da un'unica applicazione. Solo Xfce.

https://mxlinux.org/wiki/help-files/help-mx-system-locales
https://mxlinux.org/wiki/help-files/help-mx-system-sounds


Figura 3-26: La scheda principale di Data e ora

AIUTO: qui.

3.2.24 MX Tweak

MX Tweak riunisce una serie di personalizzazioni piccole ma spesso utilizzate, come la 
gestione dei pannelli, la selezione dei temi, l'abilitazione e l'impostazione del compositore, ecc. 
su base individuale.

Figura 3-27: Le facce di MX-Tweak. A destra: Plasma, sinistra: XFCE.

AIUTO: qui.

https://mxlinux.org/wiki/help-files/date-time/
https://mxlinux.org/wiki/help-files/help-mx-tweak


3.2.25 Formato USB

Figura 3-28: Il formattatore USB è pronto a riformattare con FAT32.

Questo pratico strumento pulisce e riformatta un'unità USB per renderla disponibile per nuovi 
scopi.

AIUTO: qui.

3.2.26 Smontaggio USB (solo Xfce)

Questo strumento per smontare rapidamente i supporti USB e ottici si trova nell'area di notifica 
quando è abilitato (impostazione predefinita). Con un solo clic vengono visualizzati i supporti 
disponibili da smontare con un doppio clic.

Figura 3-29: USB Unmounter con un dispositivo evidenziato per lo smontaggio.

AIUTO: qui.

3.2.27 Manager dell'utente
Questo strumento facilita l'aggiunta, la modifica e la rimozione di utenti e gruppi nel sistema.

https://mxlinux.org/wiki/help-files/help-mx-format-usb/
https://www.mxlinux.org/wiki/help-files/help-mx-usb-unmounter


Figura 3-30: Gestione utenti, scheda Amministrazione.

AIUTO: qui.

3.2.28 Pacchetti installati dall'utente

Questa applicazione ha lo scopo di facilitare la reinstallazione dei pacchetti che 
l'utente ha aggiunto all'installazione predefinita.

Può visualizzare un elenco di pacchetti installati manualmente dall'utente, che può 
essere salvato in un semplice file di testo. Inoltre, l'applicazione consente di 
caricare un elenco salvato di pacchetti per rivederlo e selezionarlo per 
reinstallarlo. Questa procedura è particolarmente facile e utile quando si installa 
un nuovo sistema.

HELP:: file:///usr/share/user-installed-packages/help.html

3.2.29 Installatore Deb
Questo semplice strumento installa i pacchetti deb (Sezione 5.5.2) scaricati.

• Fare clic con il pulsante destro del mouse sul pacchetto deb che si desidera installare > "Apri con Deb 
Installer".

• Fare clic su Installa. Quando viene richiesto, inserire la password di root.

https://mxlinux.org/wiki/help-files/help-mx-user-manager


Deb Installer tenterà di installare il pacchetto e ne riporterà i risultati.

3.2.3 Strumenti deprecati

Alcuni utenti cercano strumenti che non esistono più o che sono stati incorporati in nuovi 
strumenti.

• ATI/AMD Driver Installer: rimosso per mancanza di un candidato driver adatto.

• Broadcom Manager: riscritto per esigenze più generali come Network Assistant.

• Compton Manager: incorporato in MX Tweak.

• Installatore Debian Backports: incorporato nel programma di installazione dei pacchetti.

• Aspetto predefinito: incorporato in MX Tweak.

• Trova condivisioni di rete: rimosso per problemi di licenza.

• Flash Manager: Adobe® Flash® Player è ora deprecato ed è stato completamente 
rimosso.

• Idevice Mounter: rimosso per mancanza di supporto software.

• Editor di menu: sostituito da MenuLibre.

• Orientamento del pannello: incorporato in MX Tweak.

• Test Repo Installer: incorporato nel Package Installer .

• Gdebi: lo strumento Deb Installer MX lo ha sostituito.



3.3 Display

3.3.1 Risoluzione del display

Figura 3-31: Utilità di visualizzazione. Sinistra: Xfce, destra: KDE/Plasma.

La risoluzione si riferisce al numero fisico di colonne e righe di pixel che creano il display (ad 
esempio, 1920x1200). Nella maggior parte dei casi, la risoluzione viene impostata correttamente 
dal kernel durante l'installazione o quando si collega un nuovo monitor. In caso contrario, è 
possibile modificarla nei seguenti modi:

• Xfce: fare clic su Menu Start > Impostazioni > Schermo. Utilizzare i menu a discesa 
per impostare i valori corretti per il monitor che si desidera regolare. Per ulteriori 
opzioni e un controllo più preciso, installare xrandr dai repo.

• KDE: Menu Start > Impostazioni di sistema > Schermo e monitor > Configurazione dello schermo.

• Il display di Xfce consente di scalare in modo frazionario per i monitor HiDPI. Fare 
clic sul menu a tendina "Scala" e selezionare Personalizzato.

• In situazioni difficili, è possibile modificare manualmente il file di configurazione
/etc/X11/xorg.conf. Potrebbe non esistere, quindi potrebbe essere necessario crearlo 
prima. Eseguire sempre un backup del file prima di modificarlo e consultare il forum 
per informazioni sull'uso del file.

3.3.2 Driver grafici

Se non si è soddisfatti delle prestazioni dello schermo, potrebbe essere necessario aggiornare il 
driver grafico (assicurarsi di aver prima eseguito il backup del file /etc/X11/xorg.conf, se 
utilizzato). Si noti che dopo un aggiornamento del kernel potrebbe essere necessario ripetere 
questa operazione, si veda la Sezione 7.6.3.

Esistono vari metodi per farlo.

• Per la maggior parte delle schede Nvidia, il metodo di gran lunga più semplice è 
quello di utilizzare gli installatori accessibili dalla dashboard di MX Tools 

https://xorg-team.pages.debian.net/xorg/howto/use-xrandr.html
https://wiki.debian.org/Xorg#What_if_I_do_not_have_a_xorg_config_file.3F


(vedere Sezione 3.2).



• Alcune schede video più vecchie o meno comuni richiedono driver (come 
openchrome, mach64 e fbdev) che sono facilmente installabili solo con sgfxi 
(Sezione 6.5.3).

• Alcune schede Nvidia non sono più supportate da Debian Stable ("Jessie"), si 
veda la Wiki MX/antiX. Sono tuttavia supportate dai driver nouveau e vesa.

• È possibile installare il pacchetto nvidia-settings per uno strumento grafico 
che può essere utilizzato per modificare le impostazioni come root con il 
comando: nvidia-settings

• Consultare il Wiki Debian sui driver open-source per ati, radeon e amdgpu. Si noti 
che i driver aperti per AMD non sono più disponibili.

• È anche possibile, ma più complicato, scaricare direttamente dal produttore. Questo 
metodo richiede di selezionare e scaricare il driver corretto per il proprio sistema; per 
informazioni sul sistema, aprire un terminale e digitare: inxi -Gxx.

Ecco i siti web dei driver per i marchi più diffusi (per gli altri fate una ricerca sul web su 
"<nome> driver linux"):

• Nvidia

• Intel

I driver Intel devono essere compilati, ma i driver Nvidia scaricati sono facilmente installabili:

• Navigare in Thunar fino alla cartella in cui è stato scaricato il driver.

• Fare clic con il tasto destro del mouse sul file, selezionare la scheda Autorizzazioni e 
selezionare Is executable.

• Premere CTRL-ALT-F1 per uscire da X (l'ambiente grafico) e 
accedere al prompt del terminale.

• Accedere come root.

• Tipo: servizio lightdm stop.

• Digitare: sh <nomefile>.run (assicurarsi di utilizzare il nome effettivo del file).

• Consentire al driver NVIDIA di disattivare il kernel nouveau.

• Al termine, digitare: service lightdm start per avviare nuovamente lightdm e xorg.

• Un'altra importante opzione di driver è MESA, un'implementazione open-source 
della specifica OpenGL, un sistema per il rendering della grafica 3D interattiva. Gli 
utenti di macchine ad alte prestazioni riferiscono che l'aggiornamento di questo driver 

https://mxlinux.org/wiki/hardware/unsupported-nvidia-gpus
https://en.wikipedia.org/wiki/Nouveau_(software)
https://wiki.debian.org/AtiHowTo
http://www.nvidia.com/Download/index.aspx
https://www.intel.com/content/www/us/en/download-center/home.html
https://mxlinux.org/wiki/applications-system/compiling-software
http://www.opengl.org/


comporta una significativa stabilizzazione del sistema.



• Una versione più recente potrebbe essere disponibile nel Repo di prova; per 
ottenerla, usare l'MX Package Installer (Sezione 3.2). Deselezionare la casella 
che nasconde i pacchetti lib e dev, cercare "MESA" e selezionare i pacchetti 
aggiornabili per l'installazione.

• Le schede grafiche ibride combinano due adattatori grafici sulla stessa unità. Un 
esempio popolare è l'NVidia Optimus, che è supportato su Linux con 
Bumblebee/Primus. Le schede grafiche più recenti possono anche utilizzare le 
funzioni Primus integrate nel driver nvidia senza il sistema Bumblebee. Per eseguire 
un'applicazione con le funzioni Primus, utilizzare "nvidia-run-mx APP" per avviare 
un'applicazione con l'accelerazione grafica abilitata.

3.3.3 Caratteri

Regolazione di base

1. XFCE- Fare clic sul menu Start > Tutte le impostazioni > Aspetto, scheda Caratteri.

2. KDE/Plasma - Fare clic sul menu Start > Impostazioni di sistema > Aspetto > Caratteri.

3. Fare clic sul menu a discesa per visualizzare l'elenco dei font e delle dimensioni dei punti.

4. Selezionare quella desiderata e fare clic su OK.

Regolazioni avanzate

1. Sono disponibili diverse opzioni eseguendo in un terminale root: dpkg-
reconfigure fontconfig-config

2. Le singole applicazioni possono avere i propri controlli, spesso presenti in 
Modifica (o Strumenti) > Preferenze.

3. Per ulteriori regolazioni, consultare il Wiki MX/antiX.

4. I display ad alta risoluzione hanno esigenze particolari, vedere il Wiki MX/antiX.

Aggiunta di font

1. Ci sono alcuni pacchetti di font in MX Package Installer disponibili con un solo clic. 
Per ulteriori possibilità, fare clic su (Xfce) Menu Start > Sistema > Synaptic Package 
Manager; KDE: usare Discover invece di Synaptic.

2. Utilizzate la funzione di ricerca dei font.

3. Selezionare e scaricare quelli desiderati. Il pacchetto Microsoft (Core) Fonts ttf- 
mscorefonts-installer in MX Package Installer consente di installare facilmente 
i fonts

https://en.wikipedia.org/wiki/Nvidia_Optimus
https://wiki.debian.org/NVIDIA%20Optimus
https://www.mxlinux.org/wiki/system/font-adjustment
https://mxlinux.org/wiki/other/high-resolution-displays


Microsoft True Type Core Fonts da utilizzare con i siti web e le applicazioni MS che 
girano sotto Wine.

4. Estrarre se necessario, quindi copiare come root (più facilmente in un Thunar root) la cartella dei font in
/usr/share/fonts/.

5. I nuovi caratteri dovrebbero essere disponibili in (Xfce) il menu a discesa in Tutte le 
impostazioni > Aspetto, scheda Caratteri o (KDE) Menu di avvio > Impostazioni di 
sistema > Aspetto > Caratteri.

3.3.4 Doppio monitor

I monitor multipli sono gestiti in MX Linux Xfce con il menu Start > Impostazioni > Display. È 
possibile utilizzarlo per regolare la risoluzione, selezionare se uno clona l'altro, quali monitor 
saranno accesi, ecc. Spesso è necessario uscire e rientrare per vedere il display selezionato. Si 
consiglia di consultare anche la scheda Display di MX Tweak. Un controllo più preciso di 
alcune caratteristiche è talvolta disponibile con xrandr.

Xfce 4.18 ha migliorato notevolmente la gestione dei monitor multipli, con impostazioni nella 
scheda Avanzate di Display che consentono impostazioni dettagliate per ogni monitor e la 
possibilità di salvare i profili dei monitor e di utilizzarli automaticamente quando lo stesso 
hardware viene nuovamente collegato. Se i problemi persistono, cercate nel Forum Xfce, nel 
Forum MX Linux e nel WIki MX/antiX se avete problemi insoliti.

In KDE/Plasma i doppi monitor vengono impostati con lo Strumento di configurazione del display.

Collegamenti

• Documenti Xfce: Display

3.3.5 Gestione dell'alimentazione

Fare clic sull'icona dei plugin di Power Manager nel Pannello. Qui si può facilmente passare 
alla modalità Presentazione (Xfce), oppure andare alle Impostazioni per impostare quando uno 
schermo si spegne, quando il computer va in sospensione, l'azione avviata dalla chiusura del 
coperchio di un portatile, la luminosità, ecc. Su un computer portatile, vengono visualizzati lo 
stato della batteria e le informazioni, ed è disponibile un cursore per la luminosità.

3.3.6 Regolazione del monitor
Sono disponibili diversi strumenti per regolare la visualizzazione per determinati monitor.

• La luminosità dello schermo può essere impostata (solo per Xfce) con il menu Start > 
Impostazioni > Power Manager, scheda Display; MX Tweak o MX Brightness Systray 
che inserisce un pratico widget nel Systray.

https://forum.xfce.org/
https://mxlinux.org/wiki/xfce/xfce-commands-and-other-useful-stuff
https://docs.xfce.org/xfce/xfce4-settings/4.14/display


• Per gli utenti con Nvidia, utilizzare nvidia-settings come root per regolare con precisione la 
visualizzazione.

• Per modificare la gamma (contrasto), aprire un terminale e digitare:

xgamma -gamma 1.0

1.0 è il livello normale; modificarlo in aumento o in diminuzione per diminuire/aumentare il contrasto.

• L'adattamento del colore del display all'ora del giorno può essere controllato con 
fluxgui o Redshift.

• Per regolazioni più avanzate e creazione di profili, installare displaycal.

• È possibile creare profili colore (solo Xfce): Start > Impostazioni > Profili colore. 
Un profilo di colore è un insieme di dati che caratterizzano un dispositivo di input 
o di output del colore e la maggior parte di essi deriva dai profili ICC.

Figura 3-32: Preparazione all'aggiunta di un profilo colore.

AIUTO: qui.

3.3.7 Strappo dello schermo
Lo screen tearing è un artefatto visivo nella visualizzazione video in cui un dispositivo di 
visualizzazione mostra informazioni da più fotogrammi in un'unica schermata (Wikipedia). Il 
fenomeno tende a variare notevolmente in base a fattori quali l'hardware grafico, la particolare 
applicazione e la sensibilità dell'utente.

In MX Linux sono disponibili diverse soluzioni:

• Fare clic sulla scheda Compositore in MX Tweak e utilizzare il menu a discesa per 
passare da xfwm predefinito a Compton, un compositore indipendente.

• Utilizzare il menu a discesa per modificare la spaziatura verticale (vblank).

• Quando viene rilevato un driver grafico Intel, nella scheda MX Tweak > Config Options 
è disponibile una casella di controllo che allontana il sistema dal "modesetting" 
predefinito, un interruttore che attiva l'opzione TearFree del driver Intel. Le opzioni 
Tearfree esistono anche per nouveau, radeon e amdgpu e vengono visualizzate a seconda 
dei casi.

Collegamenti

https://en.wikipedia.org/wiki/Gamma_correction
https://justgetflux.com/linux.html
http://jonls.dk/redshift/
https://displaycal.net/
https://en.wikipedia.org/wiki/ICC_profile
https://docs.xfce.org/xfce/xfce4-settings/4.16/display
https://docs.xfce.org/xfce/xfwm4/start
https://en.wikipedia.org/wiki/Compositing


• Wiki MX/antiX

https://mxlinux.org/wiki/hardware/screen-tearing


3.4 Rete

Le connessioni a Internet sono gestite da Network Manager:

--Fare clic con il tasto sinistro del mouse sull'applet nell'area di notifica di Systray per visualizzare lo stato, la 
connessione e le opzioni di esplorazione.

--Fare clic con il tasto destro del mouse sull'applet > Modifica connessioni per aprire una finestra 
di impostazioni con cinque schede. KDE: facendo clic con il tasto destro si aprirà Configura 
connessioni di rete. Fare clic su di esso per aprire la casella delle impostazioni.

• Cablato. Nella maggior parte delle situazioni non è necessario prestare attenzione; per 
le configurazioni speciali, evidenziare e fare clic sul pulsante Modifica.

• Senza fili

• Network Manager di solito rileva automaticamente la scheda di rete e la 
utilizza per trovare i punti di accesso disponibili.

• Per i dettagli, vedere la sezione 3.4.2.

• Banda larga mobile (solo Xfce). Questa scheda consente di utilizzare un dispositivo 
mobile 3G/4G per accedere al web. Fare clic sul pulsante Aggiungi per configurare.

• VPN. Fare clic sul pulsante Aggiungi per eseguire la configurazione. In caso di 
problemi di configurazione, consultare il Wiki MX/antiX.

• DSL (solo Xfce). Fare clic sul pulsante Aggiungi per configurare.

ALTRO: Wiki Ubuntu: Gestore di rete

3.4.1 Accesso via cavo

In genere MX Linux rileva l'accesso a Internet via cavo all'avvio senza problemi. Se è 
necessario un driver Broadcom (raro), utilizzare MX Network Assistant (Sezione 3.2).

Ethernet e cavo

MX Linux viene fornito preconfigurato per una LAN (Local Area Network) standard che utilizza 
il protocollo DHCP (Dynamic Host Configuration Protocol) per assegnare gli indirizzi IP e la 
risoluzione DNS (Domain Name System). Nella maggior parte dei casi funziona così com'è. È 
possibile modificare la configurazione con Network Manager (KDE: Interfacce di rete).

https://mxlinux.org/wiki/networking/vpn
https://help.ubuntu.com/community/NetworkManager


Quando si avvia MX Linux, agli adattatori di rete viene assegnato un nome di interfaccia breve 
da udev, il gestore di dispositivi del kernel. Per i normali adattatori cablati questo è solitamente 
eth0 (con i successivi eth1, eth2, eth3, ecc.). Gli adattatori USB vengono spesso visualizzati 
sull'interfaccia eth0 in MX Linux, ma il nome dell'interfaccia può anche dipendere dal chipset 
dell'adattatore. Ad esempio, le schede Atheros vengono spesso visualizzate come ath0, mentre 
gli adattatori usb ralink possono essere rausb0. Per un elenco dettagliato di tutte le interfacce di 
rete trovate, aprire un terminale, diventare root e digitare: ifp -a.

È consigliabile collegarsi a Internet tramite un router, poiché quasi tutti i router cablati 
contengono firewall opzionali. Inoltre, i router utilizzano il NAT (Network Address Translation) 
per tradurre i grandi indirizzi Internet in indirizzi IP locali. Questo offre un ulteriore livello di 
protezione. Se ci si collega al router direttamente o tramite un hub o uno switch, la macchina si 
autoconfigura tramite DHCP.

ADSL o PPPoE (solo Xfce)

Se si utilizza ADSL o PPPoE, la connessione a Internet è facile in MX Linux. Fare clic con il 
tasto destro del mouse sull'icona Network Manager, quindi sulla scheda DSL. Fare clic sul 
pulsante Aggiungi... e compilare le informazioni richieste, selezionando se si desidera la 
connessione automatica.

NOTA: se si verificano problemi durante la connessione di un dispositivo USB, collegare 
l'unità al computer, aprire un terminale e digitare:

dmesg | tail

Pubblicare l'output sul forum MX Linux per ottenere aiuto nella ricerca del driver necessario.

Figura 3-34: Impostazione del servizio DSL.



Internet in Dial-Up

Nella scheda Dispositivo è necessario impostare le informazioni seriali. Accettare il valore predefinito
/dev/modem può funzionare, ma potrebbe essere necessario provare un'altra interfaccia. Questi 
sono gli equivalenti Linux delle porte COM in Windows:

Tabella 3: equivalenti Linux per le porte COM.

Porto Equivalente
COM 1 /dev/ttyS0
COM 2 /dev/ttyS1
COM 3 /dev/ttyS2
COM 4 /dev/ttyS3

3.4.2 Accesso wireless.

MX Linux è preconfigurato per rilevare automaticamente una scheda WiFi e nella maggior 
parte dei casi la scheda viene trovata e configurata automaticamente.

Un driver nativo viene solitamente fornito come parte del kernel Linux (esempio: ipw3945 per 
Intel), ma su alcune macchine, soprattutto quelle più recenti, potrebbe essere necessario scaricare 
un driver utilizzando le informazioni contenute in Informazioni rapide sul sistema > Rete.

A volte sono disponibili più driver. È possibile che vogliate confrontarli per velocità e 
connettività e che dobbiate inserire nella lista nera o rimuovere quello che non utilizzate per 
evitare un conflitto. Le schede wireless possono essere interne o esterne. I modem USB (dongle 
wireless) di solito vengono visualizzati nell'interfaccia wlan, ma se non lo sono, controllare gli 
altri nell'elenco.

NOTA: Il metodo corretto varia a seconda degli utenti a causa delle complicate interazioni tra 
il kernel Linux, gli strumenti wireless e il chipset della scheda wireless locale e il router.

Passi base per il wireless

Fare clic sul menu Start > Impostazioni > Connessioni di rete (KDE: Menu Start > 
Connessioni), oppure fare semplicemente clic sull'icona Network Manager nell'area di notifica), 
quindi sulla scheda Wireless. Si presenterà una delle tre situazioni.

-È stata trovata una rete wireless.

• Fare clic sul nome della rete per utilizzarla.

• Fare clic con il tasto destro del mouse sull'icona per accedere ad altre opzioni.

• Al termine, fare clic su OK.

-La rete trovata non funziona.



Se le reti wireless vengono viste ma il computer non riesce a connettersi, significa che 1) la 
scheda wireless è gestita correttamente dal driver giusto, ma ci sono problemi di connessione al 
modem/router, al firewall, al provider, al DNS e così via; oppure 2) la scheda wireless è gestita 
in modo anomalo perché il driver non è il più adatto per quella scheda o ci sono problemi di 
conflitto con un altro driver. In questo caso è necessario raccogliere informazioni sulla scheda 
wireless per verificare se i driver della scheda possono avere problemi e quindi provare a testare 
la rete con un set di strumenti diagnostici.

• Le informazioni di base si ottengono aprendo un terminale e inserendone una alla volta:

inxi -n

lsusb | grep -i 

net lspci | grep -i 

net E come root:

iwconfig

L'output di questi comandi fornisce il nome, il modello e la versione (se presente) della scheda 
wireless (esempio sotto), nonché il driver associato e l'indirizzo mac della scheda wireless. 
L'output del quarto comando fornisce il nome dell'Access Point (AP) a cui si è collegati e altre 
informazioni sulla connessione. Ad esempio:

Rete
Scheda-2: Scheda di rete wireless Qualcomm Atheros AR9462 driver: 
ath9k IF: wlan0 stato: attivo mac: 00:21:6a:81:8c:5a

A volte è necessario il numero MAC del chipset oltre a quello della scheda wireless. Il modo 
più semplice per farlo è fare clic sul menu Start > Sistema > MX Network Assistant, scheda 
Introduzione. Ad esempio:

Scheda di rete wireless Qualcomm Atheros AR9485 [168c:0032] (rev. 01)

Il numero tra parentesi identifica il tipo di chipset della scheda wireless. I numeri prima dei due 
punti identificano il produttore, quelli dopo il prodotto.

Utilizzate le informazioni raccolte in uno dei seguenti modi:

• Effettuare una ricerca sul Web utilizzando queste informazioni. Alcuni esempi che utilizzano l'output 
di lspci di cui sopra.

linux Qualcomm Atheros AR9462
linux 168c:0032
debian stable 0x168c 0x0034

• Consultare i siti Linux Wireless e Linux Wireless LAN Support per scoprire 
di quale driver ha bisogno il vostro chipset, quali conflitti potrebbero esserci 
e se ha bisogno di un firmware installato separatamente. Pubblicare le 
informazioni sul forum MX Linux e chiedere aiuto.



• Disattivare il Firewall, se presente, finché non si verifica il collegamento 
tra il computer e il router.

• Provare a riavviare il router.

• Utilizzare la sezione diagnostica di MX Network Assistant per eseguire il 
Ping del router utilizzando l'indirizzo MAC, il Ping di un sito Web come 
Google o il traceroute. Se è possibile eseguire il Ping di un sito utilizzando il 
suo IP (ottenuto da una ricerca sul web) ma non è possibile raggiungerlo con 
il suo nome di dominio, allora il problema potrebbe essere nella 
configurazione del DNS. Se non sapete come interpretare i risultati di Ping e 
traceroute, fate una ricerca sul web o pubblicate i risultati sul forum MX 
Linux.

• A volte l'uso dell'applicazione terminale Ceni (nei repo) può rivelare punti di 
accesso nascosti e altri fattori difficili. NOTA: l'uso di Ceni per configurare 
l'interfaccia di rete in MX Linux interferirà e/o disabiliterà la gestione di tale 
interfaccia da parte del Network Manager predefinito. Ceni memorizza le 
informazioni di configurazione in /etc/network/interfaces. Qualsiasi interfaccia 
definita in /etc/network/interfaces sarà ignorata da Network Manager, poiché 
quest'ultimo presume che, se esiste una definizione, sia un'altra applicazione a 
gestire il dispositivo.

-Non è stata trovata alcuna interfaccia wireless.

• Aprire un terminale e digitare i 4 comandi elencati all'inizio della sezione 
precedente. Identificare la scheda, il chipset e il driver necessari effettuando una 
ricerca sul web e consultando i siti segnalati, secondo la procedura descritta 
sopra.

• Cercate la voce relativa alla rete e prendete nota delle informazioni 
dettagliate sul vostro hardware specifico, quindi cercate ulteriori informazioni 
sul sito LinuxWireless elencato di seguito o chiedete sul forum.

• Se si dispone di un dispositivo wifi esterno e non vengono trovate 
informazioni su una scheda di rete, scollegare il dispositivo, attendere 
qualche secondo e ricollegarlo. Aprire un terminale e inserire:

dmesg | tail

Esaminare l'output per trovare informazioni sul dispositivo (come l'indirizzo 
mac) che possono essere utilizzate per risolvere il problema sul web o sul forum 
di MX Linux.

• Un esempio comune di questa situazione è rappresentato dai chipset 
wireless Broadcom; si veda il Wiki MX/antiX.

Firmware

https://en.wikipedia.org/wiki/Traceroute
https://mxlinux.org/wiki/hardware-networking/broadcom-wireless


Per alcune schede è necessario installare il firmware (ad esempio, firmware-ti-connectivity 
per Texas Instruments WL1251). MX Linux viene fornito con una buona quantità di firmware 
già disponibile,



installati o presenti nei repository, ma è possibile che dobbiate rintracciare la vostra particolare 
esigenza o controllare il forum di supporto di MX linux.

Sicurezza

La sicurezza wireless è gestita da Network Manager. Ecco i passi fondamentali da seguire (i 
passi sono simili in KDE, con piccole differenze terminologiche e di posizione che sono ovvie):

• Fare clic con il tasto destro del mouse sull'icona Network Manager nell'area di 
notifica > Modifica connessioni (KDE: Configura connessioni di rete).

• Fare clic sulla scheda Wireless ed evidenziare il nome del punto di accesso a cui 
ci si vuole collegare (ad esempio, "linksys" o "starbucks 2345").

• Fare clic sul pulsante Modifica e quindi sulla scheda Sicurezza wireless.

• Utilizzare il menu a discesa per selezionare la sicurezza desiderata (ad esempio: WPA 
e WPA2 Personal).

• Inserire la password e fare clic su Salva.

Figura 3-35: Sicurezza wireless in Network Manager (sinistra: Xfce, destra: KDE/Plasma).

È ugualmente possibile utilizzare Ceni per gestire la sicurezza wireless, purché successivamente 
non si utilizzi Network Manager, con il quale interferisce.

Collegamenti

• Linux senza fili

https://wireless.wiki.kernel.org/


• Supporto LAN wireless Linux

• Wiki Debian: Wifi

• Arch Wiki: Senza fili

3.4.3 Banda larga mobile

Per l'accesso a Internet senza fili con un modem 3G/4G, consultare le pagine 3G di Debian 
Wiki collegate qui sotto per informazioni sulla compatibilità. Molti modem 3G/4G vengono 
riconosciuti su MX Linux da Network Manager.

3.4.4 Tethering
Il tethering si riferisce all'uso di un dispositivo come un telefono cellulare o un HotSpot WiFi 
mobile per fornire accesso a Internet mobile ad altri dispositivi, come un computer portatile. È 
necessario creare un "HotSpot" sul dispositivo con accesso all'altro dispositivo. È facile 
configurare un telefono Android come HotSpot
: Impostazioni > Connessioni > Hotspot mobile e Tethering > Hotspot mobile. Per rendere il 
portatile l'Hotspot, consultate questo video.

Risoluzione dei problemi

Su alcuni sistemi, le connessioni via modem falliscono a causa dell'aggiornamento dei pacchetti 
udev e libudev1. Per risolvere il problema, aprire Synaptic, evidenziare i pacchetti e fare clic 
su Pacchetto>Forza versione.... Utilizzate il menu a discesa per passare a una versione inferiore 
e fate clic sull'icona Applica.

In alcuni casi questa soluzione non ha funzionato in modo coerente, ma gli utenti hanno 
scoperto che la rimozione completa di Network Manager ha risolto i problemi.

ALTRO: Wiki Debian: Modem 3G

3.4.5 Utilità a riga di comando

Le utilità della riga di comando sono utili per visualizzare informazioni dettagliate e sono anche 
comunemente utilizzate per la risoluzione dei problemi. La documentazione dettagliata è 
disponibile nelle pagine man. Quelle più comuni che seguono devono essere eseguite come root.

Tabella 4: Servizi di pubblica utilità senza fili.

Comando Commento
ip Utilità di configurazione principale per le 

interfacce di rete.

http://linux-wless.passys.nl/
http://wiki.debian.org/WiFi
https://wiki.archlinux.org/index.php/Wireless
https://www.youtube.com/watch?v=WeKcWTQc7mY&feature=youtu.be
http://wiki.debian.org/Modem/3G


ifup <interfaccia> Visualizza l'interfaccia specificata. Ad esempio:
ifup eth0 farà apparire la porta ethernet eth0

ifdown 
<interfaccia>

L'opposto di ifup



iwconfig Utilità di connessione alla rete wireless. Utilizzata da sola, visualizza 
lo stato della rete wireless. Può essere applicata a un'interfaccia 

specifica, ad esempio per selezionare un particolare punto di accesso.
rfkill Disabilita il softblock per le interfacce di rete wireless (ad 

esempio, wlan).
depmod -a Esamina tutti i moduli e, se sono cambiati, abilita la nuova 

configurazione.

3.4.5 DNS statico

A volte è auspicabile cambiare la configurazione di Internet da quella automatica predefinita del 
DNS (Dynamic Name Service) a una statica manuale. I motivi per farlo possono essere una 
maggiore stabilità, una migliore velocità, il controllo parentale, ecc. Tale modifica può essere 
effettuata per l'intero sistema o per singoli dispositivi. In entrambi i casi, prima di iniziare, 
procurarsi le impostazioni DNS statiche che si intende utilizzare da OpenDNS, Google Public 
DNS, ecc.

DNS a livello di sistema

È possibile effettuare la modifica per tutti gli utenti del router utilizzando un browser. Sono necessari:

• l'URL del router (elencarlo qui se lo si è dimenticato).

• la sua password, se è stata impostata.

Individuare e modificare il pannello di configurazione del router, seguendo le indicazioni 
relative al router in questione (elenco delle guide qui).

DNS individuale

Per la modifica di un singolo utente, è possibile utilizzare Network Manager.

• Fare clic con il tasto destro del mouse sull'icona della connessione nell'area di notifica > Modifica 
connessioni...

• Evidenziare la connessione e fare clic sul pulsante Modifica.

• Nella scheda IPv4, utilizzare il menu a discesa per modificare il metodo in 
"Solo indirizzi automatici (DHCP)".

• Nella casella "Server DNS" inserire le impostazioni DNS statiche che si intende utilizzare.

• Fare clic su Salva per uscire.

3.5 Gestione dei file

https://en.wikipedia.org/wiki/Domain_Name_System
http://www.techspot.com/guides/287-default-router-ip-addresses/
https://support.opendns.com/forums/21618374


La gestione dei file in MX Linux viene effettuata tramite Thunar su Xfce e Dolphin su KDE / 
Plasma. Gran parte del loro uso di base è evidente, ma ecco alcune cose da sapere:



• I file nascosti non sono visibili per impostazione predefinita, ma possono essere resi 
visibili tramite il menu (Visualizza > Mostra file nascosti); oppure premendo Ctrl-H.

• Il riquadro laterale può essere nascosto e i collegamenti alle directory (cartelle) 
possono essere inseriti facendo clic con il pulsante destro del mouse > Invia a 
(KDE: Aggiungi a posizioni) o trascinandoli.

• Il menu contestuale è stato popolato con procedure comuni ("Azioni personalizzate" 
su Xfce e "Azioni" e "Azioni radice" su KDE / Plasma) che variano a seconda di ciò 
che è presente o sotto il fuoco.

• L'azione di root è disponibile tramite il menu contestuale per aprire un terminale, 
modificare come root o aprire un'istanza di File Manager con privilegi di root.

• I File Manager gestiscono facilmente i trasferimenti FTP, vedi sotto.

• Le azioni personalizzate aumentano notevolmente la potenza e l'utilità dei File 
Manager. MX Linux viene fornito con molte azioni preinstallate, ma ve ne sono 
altre che possono essere copiate e che l'utente può creare per le proprie esigenze. 
Vedere Suggerimenti e trucchi (Sezione 3.5.1), più avanti; e il Wiki MX/antiX.

Figura 3-36: A sinistra: Azioni personalizzate impostate in Thunar. A destra: Servizi personalizzati in 
Dolphin.

3.5.1 Suggerimenti e trucchi

• Quando si lavora in una directory che richiede i privilegi di superutente, è possibile fare 
clic con il pulsante destro del mouse > Apri root Thunar qui (o File > Apri root Thunar 

http://docs.xfce.org/xfce/thunar/custom-actions
https://mxlinux.org/wiki/applications/thunar-custom-actions


qui) o l'analoga "Azione root" in Dolphin.



• I privilegi di superutente possono essere modificati nella scheda MX Tweak > Altro 
utilizzando la password dell'utente (predefinita) o una password amministrativa, se è stata 
impostata.

• È possibile impostare le schede con File > Nuova scheda (o Ctrl-T), quindi spostare gli 
elementi da una posizione all'altra trascinandoli in una scheda e rilasciandola.

• È possibile dividere lo schermo e navigare in un'altra directory in uno dei pannelli. 
Quindi spostare o copiare i file da uno all'altro.

• In Xfce 4.18 e versioni successive, è possibile impostare una visualizzazione a schede 
multiple per impostazione predefinita; a tale scopo è più facile utilizzare la scheda 
MX Tweak > Config Options.

È possibile assegnare un tasto di scelta rapida da tastiera all'azione personalizzata "Apri il terminale qui".

▪ Thunar/Xfce

• Attivare gli acceleratori modificabili in Tutte le impostazioni > Aspetto > Impostazioni.

• In Thunar, passate il mouse sulla voce di menu File > Apri nel terminale 
e premete la combinazione di tasti che desiderate utilizzare per 
quell'azione.

• Quindi, quando si naviga in Thunar, utilizzare la combinazione di tasti 
per aprire una finestra di terminale nella directory attiva.

• Questo vale anche per altre voci del menu File di Thunar; per esempio, 
si può assegnare Alt-S per creare un collegamento simbolico a un file 
evidenziato, ecc.

• Le azioni elencate nel menu contestuale possono essere 
modificate/eliminate e ne possono essere aggiunte di nuove facendo 
clic su Modifica > Configura azioni personalizzate...

• Dolphin / KDE Plasma: selezionare Impostazioni > Configura scorciatoie da 
tastiera e trovare la voce Terminale.

• Sono visibili anche varie opzioni e comandi nascosti, vedi Collegamenti qui sotto.

• Sia Java che Python sono talvolta utilizzati per produrre applicazioni, con il termine
*.jar e *.py, rispettivamente. Questi file possono essere aperti con un solo clic, come 
qualsiasi altro file; non è più necessario aprire un terminale, capire qual è il comando, 
ecc. ATTENZIONE: fate attenzione ai potenziali problemi di sicurezza.

• I file compressi (zip, tar, gz, xz, ecc.) possono essere gestiti con un clic del tasto destro del mouse sul 
file.



• Per trovare i file:



--Thunar/Xfce: aprire Thunar e fare clic con il pulsante destro del mouse su 
qualsiasi cartella > Trova file qui. Verrà visualizzata una finestra di dialogo con 
le opzioni disponibili. In esecuzione in background c'è Catfish (menu Start > 
Accessori > Catfish).

--Dolphin / KDE Plasma: Utilizzare Modifica > Cerca nella barra degli strumenti di Dolphin.

• Link/Symlink

--Thunar/Xfce: Per impostare un soft link (alias link simbolico) - un file che punta 
a un altro file o a un'altra directory - fare clic con il tasto destro del mouse sulla 
destinazione (file o cartella a cui si desidera che il link punti).
> Crea collegamento simbolico. Quindi trascinare (o fare clic con il pulsante 
destro del mouse, tagliare e incollare) il nuovo collegamento simbolico nel punto 
desiderato.

--Dolphin / KDE Plasma: Fate clic con il tasto destro del mouse su un punto vuoto 
della finestra di Dolphin e utilizzate Crea nuovo > Collegamento di base a un file 
o a una directory.

• Azioni personalizzate Thunar. Si tratta di un potente strumento per espandere le funzioni 
del file manager. Per vedere quelle predefinite durante lo sviluppo di MX Linux, fare 
clic su Modifica > Configura azioni personalizzate. La finestra di dialogo che si aprirà 
mostrerà ciò che è predefinito e darà un'idea di ciò che si può fare da soli. Per creare una 
nuova Azione personalizzata, fare clic sul pulsante "+" a destra. I dettagli nel wiki di 
MX/antiX.

• Le cartelle possono essere visualizzate con immagini inserendo un'immagine che termina 
con *.jpg o *.png nella cartella e rinominandola "cartella".

Figura 3-37: utilizzo di immagini per etichettare le cartelle.

https://mxlinux.org/wiki/applications/thunar-custom-actions
https://mxlinux.org/wiki/applications/thunar-custom-actions


 3.5.2 FTP

Figura 3-38: Utilizzo di Thunar per accedere a un sito FTP.

Il protocollo di condivisione dei file (FTP) viene utilizzato per trasferire file da un host a un 
altro host attraverso una rete.

Xfce FTP

• Aprire Thunar File Manager e fare clic su Sfoglia rete nella parte inferiore del 
riquadro sinistro. Quindi fare clic sulla barra degli indirizzi nella parte superiore 
del browser (oppure utilizzare Cntrl+L) e fare un backspace per

• Il backspace nel campo dell'indirizzo cancella quello che c'è (network:///), quindi 
digitate il nome del server con il prefisso ftp://. Ad esempio, per raggiungere la 
documentazione MX (se si ha l'autorizzazione) si dovrebbe digitare questo indirizzo: 
ftp://mxlinux.org

• Viene visualizzata una finestra di dialogo di autorizzazione. Compilate il nome 
utente e la password e lasciate che la password venga salvata, se siete a vostro 
agio.

• Ecco fatto. Una volta che si è arrivati alla cartella che si intende utilizzare sempre, è 
possibile fare clic con il tasto destro del mouse sulla cartella e su Thunar > Invia a > 
Riquadro laterale per creare un modo molto semplice di collegarsi.

KDE FTP

• Consultare la base utenti di KDE.

È possibile utilizzare anche applicazioni FTP dedicate, come Filezilla. Per una discussione sul 
funzionamento dell'FTP, vedere questa pagina.

https://userbase.kde.org/File_transfers
http://www.ncftp.com/libncftp/doc/ftp_overview.html


3.5.3 Condivisione di file

Esistono diverse possibilità per condividere i file tra computer o tra un computer e un 
dispositivo.

• Samba. SAMBA è la soluzione più completa per condividere file con i computer 
Windows in rete senza apportare modifiche ai computer Windows. SAMBA può 
essere utilizzato anche da molti lettori multimediali di rete e dispositivi NAS 
(Network-attached storage). SAMBA offre altri servizi per interfacciarsi con le reti 
Windows, come l'autenticazione di dominio, i servizi di messaggistica e la risoluzione 
dei nomi NETBIOS. Per i dettagli, vedere di seguito.

• NFS. È il protocollo standard di Unix per la condivisione dei file. Molti ritengono 
che sia migliore di Samba per la condivisione dei file e può essere usato con 
macchine Windows (2000 e XP) se si installa "Services for Unix" o un client NFS 
di terze parti. Dettagli: vedere MX/antiX Wiki.

• Bluetooth: Per lo scambio di file, installare blueman dai repo, riavviare, 
accoppiare il dispositivo, quindi fare clic con il pulsante destro del mouse 
sull'icona Bluetooth nell'area di notifica > Invia file al dispositivo.

3.5.4 Azioni (Samba)

Figura 3-39: Navigazione nelle condivisioni di rete Sinistra: Thunar, destra: Dolphin.

I File Manager possono collegarsi a cartelle condivise (alias Samba Shares) su computer 
Windows, Mac, Linux e dispositivi NAS (Network Attached Storage). Per la stampa con 
Samba, vedere la Sezione 3.1.2.

• Fare clic su Sfoglia rete nel riquadro sinistro per visualizzare le varie reti.

• Fare clic sulla rete desiderata per visualizzare i server disponibili. Ora scendete verso 
il basso per trovare quello che state cercando.

https://mxlinux.org/wiki/networking/nfs


• Selezionare un server per le condivisioni Samba disponibili

• Selezionate una condivisione Samba per vedere tutte le cartelle disponibili.

• Nella sezione della barra laterale Rete viene creato un collegamento per la condivisione selezionata.

• La navigazione non funziona, soprattutto in Windows. È possibile accedere 
direttamente a una condivisione remota utilizzando la barra di localizzazione del File 
Manager (Ctrl+L) e usando smb://servername/sharename. Questi luoghi possono 
essere inseriti come segnalibri nei riquadri laterali.

3.5.5 Creazione di azioni

Su MX, Samba può anche essere usato per creare condivisioni a cui altri computer (Windows, 
Mac, Linux) possono accedere. La creazione di condivisioni pubbliche con MX Samba Config 
è abbastanza semplice, ma si tenga presente che la creazione di condivisioni Samba è un'area 
complessa dal punto di vista della configurazione.

3.6 Suono

 VIDEO: Come abilitare l'audio HDMI con Linux

L'audio di MX Linux dipende a livello di kernel da Advanced Linux Sound Architecture 
(ALSA) e a livello di utente da PulseAudio. Nella maggior parte dei casi l'audio funziona 
subito, anche se potrebbe essere necessario qualche piccolo aggiustamento. Fare clic 
sull'icona dell'altoparlante per disattivare l'audio, poi di nuovo per ripristinarlo, se le 
preferenze sono impostate in questo modo. Posizionare il cursore sull'icona dell'altoparlante 
nell'area di notifica e usare la rotella di scorrimento per regolare il volume. Vedere anche le 
sezioni 3.6.4, 3.6.5 e 3.8.9.

3.6.1 Configurazione della scheda audio

Se si dispone di più di una scheda audio, assicurarsi di selezionare quella che si desidera 
regolare utilizzando lo strumento MX Seleziona suono (Sezione 3.2). Per configurare la 
scheda audio e regolare il volume delle tracce selezionate, fare clic con il tasto destro del 
mouse sull'icona dell'altoparlante nell'area di notifica > Apri Mixer. Se i problemi persistono 
dopo essersi disconnessi e riaccesi, consultare la sezione Risoluzione dei problemi.

3.6.2 Uso simultaneo della carta

Può capitare di voler utilizzare più di una scheda contemporaneamente; ad esempio, si 
potrebbe voler ascoltare la musica sia in cuffia che attraverso gli altoparlanti in un altro luogo. 
Questo non è facile da fare in Linux, ma controllate le FAQ di PulseAudio. Inoltre, le 
soluzioni presenti in questa pagina Wiki MX/antiX possono funzionare, se si fa attenzione ad 
adattare i riferimenti delle schede alla propria situazione.

https://youtu.be/gjqcmZK5SnE
http://www.freedesktop.org/wiki/Software/PulseAudio/
http://www.freedesktop.org/wiki/Software/PulseAudio/FAQ/
https://mxlinux.org/wiki/sound-not-working


A volte è necessario cambiare scheda audio, ad esempio quando una è HDMI e l'altra 
analogica. Questo può essere fatto con la scheda Pulse Audio Volume Control > 
Configuration; assicuratevi di selezionare l'opzione Profile che funziona per il vostro 
sistema. Per rendere automatico il cambio, consultare lo script su questo sito GitHub.

https://gist.github.com/3v1n0/ad3ad73e0bdd466d7f4a95b3aa376285


3.6.3 Risoluzione dei problemi

• Il suono non funziona

• Nessun suono, anche se l'icona dell'altoparlante è presente nell'area 
di notifica.

• Provare ad alzare tutti i controlli a un livello superiore. Per un suono di 
sistema, ad esempio un login, utilizzare la scheda Riproduzione di 
PulseAudio.

• Modificare direttamente il file di configurazione: vedere la sezione 
7.4.

• L'audio è assente e l'icona dell'altoparlante non è presente nell'area di notifica. 
Potrebbe essere che la scheda audio sia assente o non riconosciuta, ma il problema 
più comune è quello delle schede audio multiple, che affrontiamo qui.

• Soluzione 1: fare clic sul menu Start > Impostazioni > Scheda audio MX 
(KDE: Impostazioni di sistema > Hardware > Audio) e seguire la 
schermata per selezionare e testare la scheda che si desidera utilizzare.

• Soluzione 2: utilizzare il controllo del volume di PulseAudio (pavucontrol) 
per selezionare la scheda audio corretta

• Soluzione 3: accedere al BIOS e disattivare l'HDMI.

• Controllare la matrice della scheda audio ALSA elencata di seguito.

3.6.4 Server audio

Mentre la scheda audio è un elemento hardware accessibile all'utente, il Sound Server è un 
software che lavora in gran parte in background. Permette la gestione generale delle schede 
audio e consente di eseguire operazioni avanzate sul suono. Il più usato dai singoli utenti è 
PulseAudio. Questo avanzato server audio open-source può funzionare con diversi sistemi 
operativi ed è installato di default. Ha un proprio mixer che permette all'utente di controllare il 
volume e la destinazione del segnale sonoro. Per l'uso professionale, Jack audio è forse il più 
noto.

https://mxlinux.org/wiki/sound-not-working
http://jackaudio.org/


Figura 3-40: Utilizzo di PulseAudio Mixer. Sinistra: Pavucontrol Destra: Volume audio di KDE.

3.6.5 Collegamenti

• Wiki MX/antiX: Il suono non funziona

• ALSA: Matrice di schede audio

• Wiki ArchLinux: Informazioni su PulseAudio

• Documentazione di PulseAudio: Desktop gratuito

3.7 Localizzazione

MX Linux è gestito da un team internazionale di sviluppatori che lavora costantemente per 
migliorare ed espandere le opzioni di localizzazione. Ci sono molte lingue in cui i nostri 
documenti non sono ancora stati tradotti; se potete aiutare in questo sforzo, registratevi su 
Transifex e/o scrivete sul Forum di traduzione.

3.7.1 Installazione

L'atto principale di localizzazione avviene durante l'uso di LiveMedium USB.

• Quando viene visualizzata la schermata di avvio, assicurarsi di utilizzare i tasti 
funzione per impostare le preferenze.

• F2. Selezionare la lingua.

• F3. Selezionare il fuso orario che si desidera utilizzare.

• Se si dispone di una configurazione complicata o alternativa, è possibile 
utilizzare i codici di avvio. Ecco un esempio per impostare una tastiera tartara 
per il russo: lang=ru kbvar=tt . Un elenco completo dei parametri di avvio 
(=codici truffa) è disponibile nella Wiki MX/antiX.

• Se i valori di localizzazione sono stati impostati nella schermata di avvio, Screen 7 
dovrebbe mostrarli durante l'installazione. In caso contrario, o se si desidera 
modificarli, selezionare la lingua e il fuso orario desiderati.

Dopo la schermata di avvio sono disponibili altri due metodi.

• La prima schermata del programma di installazione consente all'utente di selezionare una particolare 
tastiera da utilizzare.

https://mxlinux.org/wiki/sound-not-working
https://wiki.archlinux.org/index.php/PulseAudio
http://www.freedesktop.org/wiki/Software/PulseAudio/Documentation/User/
https://forum.mxlinux.org/viewtopic.php?f=96&t=38671
https://forum.mxlinux.org/viewtopic.php?f=96&t=38671
https://forum.mxlinux.org/viewforum.php?f=96
https://mxlinux.org/wiki/system/boot-parameters


• La schermata di accesso presenta dei menu a discesa nell'angolo in alto a destra 
in cui è possibile selezionare sia la tastiera che il locale.

3.7.2 Post-installazione
MX Tools include due strumenti per cambiare la tastiera e il locale. Si vedano le precedenti 
sezioni 3.2.15 e 3.2.16.

Anche Xfce4 e KDE/Plasma hanno i loro metodi:

Figura 3-41: Aggiunta di un altro layout di tastiera Sinistra: XfceDestra : KDE.

Ecco le operazioni di configurazione che si possono eseguire per localizzare MX Linux 

dopo l'installazione. Per cambiare la tastiera:

Xfce

• Fare clic su Menu Start > Impostazioni > Tastiera, scheda Layout.

• Deselezionare "Usa le impostazioni predefinite del sistema", quindi fare clic 
sul pulsante +Aggiungi in basso e selezionare le tastiere desiderate.

• Uscire, quindi fare clic su Keyboard Switcher (bandiera) nell'area di 
notifica per selezionare la tastiera attiva.

KDE/Plasma

• Fare clic su Menu Start > Impostazioni > Impostazioni di sistema > Hardware > 
Scheda Tastiera> Layout

• Selezionate "Configura layout" al centro della finestra di dialogo, quindi fate clic su +Aggiungi
e selezionare la tastiera o le tastiere desiderate.

• Uscire, quindi fare clic su Keyboard Switcher (bandiera) nell'area di 
notifica per selezionare la tastiera attiva.



• Ottenere i language pack per le principali applicazioni: fare clic sul menu Start > 
System > MX Package Installer, fornire la password di root, quindi fare clic su 
Language per trovare e installare i language pack per le applicazioni utilizzate.

• L'impostazione del cinese semplificato pinyin è un po' più complicata, vedere qui.

• Modificare le impostazioni dell'ora: (Xfce) fare clic su Menu Start > Sistema > MX 
Data e ora, (KDE: fare clic con il pulsante destro del mouse sull'ora nel pannello > 
Regola data e ora) e selezionare le preferenze. Se si utilizza l'orologio digitale Data e 
ora, fare clic con il pulsante destro del mouse > Proprietà per scegliere 12h/24h e altre 
impostazioni locali.

• Per far sì che il correttore ortografico utilizzi la propria lingua: installare il pacchetto 
aspell o myspell per la propria lingua (ad esempio, myspell-es).

• Ottenere informazioni meteo locali.

• Xfce: fare clic con il pulsante destro del mouse su Pannello > Pannello > 
Aggiungi nuovi elementi > Aggiornamento meteo. Fare clic con il pulsante 
destro del mouse > Proprietà e impostare il locale che si desidera visualizzare 
(in base all'indirizzo IP).

• KDE: Fare clic con il tasto destro del mouse sul desktop o sul pannello, a 
seconda di dove apparirà il widget, e quindi su Aggiungi widget. Cercare 
Meteo e aggiungere il widget

• Per la localizzazione di Firefox, Thunderbird o LibreOffice, utilizzare il programma di 
installazione dei pacchetti MX >
Lingua per installare il pacchetto appropriato per la lingua di interesse.

• Potreste aver bisogno o voler cambiare le informazioni sulla localizzazione (lingua 
predefinita, ecc.) disponibili per il sistema. Per farlo, aprite un terminale, diventate 
root e digitate: dpkg-reconfigure locales

• Verrà visualizzato un elenco con tutte le località che si possono scorrere 
utilizzando i tasti freccia su e giù.

• Attivate e disattivate ciò che volete (o non volete), usando la barra spaziatrice 
per far apparire (o scomparire) l'asterisco davanti al locale.

• Al termine, fare clic su OK per passare alla schermata successiva.

• Usare le frecce per selezionare la lingua predefinita che si desidera 
utilizzare. Per gli utenti statunitensi, ad esempio, la lingua predefinita è 
en_US.UTF-8.

• Fare clic su OK per salvare e uscire.

https://mxlinux.org/wiki/other/chinese-simplified-input


ALTRO: Documentazione di Ubuntu

https://help.ubuntu.com/community/Locale


Figura 3-42: Impostazione della lingua predefinita per il sistema installato.

3.7.3 Ulteriori note
• È possibile cambiare temporaneamente la lingua per una particolare applicazione 

immettendo questo codice in un terminale (in questo esempio, per passare allo 
spagnolo):

LC_ALL=es_ES.UTF8 <comando da lanciare>

Questo funziona per la maggior parte delle applicazioni già localizzate.

• Se durante l'installazione è stata selezionata una lingua sbagliata, è possibile cambiarla 
una volta sul desktop installato, utilizzando MX Locales per correggerla. È anche 
possibile aprire un terminale e inserire questo comando:

sudo update-locale LANG=en_GB.utf8

Ovviamente è necessario cambiare la lingua in quella che si desidera utilizzare.

• Può accadere che una singola applicazione non abbia una traduzione nella vostra lingua; 
a meno che non si tratti di un'applicazione MX, non possiamo fare nulla al riguardo, 
quindi dovreste inviare un messaggio allo sviluppatore.

• Alcuni file del desktop utilizzati per creare il menu Start potrebbero essere privi di un 
commento nella vostra lingua, anche se l'applicazione stessa ha una traduzione in quella 
lingua; vi preghiamo di comunicarcelo con un post nel sottoforum Traduzione che 
fornisca la traduzione corretta.

3.8 Personalizzazione

I moderni desktop Linux, come Xfce e KDE/Plasma, rendono molto semplice 
modificare le funzioni di base e l'aspetto della configurazione dell'utente.

• Ma soprattutto, ricordate: Il clic destro è vostro amico!

• Un grande controllo è disponibile attraverso le impostazioni di (Xfce) Tutte le 



impostazioni e (KDE/Plasma) Impostazioni, Impostazioni di sistema (icone del 
pannello).



• Le modifiche apportate dall'utente vengono memorizzate in file di 
configurazione nella directory: ~/.config/. Questi possono essere interrogati in 
un terminale, vedere il Wiki MX/antiX.

• La maggior parte dei file di configurazione a livello di 

sistema si trova in /etc/skel/ o /etc/xdg/ PIÙ: Suggerimenti e 

trucchi per Xfce (PDF)

3.8.1 Tematizzazione predefinita

La tematizzazione predefinita è controllata da una serie di elementi personalizzati.

Xfce

• La schermata di accesso può essere modificata con Tutte le impostazioni > Impostazioni di LightDM 
GTK+ Greeter.

• Desktop:

• Sfondo: Tutte le impostazioni > Desktop/ oppure fare clic con il pulsante 
destro del mouse sul desktop > Impostazioni desktop. Quando si seleziona 
da un'altra posizione, tenere presente che dopo aver utilizzato la voce 
"Altro" è necessario navigare fino alla cartella desiderata, quindi fare clic su 
"Apri"; solo a questo punto è possibile selezionare un file particolare in 
quella posizione.

• Tutte le impostazioni > Aspetto. Imposta i temi e le icone GTK. 
Impostazioni raggruppate in MX Tweak - Temi.

• Tutte le impostazioni > Gestione finestre. Imposta i temi dei bordi delle finestre.

KDE/Plasma

• Schermata di accesso (modificare con Impostazioni di sistema > Avvio e 
spegnimento, quindi scegliere Schermata di accesso, configurazione SDDM)

• Brezza

• Desktop:

• Sfondo: Fare clic con il tasto destro del mouse sul desktop e 
selezionare "Configura desktop e sfondo".

• Aspetto: Fare clic su Menu principale > Impostazioni > Impostazioni di sistema > Aspetto.

https://mxlinux.org/wiki/xfce/xfce-commands-and-other-useful-stuff#List%20configuration%20settings
http://pclosmag.com/download.php?f=XfceTipsTricksSE.pdf
http://pclosmag.com/download.php?f=XfceTipsTricksSE.pdf


1. Temi globali: combinazioni di set di temi in bundle

2. Stile plasma - Imposta il tema degli oggetti del desktop al plasma.



1. Stile dell'applicazione - Configurare gli elementi dell'applicazione

2. Decorazioni della finestra - Stili dei pulsanti di 
minimizzazione, massimizzazione e chiusura

3. È inoltre possibile configurare colori, caratteri, icone e cursori.

• Impostazioni del menu dell'applicazione

1. Fare clic con il tasto destro del mouse sull'icona del menu per ottenere 
le opzioni di configurazione. Il pannello predefinito è quello 
dell'applicazione standard

3.8.3 Pannelli

3.8.3.1 Pannello Xfce

Figura 3-43: Schermata delle preferenze per la personalizzazione dei pannelli.

MX Linux viene fornito di default con la barra delle applicazioni 
Docklike (plugin xfce4-docklike-) che sostituisce i pulsanti delle finestre 
Xfce utilizzati nelle precedenti versioni di MX. Questa barra delle 
applicazioni leggera, moderna e minimalista per Xfce offre le stesse 
funzionalità dei pulsanti delle finestre di Xfce, ma anche funzioni più 
avanzate di "dock".

Per visualizzare le proprietà della barra delle applicazioni simile a quella del dock: Ctrl + clic destro su 
qualsiasi icona. Oppure:
MX Tweak > scheda Pannello, fare clic sul pulsante "Opzioni" sotto Docklike. Figura 3-44: L'aspetto del 

https://mxlinux.org/wiki/docklike-taskbar/
https://mxlinux.org/wiki/docklike-taskbar/


dock
barra delle applicazioni 
con icone e menu 
contestuale.



I pulsanti della finestra possono essere ripristinati facendo clic con il pulsante destro del mouse su uno spazio 
vuoto > Pannello > Aggiungi nuovi elementi.

Trucchi per la personalizzazione dei pannelli:

• Per spostare il pannello, sbloccarlo facendo clic con il pulsante destro del mouse su un pannello > 
Pannello > Preferenze pannello.

• Utilizzare MX Tweak per modificare la posizione del pannello: verticale o 
orizzontale, superiore o inferiore.

• Per cambiare la modalità di visualizzazione all'interno dell'impostazione 
Pannello, selezionare dal menu a discesa: Orizzontale, Verticale o Deskbar.

• Per nascondere automaticamente il pannello, scegliere dal menu a discesa: Mai, 
Sempre o Intelligentemente (nasconde il pannello quando una finestra si 
sovrappone ad esso).

• Per installare nuovi elementi del pannello, fare clic con il pulsante destro del mouse 
su uno spazio vuoto nel pannello > Pannello > Aggiungi nuovi elementi. Sono 
disponibili 3 scelte:

• Selezionate una delle voci dell'elenco principale che appare.

• Se ciò che si desidera non è presente, selezionare Launcher. Una volta 
inserito, fare clic con il pulsante destro del mouse > Proprietà, fare clic sul 
segno più e selezionare un elemento dall'elenco visualizzato.

• Se si desidera aggiungere un elemento non presente in nessuno dei due 
elenchi, selezionare l'icona dell'elemento vuoto sotto il segno più e 
compilare la finestra di dialogo visualizzata.

• Le nuove icone vengono visualizzate nella parte inferiore del Pannello verticale; 
per spostarle, fare clic con il tasto destro del mouse > Sposta

• Per modificare l'aspetto, l'orientamento e così via, fare clic con il pulsante 
destro del mouse sul pannello > Pannello > Preferenze pannello.

• Fare clic con il tasto destro del mouse sul plugin dell'orologio "Data e ora" per 
modificare il formato del layout, della data o dell'ora. Per un formato orario 
personalizzato è necessario utilizzare i codici "strftime" (consultare questa pagina o 
aprire un terminale e digitare man strftime).

• Creare una doppia fila di icone nell'area di notifica facendo clic con il pulsante destro 
del mouse > Proprietà e diminuendo la dimensione massima delle icone fino a 
modificarla.

http://en.cppreference.com/w/c/chrono/strftime


• Aggiungete o eliminate un pannello in Preferenze pannello, facendo clic sul pulsante 
più o meno a destra del menu a discesa del pannello superiore.

• L'installazione del pannello orizzontale con un solo clic è disponibile da MX Tweak (Sezione 3.2).

ALTRO: Documenti di Xfce4: Pannello.

http://docs.xfce.org/xfce/xfce4-panel/start


3.8.3.2 Pannello KDE/Plasma

Figura 3-45: Schermata delle preferenze per la personalizzazione dei pannelli.

Trucchi per la personalizzazione dei pannelli:

• Per spostare il pannello, fare clic con il pulsante destro del mouse sul pannello e 
poi su Modifica pannello. Passare il mouse su "Bordo schermo" e spostarlo nella 
posizione desiderata.

• Utilizzate MX Tweak per modificare la posizione del pannello: verticale (sinistra), 
superiore o inferiore. Oppure utilizzate il metodo precedente per trascinare su 
qualsiasi bordo dello schermo.

• Per cambiare la modalità di visualizzazione all'interno del pannello, una volta aperta 
la finestra di dialogo Modifica pannello, scegliere Altre opzioni Allineamento 
pannello > sinistra, centro o destra.

• Per nascondere automaticamente il pannello, una volta aperta la finestra di dialogo 
Modifica pannello, fare clic su "Altre impostazioni" e selezionare "Nascondi 
automaticamente".

• Installare nuovi elementi del pannello facendo clic sul pannello >Aggiungi 
widget. Dalla finestra di dialogo è possibile selezionare il widget desiderato da 
aggiungere.

• Creare una doppia fila di icone nell'area di notifica utilizzando la finestra di dialogo 
Configura pannello e selezionando Altezza per modificare l'altezza del pannello. 
Quindi, utilizzando MX-Tweak
> scheda Plasma e impostare le dimensioni delle icone della barra delle applicazioni 
più grandi o più piccole, come desiderato, per creare l'effetto doppia fila. È anche 
possibile far sì che le icone della barra delle applicazioni scalino automaticamente con 
l'altezza del pannello facendo clic con il pulsante destro del mouse sulla freccia verso 
l'alto della barra, Configura barra delle applicazioni e abilitando la scala con l'altezza 
del pannello.

• Per mostrare tutte le applicazioni aperte, fare clic su Tweak MX, scheda 
Plasma e attivare "Mostra finestre da tutti gli spazi di lavoro nel pannello".

•

3.8.4 Desktop



 VIDEO: Personalizzazione del desktop

 VIDEO: Cose da fare dopo l'installazione di 
MX Linux

https://www.youtube.com/watch?v=QWVd1-8xpYI
https://youtu.be/aESEb8lTvz4
https://youtu.be/aESEb8lTvz4


Il desktop predefinito (alias sfondo, background) può essere modificato in vari modi:

• Fare clic con il tasto destro del mouse su qualsiasi immagine > Imposta come sfondo

• Se volete che gli sfondi siano disponibili per tutti gli utenti, diventate root e metteteli nella cartella
cartella /usr/share/backgrounds;

• Se si desidera ripristinare lo sfondo predefinito, questo si trova in 
/usr/share/backgrounds/. Ci sono anche dei link simbolici ai set di sfondi MX in 
/usr/share/wallpapers per facilitare l'uso di KDE.

Sono disponibili molte altre opzioni di personalizzazione.

• Per cambiare il tema:

• Xfce - Aspetto. Il tema predefinito è un MX mx-comfort (chiaro e scuro) che 
ha bordi più grandi e specifica l'aspetto del menu Whisker. Assicuratevi di 
selezionare un tema per le icone che si veda bene, soprattutto nella versione 
scura.

• KDE/Plasma - Tema globale - Il tema MX è quello predefinito. È inoltre 
possibile impostare singoli elementi del tema in Stile Plasma, Stile 
applicazione, Colori, Caratteri, Icone e cursori.

• Se necessario, per rendere i bordi sottili più facili da afferrare:

• Xfce - Utilizzate uno dei temi del gestore di finestre con "bordi spessi" o 
consultate la Wiki MX/antiX.

• KDE/Plasma - In Stile applicazione > Decorazioni finestra, impostate la 
"Dimensione del bordo" desiderata dal menu a discesa.

• Xfce - Aggiunta di icone standard come Cestino o Casa al desktop nella scheda 
Desktop, Icone.

• È possibile personalizzare il comportamento delle finestre, come la commutazione, l'affiancamento e lo 
zoom.

• Xfce - Tweaks del gestore di finestre.

• Il passaggio da una finestra all'altra tramite Alt+Tab può essere 
personalizzato per utilizzare un elenco compatto al posto delle icone 
tradizionali.

• Il passaggio da una finestra all'altra tramite Alt+Tab può anche essere 
impostato in modo da mostrare le anteprime al posto delle icone o di un 
elenco, ma richiede l'attivazione del compositore, che alcuni computer 
più vecchi potrebbero avere difficoltà a supportare. Per attivarlo, 

https://mxlinux.org/wiki/xfce/changing-border-size-with-xfce4-window-manager/
https://en.wikipedia.org/wiki/Compositing_window_manager


deselezionare prima Ciclo su un elenco nella scheda "Ciclo", quindi 
fare clic sulla scheda "Compositore" e selezionare 'Mostra l'anteprima 
delle finestre al posto delle icone' durante il ciclo.



• L'affiancamento delle finestre può essere effettuato trascinando una 
finestra in un angolo e rilasciandola...

• Se il compositing è attivato, lo zoom della finestra è disponibile 
utilizzando la combinazione Alt + Rotella del mouse.

• KDE/Plasma - Impostazioni di sistema

• È possibile affiancare le finestre trascinando una finestra in un angolo 
e rilasciandola in quel punto.

• La configurazione di una serie di controlli dei tasti e del mouse può 
essere impostata come desiderato tramite la finestra di dialogo 
Spazio di lavoro > Comportamento della finestra.

• La configurazione dell'Alt-tab, compreso il tema, può essere 
eseguita nella finestra di dialogo Task Switcher.

• Carta da parati

• Xfce - Utilizzare le impostazioni del desktop per scegliere gli sfondi. Per 
selezionare uno sfondo diverso per ogni area di lavoro, andare su Sfondo e 
deselezionare l'opzione "Applica a tutte le aree di lavoro". Quindi selezionare uno 
sfondo e ripetere la procedura per ogni area di lavoro trascinando la finestra di 
dialogo nell'area di lavoro successiva e selezionando un altro sfondo.

• KDE/plasma: fare clic con il pulsante destro del mouse sul desktop e 
selezionare "Configura desktop e sfondo".

Figura 3-46: La casella non selezionata consente di avere sfondi diversi per ogni area di lavoro 
A sinistra: Xfce, a destra: KDE.



Conky

Conky consente di visualizzare quasi tutti i tipi di informazioni sul desktop:

• Sia Conky Manager che MX Conky sono installati di default.

• Quando si fa clic su MX Conky, viene visualizzata una finestra di dialogo che indica se sono 
disponibili aggiornamenti.

• Fare clic sul menu Start > Accessori per trovare Conky Manager. MX Conky fa 
parte di MX Tools.

• Per impostazione predefinita, è incluso un set di Conky che funziona subito. È 
possibile importare altri set utilizzando l'icona dell'ingranaggio all'estremità destra 
della barra dei menu di Conky Manager.

• Evidenziate ogni conchiglia e premete Anteprima, se necessario, per vederne l'aspetto.

• Selezionare la casella per selezionare il Conky che si desidera utilizzare. Verrà installato 
automaticamente.

• I file di configurazione sono memorizzati nella cartella ~/.conky/ nei singoli file di 
tema; possono essere modificati evidenziando il Conky nell'elenco e facendo clic 
sull'icona di modifica (matita).

Figura 3-47: La schermata principale di Conky Manager mostra uno dei conkies disponibili.

AIUTO: Wiki tecnica MX/antiX

ALTRO: Pagina iniziale di Conky

https://mxlinux.org/wiki/help-files/help-mx-conky
http://conky.sourceforge.net/index.html


Terminale a scomparsa

 VIDEO: Personalizzazione del terminale a discesa

MX Linux viene fornito con un terminale a discesa molto pratico attivato con F4. Se si desidera 
disabilitarla: Xfce - Menu Start > Tutte le impostazioni > Tastiera, scheda Scorciatoie 
applicazioni.

KDE/plasma - Impostazioni di sistema > Avvio e spegnimento > Avvio e spegnimento 
eliminare Yakuake.

I terminali a discesa sono molto configurabili.

Xfce - fare clic con il pulsante destro del mouse sulla finestra del terminale e selezionare Preferenze.
KDE/plasma - cliccate con il tasto destro del mouse nella finestra del terminale e scegliete Crea nuovo 
profilo.

3.8.5 Touchpad

Xfce - Le opzioni generali per il touchpad di un computer portatile si trovano facendo clic su 
Impostazioni > Mouse e touchpad. I sistemi più sensibili alle interferenze del touchpad 
dispongono di un paio di opzioni:

• Utilizzare MX-Tweak, scheda Altro per modificare il driver del touchpad.

• Installare touchpad-indicator per vedere il controllo fine del comportamento... Fare 
clic con il tasto destro del mouse sull'icona nell'area di notifica per impostare opzioni 
importanti come l'avvio automatico.

KDE/Plasma - le opzioni del touchpad si trovano in Impostazioni di sistema > Hardware > 
Dispositivi di input. Esiste anche un widget per il touchpad che può essere aggiunto al pannello 
(tasto destro del mouse sul pannello > aggiungi widget).

Le modifiche dettagliate possono essere apportate manualmente modificando il file 20-synaptics.conf sotto la 
voce
/etc/X11/xorg.conf.d (il file è solo "synaptics.conf su MX-19).

3.8.6 Personalizzazione del menu di avvio

3.8.6.1 Menu Xfce ("Whisker")

https://www.youtube.com/watch?v=_X4tVjO8uzo


 VIDEO: Personalizzazione del menu Whisker

 VIDEO: Divertimento con il menu Whisker

https://www.youtube.com/watch?v=QWVd1-8xpYI
https://www.youtube.com/watch?v=bgPn68jMqd0


MX Linux Xfce utilizza per impostazione predefinita il menu Whisker, anche se un menu 
classico può essere facilmente installato facendo clic con il pulsante destro del mouse su un 
pannello > Pannello > Aggiungi nuovi elementi > Menu Applicazioni. Whisker Menu è molto 
flessibile.

• Fare clic con il tasto destro del mouse sull'icona del menu > Proprietà per impostare le preferenze, ad 
esempio,

• Spostare la colonna delle categorie accanto al pannello.

• Cambiare la posizione della casella di ricerca dall'alto verso il basso.

• Decidete quali pulsanti di azione volete mostrare.

• È facile aggiungere i preferiti: fare clic con il pulsante destro del mouse su qualsiasi voce di menu > 
Aggiungi ai preferiti.

• È sufficiente trascinare e rilasciare i Preferiti per disporli come si desidera. Fare 
clic con il tasto destro del mouse su qualsiasi voce per ordinarla o rimuoverla.

I contenuti dei menu possono essere modificati in Xfce utilizzando Menu > Accessori > 
Editor di menu (menulibre). In KDE si accede all'editor di menu facendo clic con il tasto 
destro del mouse sull'icona del menu e scegliendo Modifica applicazioni.

ALTRO: Caratteristiche del menu di Whisker

Modifica dei menu di Xfce

Le singole voci di menu possono essere modificate in vari modi (i file "desktop" delle voci di 
menu si trovano in /usr/share/applications/ e possono essere modificati anche direttamente 
come root).

• MenuLibre

• Facendo clic con il tasto destro del mouse su una voce del menu Whisker o del 
Finder delle applicazioni, è possibile modificarla in base alle esigenze dell'utente. Il 
menu contestuale contiene Modifica e Nascondi (quest'ultimo può essere molto 
utile). Selezionando Modifica si apre una schermata in cui è possibile modificare 
nome, commento, comando e icona.

http://gottcode.org/xfce4-whiskermenu-plugin/


Figura 3-48: Schermata di modifica delle voci di menu.

3.8.6.2 KDE/Plasma ("kicker")

MX Linux KDE/Plasma utilizza il menu Application Launcher per impostazione predefinita, 
anche se le alternative sono facilmente installabili facendo clic con il pulsante destro del mouse 
sull'icona del menu e scegliendo "Mostra alternative alternative". Le applicazioni "preferite" 
sono visualizzate come icone a sinistra del menu.

• Fare clic con il tasto destro del mouse sull'icona del menu > Configura menu applicazione per 
impostare le preferenze, ad esempio,

• Mostra le applicazioni come solo nome o come combinazione di nome e descrizione.

• Cambiare la posizione dei risultati della ricerca.

• Mostra gli elementi recenti o usati spesso.

• Appiattire i livelli secondari dei menu.

• È facile aggiungere i preferiti: fare clic con il pulsante destro del mouse su qualsiasi voce di menu > 
Mostra nei preferiti.

• È sufficiente trascinare e rilasciare i Preferiti per disporli come si desidera. Fare 
clic con il tasto destro del mouse su qualsiasi voce per ordinarla. Per rimuovere dai 
Preferiti, fare clic con il pulsante destro del mouse sull'icona, quindi su Mostra nei 
Preferiti e deselezionare il Desktop o l'Attività appropriata.

Modifica dei menu di KDE

Le voci di menu possono essere modificate facendo clic con il pulsante destro del mouse su 
una voce del menu ed è possibile modificare un launcher su base specifica per l'utente. I file 



"desktop" delle voci di menu si trovano in /usr/share/applications/ e possono essere 
modificati anche direttamente come root.



Figura 3-49: Schermata di modifica delle voci di menu
(Plasma).

3.8.7 Accesso Greeter

L'utente ha a disposizione una serie di strumenti per personalizzare il Login Greeter. Le ISO di 
Xfce utilizzano Lightdm Greeter, mentre quelle di KDE/Plasma utilizzano SDDM.

Lightdm

Figura 3-50: l'applicazione di configurazione di Lightdm.



• Fare clic sul menu Start > Impostazioni > Tutte le impostazioni > Impostazioni 
LightDM GTK+ Greeter per regolare la posizione, lo sfondo, il carattere, ecc.

• L'Autologin può essere (in)attivato da MX User Manager, scheda Opzioni.

• Alcune proprietà della casella di accesso predefinita sono impostate nel codice 
del tema selezionato. Cambiare tema per avere una maggiore scelta.

• Si può fare in modo che il login greeter mostri un'immagine come segue:

• Menu Start > Impostazioni > Informazioni su di me (foto segnaletica)

• Compilare i dettagli che si desidera aggiungere.

• Fare clic sull'icona, navigare fino all'immagine che si desidera utilizzare.

• Chiudere

• Manuale

• Creare o selezionare un'immagine e utilizzare nomacs o un altro editor di 
foto per ridimensionarla a circa 96x96 pixel.

• Salvate l'immagine nella vostra cartella home come .face (assicuratevi di 
includere il punto e di non aggiungere alcuna estensione come jpg o png).

• Fare clic su Tutte le impostazioni > Impostazioni del Greeter GTK+ di 
LightDM, scheda Aspetto: attivare l'interruttore dell'immagine utente.

• Qualunque sia il modo scelto, fate il logout e vedrete l'immagine accanto alla 
casella di accesso; apparirà anche nel menu Whisker una volta effettuato il 
login.

SDDM

Figura 3-51: l'applicazione di configurazione SDDM.



• Le impostazioni SDDM si trovano tutte nelle Impostazioni di sistema di Plasma 
desktop. Un collegamento per le Impostazioni di sistema si trova nel pannello 
predefinito di MX, oppure è possibile cercarlo nel menu Applicazioni. Nelle 
Impostazioni, andare su Avvio e Spegnimento
>> Schermata di accesso (SDDM).

• La pagina delle impostazioni per SDDM consente di:

■ selezionare tra diversi temi se ne avete installato più di uno;

■ scegliere di personalizzare uno sfondo per il tema selezionato;

■ rimuovere (cioè eliminare) un tema installato; e

■ per ottenere/installare nuovi temi direttamente dal KDE Store online o da un file 
sul proprio disco/supporto di memoria (vedi sotto)

• è richiesta la password di root - poiché il desktop manager è un programma di 
sistema, qualsiasi modifica apportata ad esso o alla sua configurazione influirà sui 
file della partizione root; per questo motivo verrà richiesta la password di root.

• selezione dello sfondo - è possibile cambiare lo sfondo del tema SDDM 
selezionato. Alcuni temi sono dotati di un'immagine di sfondo predefinita che 
verrà visualizzata se non si apporta alcuna modifica. Anche questa operazione 
richiede la password di root.

• I nuovi temi di SDDM si trovano nel KDE Store. È anche possibile sfogliare i temi 
direttamente dalla pagina delle impostazioni di sistema di SDDM.

• In Impostazioni di sistema > Avvio e spegnimento > Schermata di accesso (SDDM), 
nella parte inferiore della finestra selezionare Nuove schermate di accesso.

• Per installare un tema:

■ da un file zip scaricato, fare clic sul pulsante "Installa da file" nella pagina delle 
impostazioni di sistema per SDDM, quindi selezionare il file zip desiderato dal 
selezionatore di file che si apre.

■ Nel browser dei temi SDDM incorporato nelle Impostazioni di sistema, è 
sufficiente fare clic sul pulsante "Installa" del tema selezionato.

NOTA: alcuni temi presenti nel KDE Store potrebbero essere incompatibili. MX 23 utilizza 
Plasma versione 5.27.5, che è la versione stabile disponibile per Debian, Bookworm. È quindi 
possibile che alcuni dei temi SDDM più recenti, costruiti per utilizzare le ultime caratteristiche 
di Plasma, non funzionino con l'SSDM di Plasma 5.27. Fortunatamente SDDM è dotato di una 
schermata di accesso di ripiego in modo che se un tema applicato non funziona, è possibile 
accedere nuovamente al desktop e da lì passare a un altro tema SDDM. Fate delle prove; alcuni 
temi molto nuovi funzionano mentre altri no.

3.8.8 Bootloader

Il bootloader (GRUB) di un MX Linux installato può essere modificato con le opzioni più 
comuni facendo clic sul menu Start > MX Tools > MX Boot Options (vedere Sezione 3.2). Per 
altre funzioni, installare Grub Customizer. Questo strumento deve essere usato con cautela, ma 

https://store.kde.org/browse/cat/101/order/latest


consente agli utenti di configurare



Impostazioni di Grub come la configurazione dell'elenco delle voci di avvio, i nomi delle 
partizioni, il colore delle voci di menu, ecc. Dettagli qui.

3.8.9 Suoni del sistema e degli eventi

Xfce

I segnali acustici del computer sono silenziati per impostazione predefinita nelle righe 
"blacklist" del file /etc/modprobe.d/pc- speaker.conf. Commentare (# all'inizio) queste righe 
come root se si desidera ripristinarle.

I suoni degli eventi possono essere attivati a livello di sistema facendo clic su Menu Start > 
Impostazioni > Aspetto, scheda Altro: selezionare Abilita suoni eventi e, se lo si desidera, 
Abilita suoni di feedback input. Possono essere gestiti con MX System Sounds (Sezione 3.2). Se 
non si iniziano a sentire piccoli suoni quando si chiude una finestra o si effettua il logout, ad 
esempio, provare a eseguire le seguenti operazioni:

• Uscire e rientrare.

• Fare clic sul menu Start > Multimedia > PulseAudio Volume Control, scheda 
Riproduzione, e regolare il livello come necessario (iniziare con 100%).

• Fare clic sul menu di avvio, digitare "!alsamixer" (senza dimenticare il punto 
esclamativo). Apparirà una finestra di terminale con un singolo controllo audio 
(Pulseaudio Master).

• Usare F6 per selezionare la scheda audio, quindi regolare i canali che 
appaiono a volumi più alti.

• Cercate canali come "Surround", "PCM", "Altoparlanti", 
"Master_Surround", "Master_Mono" o "Master". I canali disponibili 
dipendono dall'hardware in uso.

Per impostazione predefinita vengono forniti tre file audio: Borealis, Freedesktop e Fresh and 
Clean. Tutti si trovano in /usr/share/sounds. È possibile trovarne altri nei repo o con una ricerca 
sul web.

KDE

Per impostare i suoni del sistema, fate clic su Impostazioni di sistema > Notifiche > 
Impostazioni dell'applicazione > Spazio di lavoro Plasma > Configura eventi.

3.8.10 Applicazioni predefinite

Generale

https://answers.launchpad.net/grub-customizer/%2Bfaq/1355


Le applicazioni predefinite da utilizzare per le operazioni generali si impostano facendo clic sul menu 
Applicazioni
> Impostazioni > Applicazioni predefinite (Xfce) o Impostazioni di sistema > Applicazioni > Predefinite



Applicazioni (KDE/Plasma). È possibile impostare quattro preferenze (Xfce: schede separate 
per Internet e Utilità).

• Browser web

• Lettore di posta

• Gestore di file

• Emulatore di terminale

• Mappa (KDE)

• Dialer (KDE)

Applicazioni particolari

Molte impostazioni predefinite per tipi di file specifici sono impostate durante l'installazione di 
un'applicazione. Spesso, però, esistono più opzioni per un determinato tipo di file e l'utente 
desidera determinare quale applicazione debba lanciare il file, ad esempio il lettore musicale per 
aprire un file *.mp3.

L'applicazione Applicazioni predefinite di Xfce ha una terza scheda, "Altri", in cui è possibile 
impostare questi tipi di MIME utilizzando una comoda tabella di ricerca per trovare il tipo, 
quindi facendo doppio clic sullo spazio Applicazioni predefinite per impostare l'applicazione 
desiderata.

Metodo generale

• Fare clic con il tasto destro del mouse su qualsiasi esempio del tipo di file che interessa

• Effettuare una delle seguenti selezioni:

• Apri con <applicazione elencata>. Questo aprirà il file con l'applicazione 
selezionata per questa particolare istanza, ma non influirà sull'applicazione 
predefinita.

• Apri con un'altra applicazione. Scorrere l'elenco per evidenziare quello 
desiderato (compreso "Usa un comando personalizzato"), quindi selezionare Apri. 
La casella in basso "Usa come predefinito per questo tipo di file" è deselezionata 
per impostazione predefinita, quindi selezionatela se volete che la vostra selezione 
diventi la nuova applicazione predefinita che viene avviata quando fate clic su 
qualsiasi file di quel particolare tipo. Mantenetela deselezionata per un utilizzo 
una tantum.



 

Figura 3-52: Modifica dell'applicazione predefinita Sinistra: Thunar Destra: Dolphin: Dolphin.

3.8.11 Conti limitati

Per alcuni scopi, può essere auspicabile bloccare un'applicazione o un sistema per proteggerlo 
dagli utenti. Ad esempio, i computer di una scuola o di un luogo pubblico per uso generale, dove 
è necessario chiudere il file system, il desktop e l'accesso a Internet. Sono disponibili diverse 
opzioni.

• Alcuni componenti di Xfce che supportano la modalità kiosk. I dettagli nel Wiki di Xfce.

• KDE ha una modalità amministrativa, consultate il sito KDE Userbase.

• Verificate se il browser che utilizzate dispone di una modalità kiosk.

• La distro dedicata ai chioschi Porteus.

3.9 Accessibilità

3.9.1 Lente di ingrandimento dello schermo
Magnus (Xfce) e KMag (KDE) sono strumenti semplici e pratici per ingrandire porzioni di schermo.

3.9.2 Lettore di schermo
Lettore di schermo Orca In questo momento, a causa dell'impacchettamento di Debian, orca non 
appare nei menu ma può essere lanciato manualmente. In particolare, orca è configurabile nelle 
impostazioni di accessibilità integrate di KDE e può essere avviato con Meta+Alt+S. Per l'uso, 
vedere questo tutorial.

https://wiki.xfce.org/howto/kiosk_mode
https://userbase.kde.org/KDE_System_Administration
http://porteus-kiosk.org/index.html
https://techblog.wikimedia.org/2020/07/02/an-orca-screen-reader-tutorial/


ALTRO:

Accessibilità Xfce 

Accessibilità KDE

https://docs.xfce.org/xfce/xfce4-settings/accessibility
https://userbase.kde.org/Applications/Accessibility


4.1 Internet

4.1.1 Browser web

• MX Linux ha installato il popolare browser Firefox, che dispone di un'ampia serie di 
componenti aggiuntivi per migliorare l'esperienza dell'utente.

Pagina iniziale di Firefox

Componenti aggiuntivi di Firefox

• Gli aggiornamenti di Firefox vengono forniti attraverso i repo di MX Linux e sono 
solitamente disponibili per gli utenti entro 24 ore dal rilascio. Per il download 
diretto, vedere la Sezione 5.5.5.

• I file di localizzazione per Firefox possono essere installati facilmente con MX Package Installer.

• Firefox dispone di un servizio di sincronizzazione che facilita il trasferimento di 
segnalibri, cookie, ecc. da un'installazione esistente di Firefox.

• Altri browser sono disponibili per il download e l'installazione tramite MX Package 
Installer. Consultate il Wiki MX/antiX per suggerimenti e trucchi di configurazione.

4.1.2 Email

• Thunderbird è installato di default in MX Linux. Questo popolare client di posta 
elettronica si integra bene con Google Calendar e Google Contacts. Le versioni più 
recenti disponibili possono essere trovate con il programma di installazione dei 
pacchetti MX > MX Test Repo.

• I file di localizzazione per Thunderbird possono essere installati facilmente con MX Package Installer.

• Per informazioni sui collegamenti che non aprono più il browser, consultare il Wiki MX/antiX.

• Altri client di posta elettronica leggeri sono disponibili nel programma di installazione dei pacchetti 
MX.

4.1.3 Chat

• HexChat. Questo programma di chat IRC è installato di default in MX Linux e 
facilita lo scambio di messaggi di testo per l'utente.

Pagina iniziale di HexChat

4Uso di base

https://www.mozilla.org/
https://addons.mozilla.org/en-US/firefox/
https://mxlinux.org/wiki/applications/
https://www.thunderbird.net/
https://mxlinux.org/wiki/applications/thunderbird/
https://hexchat.github.io/


• Pidgin. Questo client di messaggistica istantanea grafico e modulare è in grado di 
utilizzare più reti contemporaneamente. Installatore di pacchetti MX.



Pagina iniziale di Pidgin

Video chat

• Zoom. Questo popolarissimo programma di video chat è multipiattaforma e può 
essere installato senza problemi su MX Linux utilizzando il programma di 
installazione dei pacchetti MX > Messaggistica. Si integra automaticamente con 
PulseAudio, che è installato di default.

• Gmail ha una funzione di conversazione integrata, ora chiamata Google Meet. Vedere la sezione 
4.10.6

• Skype. Un popolare programma proprietario per la messaggistica istantanea e la 
chat vocale e video.

Pagina iniziale di Skype

Risoluzione dei problemi

• Se la voce non viene captata nemmeno dopo aver utilizzato gli strumenti 
dell'applicazione, provate a fare così:

• Accedere all'applicazione di video chat, fare clic su Opzioni e 
andare alla scheda Dispositivi audio.

• Fare clic sul pulsante per avviare una chiamata di prova. Mentre la 
chiamata è in corso, aprire PulseAudio Volume Control e andare alla 
scheda Registrazione.

• Mentre è in corso la chiamata di prova, cambiare il microfono di 
Skype con quello della webcam.

4.2 Multimedia

Qui di seguito sono elencate alcune delle numerose applicazioni multimediali disponibili in 
MX Linux. Esistono anche applicazioni professionali avanzate, che possono essere trovate 
attraverso ricerche mirate in Synaptic.

4.2.1 Musica

http://pidgin.im/
https://zoom.us/
https://meet.google.com/
https://www.skype.com/en/


Figura 4-1: Riproduzione di un brano CD con Strawberry.



• Giocatori

• Strawberry. Un moderno lettore musicale e organizzatore di librerie in 
grado di riprodurre qualsiasi sorgente, da un CD a un servizio cloud. 
Installato per impostazione predefinita.

Pagina iniziale della fragola

• Audacious. Un lettore e gestore musicale completo. MX Package Installer.

Home page di Audacious

• DeaDBeeF. Un lettore leggero con un ingombro di memoria ridotto, un 
robusto insieme di funzioni di base e un'attenzione particolare alla 
riproduzione musicale. Installatore di pacchetti MX.

DeaDBeeF home page

• Ripper ed editor

• Asunder. Un ripper e codificatore di CD audio grafico che può essere usato 
per salvare tracce da CD audio. Installato per impostazione predefinita.

Home page di Asunder

• EasyTAG. Una semplice applicazione per visualizzare e modificare i tag nei file audio.

Pagina iniziale di EasyTAG

4.2.2 Video

 VIDEO: AGGIORNAMENTO: Netflix su Linux a 32 bit

• Giocatori

• VLC. Riproduce un'ampia gamma di formati video e audio, DVD, VCD, 
podcast e flussi multimediali da varie fonti di rete. Installato per impostazione 
predefinita.

Pagina iniziale di VLC

• Browser YouTube per SM Player (non installato di default).

Home page di SMplayer

• Netflix. La funzionalità desktop di streaming di Netflix è disponibile per 

https://github.com/strawberrymusicplayer/strawberry
http://audacious-media-player.org/
http://deadbeef.sourceforge.net/
http://littlesvr.ca/asunder/
https://wiki.gnome.org/Apps/EasyTAG
https://www.youtube.com/watch?v=fY_PqMJ5kG4
http://www.videolan.org/vlc/
http://smplayer.sourceforge.net/


Firefox e Google Chrome.



Pagina iniziale di Netflix

Figura 4-2: Esecuzione di Netflix sul desktop in Firefox.

• Ripper ed editor

• HandBrake. Un ripper video facile da usare, veloce e semplice. Installare 
con MX Package Installer.

Pagina iniziale di HandBrake

• DeVeDe. Questa utility converte automaticamente il materiale in formati 
compatibili con gli standard dei CD audio e dei DVD video.

Pagina iniziale di DeVeDe

• DVDStyler. Un'altra buona utility di authoring. MX Package Installer.

Pagina iniziale di DVDStyler

• OpenShot. Un editor video semplice da usare e ricco di funzioni. 
Installatore di pacchetti MX.

Pagina iniziale di OpenShot

https://www.netflix.com/us/
https://handbrake.fr/
http://www.rastersoft.com/programas/devede.html
http://www.dvdstyler.org/en/
http://www.openshot.org/


4.2.3 Foto

Figura 4-3: Utilizzo dello strumento di ritaglio in Nomacs.

• Nomacs. Un visualizzatore di immagini veloce e potente, installato di default.

Pagina iniziale di Nomacs

• Mirage. Questa veloce applicazione è facile da usare e consente di visualizzare e 
modificare le foto digitali. Installare tramite MX Package Installer.

Pagina del progetto Mirage

• Fotoxx. Questa veloce applicazione consente di modificare facilmente le foto e di 
gestire le collezioni, soddisfacendo le esigenze dei fotografi più seri. Installatore di 
pacchetti MX > MX Test Repo.

Pagina iniziale di Fotoxx

• GIMP. Il principale pacchetto di manipolazione delle immagini per Linux. L'aiuto 
(gimp-help) deve essere installato separatamente ed è disponibile in molte lingue. Il 
pacchetto di base è installato di default, quello completo è disponibile nel programma 
di installazione dei pacchetti MX.

Pagina iniziale di GIMP

• gThumb. un visualizzatore e browser di immagini degli sviluppatori di GNOME che 
include anche uno strumento di importazione per trasferire le foto dalle macchine 
fotografiche.

https://nomacs.org/
http://sourceforge.net/projects/mirageiv.berlios/
http://www.kornelix.net/fotoxx/fotoxx.html
http://www.gimp.org/


Wiki gThumb

http://gthumb.sourceforge.net/features.html


• LazPaint, un editor di immagini leggero multipiattaforma con livelli raster e 
vettoriali. Predefinito in MX-21.

Documentazione di LazPaint

• Gwenview, il visualizzatore di immagini per progetti KDE

Figura 4-4: Gwenview.

4.2.4 Screencasting

Figura 4-5: Schermata principale di SimpleScreenRecorder.

• SimpleScreenRecorder. Un programma semplice ma potente per registrare 
programmi e giochi. Installare tramite MX Package Installer.

SimpleScreenRecorder pagina iniziale

• RecordMyDesktop. Cattura i dati audio-video di una sessione desktop di Linux. 
Installare tramite il programma di installazione dei pacchetti MX.

https://wiki.freepascal.org/LazPaint
http://www.maartenbaert.be/simplescreenrecorder/


Pagina iniziale di RecordMyDesktop.

4.2.5 Illustrazioni

• mtPaint. Un'applicazione di facile apprendimento per creare pixel art e manipolare 
foto digitali. Installare tramite MX Package Installer.

Pagina iniziale di mtPaint

• LibreOffice Draw. Con questa applicazione è possibile creare e modificare 
diagrammi, disegni e immagini.

LO Draw home page

• Inkscape. Questo editor di illustrazioni ha tutto ciò che serve per creare computer art 
di qualità professionale. Installatore di pacchetti MX.

Pagina iniziale di Inkscape

4.3 Ufficio

4.3.1 Suite per ufficio

4.3.1.1 Sul desktop

LibreOffice

MX Linux è dotato di un'ottima suite per ufficio gratuita chiamata LibreOffice, che è 

l'equivalente di Linux e quasi un sostituto di Microsoft Office®. La suite è disponibile nel menu 

Applicazioni > Ufficio > LibreOffice. LibreOffice supporta i formati di file .docx, .xlsx e 

.pptx di Microsoft Office. Per impostazione predefinita, viene installata l'ultima versione 

stabile disponibile nei repo predefiniti.

http://recordmydesktop.sourceforge.net/about.php
http://mtpaint.sourceforge.net/
http://www.libreoffice.org/discover/draw/
https://inkscape.org/en/


Figura 4-6: Cruscotto principale in LibreOffice 7.4.5.1.

• Elaboratore di testi: LibreOffice Writer. Un elaboratore di testi avanzato 
compatibile con i file .doc e .docx.

• Foglio elettronico: LibreOffice Calc. Un foglio di calcolo avanzato 
compatibile con i file .xls e .xlsx.

• Presentazione: LibreOffice Impress. Presentazioni, compatibili con i 
file .ppt e .pptx.

• Disegnare: LibreOffice Draw. Utilizzato per creare grafici e diagrammi.

• Matematica: LibreOffice Math. Utilizzato per le equazioni matematiche.

• Base: LibreOffice Base. Utilizzato per creare e manipolare database. Se si 
utilizza questa applicazione per creare o utilizzare database nel formato nativo 
di LibreOffice, è necessario installare anche libreoffice-sdbc-hsqldb e 
libreoffice-base-driver corrispondenti alla versione.

• Gli utenti possono ottenere versioni più recenti con diversi metodi:

• Scaricate direttamente da LibreOffice. Per i dettagli, consultare il Wiki MX/antiX.

• Scaricare da MX Package Installer, scheda Debian Backports.

https://mxlinux.org/wiki/applications/libreoffice/


• Scaricare Flatpak (MX Package Installer) o Appimage.

LINK

• Pagina iniziale di LibreOffice.

• Wiki MX/antiX.

Sono disponibili anche altre suite desktop.

• Softmaker Free Office -- MX Package Installer: Applicazioni più diffuse

• Calligra Suite (parte del progetto KDE) -- Installatore di pacchetti MX: Repo di prova

4.3.1.2 Nel cloud

Google Docs e Office Suite

Docs di Google offre eccellenti applicazioni online che includono tre componenti standard per 
l'ufficio: Docs, Sheets e Slides. È facile condividere i file e le opzioni di esportazione sono 
molto utili.

Microsoft 365

I prodotti Microsoft non sono FOSS, eppure molti utenti hanno bisogno o vogliono avere 
accesso a questi prodotti, soprattutto in contesti aziendali, istituzionali e di altro tipo. 
Sebbene le applicazioni della suite Microsoft Office non possano essere installate in modo 
nativo su Linux, Office365 (servizio a pagamento) o On-line Office (gratuito) di Microsoft 
sono solo normali pagine web che funzionano bene in qualsiasi browser moderno su MX 
Linux. I dettagli nel Wiki MX/antiX.

Altre opzioni

• OnlyOffice (servizio a pagamento per le aziende)

4.3.2 Finanze dell'ufficio

• GnuCash. Software finanziario per l'ufficio. È facile da imparare e consente di tenere 
traccia di conti bancari, azioni, entrate e uscite. Può importare dati in formato QIF, 
QFX e altri formati e supporta la contabilità a doppia entrata. Installatore del 
pacchetto MX. Il pacchetto Guida (gnucash-docs) deve essere installato 
separatamente.

• Pagina iniziale di GnuCash

https://www.libreoffice.org/download/appimage/
https://www.libreoffice.org/
https://mxlinux.org/wiki/applications/libreoffice
https://www.freeoffice.com/
https://www.calligra.org/
https://www.google.com/docs/about/
https://www.office.com/
https://products.office.com/en-us/office-online/documents-spreadsheets-presentations-office-online
https://mxlinux.org/wiki/applications/microsoft-office/
https://www.onlyoffice.com/
http://gnucash.org/


Figura 4-7: Nuovo conto in GnuCash.

4.3.3 PDF

• QPDFview. Un visualizzatore veloce e leggero che include una serie di strumenti di 
base. Installato per impostazione predefinita.

QpdfView home page

• Okular, il lettore di PDF e documenti del progetto 

KDE Documentazione di Okular

• Document Scanner (ex SimpleScan) è un software di scansione minimale che funziona 
molto bene per le attività quotidiane. È installato di default su MX-23.

Home page dello scanner per documenti

• PDFShuffler semplifica il riordino, l'eliminazione e l'aggiunta di pagine PDF. 
Installato per impostazione predefinita.

PDFShuffler pagina iniziale

• gscan2pdf è un'applicazione tecnica per esigenze di scansione generali. MX 
Package Installer (MX/antix Wiki).

gscan2pdf home page

• Per altre funzioni (ad esempio, la creazione di un modulo PDF), vedere MX/antiX Wiki.

https://launchpad.net/qpdfview
https://okular.kde.org/
https://gitlab.gnome.org/GNOME/simple-scan
http://pdfshuffler.sourceforge.net/
https://mxlinux.org/wiki/applications/gscan2pdf
http://gscan2pdf.sourceforge.net/
https://mxlinux.org/wiki/applications/pdf


4.3.4 Pubblicazione desktop

• Scribus. Impaginazione professionale che produce risultati pronti per la stampa. 
Disponibile tramite MX Package Installer.

Pagina iniziale di Scribus

4.3.5 Tracciamento dei tempi del progetto

• Orologio a timbro Kapow. Un'applicazione semplice ma ricca di funzioni per registrare i tempi dei 
progetti.

Pagina iniziale di Kapow

Figura 4.8 Kapow impostato per tracciare il lavoro su un progetto.

• Altre opzioni

4.3.6 Video meeting e desktop remoto

• AnyDesk. Consente un facile accesso remoto. MX Package Installer, oltre ad altre opzioni.

• TeamViewer. Applicazione multipiattaforma per il supporto remoto e i meeting online. 
Gratuita per uso privato. Installatore di pacchetti MX.

Pagina iniziale di TeamViewer

• Zoom. Un programma di video chat molto popolare che può essere installato senza 
problemi su MX Linux utilizzando il programma di installazione dei pacchetti MX 
> Messaggistica. I

4.4 Casa

https://www.scribus.net/
https://gottcode.org/kapow/
https://www.linuxlinks.com/timetracking/
https://anydesk.com/en
https://www.teamviewer.us/
https://zoom.us/


4.4.1 Finanze

• HomeBank. Gestione semplice della contabilità, del bilancio e delle finanze personali.

HomeBank pagina iniziale

• Grisbi è molto utile per la casa. Può importare file QIF/QFX e ha un'interfaccia 
intuitiva. È adatto alle banche al di fuori degli Stati Uniti.

Home page di Grisbi

4.4.2 Centro multimediale

• Plex Mediaserver. Consente di riunire tutti i media e di visualizzarli in un unico 
luogo. Installatore di pacchetti MX.

Pagina iniziale di Plex

• Kodi Entertainment Center (ex XBMC) consente agli utenti di riprodurre e 
visualizzare video, musica, podcast e file multimediali da supporti di archiviazione 
locali e di rete. Installare tramite MX Package Installer.

Pagina iniziale di Kodi

4.4.3 Organizzazione

• Note. Questo pratico plugin per Xfce (xfce4-notes-plugin) consente di creare e 
organizzare note adesive per il desktop.

Pagina iniziale delle note

• Applicazione Pim di KDE, una suite di applicazioni per la gestione delle 

informazioni personali. https://community.kde.org/KDE_PIM

• Osmo. Bella applicazione Xfce compatta che include calendario, attività, 
contatti e note.

Pagina iniziale di Osmo

http://homebank.free.fr/en/
http://www.grisbi.org/
https://www.plex.tv/
http://kodi.tv/
http://goodies.xfce.org/projects/panel-plugins/xfce4-notes-plugin
https://community.kde.org/KDE_PIM
https://osmo-pim.sourceforge.net/


Figura 4-9: Il gestore di informazioni personali Osmo.

4.5 Sicurezza

4.5.1 Firewall

Gufw. Un'utilità di configurazione del firewall personale che facilita la configurazione del 
firewall da parte dell'utente. È installata di default solo in Xfce e Fluxbox. Gli utenti di KDE 
possono cercare gufw in MXPI.

In MX Linux 23, il firewall non complicato (alias UFW) è abilitato per impostazione 
predefinita e impostato per ignorare tutte le connessioni in entrata. Questo potrebbe bloccare il 
funzionamento di alcuni servizi di rete popolari come Samba, SSH, VNC o KDE Connect.

L'aggiunta di una regola di eccezione del firewall risolve questo problema in modo sicuro. Per 
configurare una regola nell'UFW, eseguire la "Configurazione del firewall" (app UFW).

• Lo "Stato del Firewall:" blu indica che il Firewall è attivo (abilitato).

• Fare clic sul pulsante Regole e poi su +.

• Nella casella di ricerca bianca digitate "Samba" e fate clic sul pulsante "+ Aggiungi" e poi su Chiudi.

Figura 4-10: Aggiunta di un'eccezione per Samba



NOTA: Samba versione 4.7.x e successive utilizza TCP sulla porta 445. Questo è tutto ciò che 
è necessario per Vista e le versioni più recenti di Windows.

AVVERTENZA: Le versioni più vecchie dei dispositivi Samba e le versioni di Windows 2000 
e precedenti utilizzano UDP sulle porte 137 e 138 e TCP sulle porte 137 e 139. L'abilitazione di 
questi intervalli di porte *POTREBBE* causare perdite di dati, Ransomware, Malware o 
problemi di privacy.

Servizio di scoperta dinamica dei servizi web (WSDD)
Se si utilizza il servizio WSDD (MX Test Repo) per consentire agli host Windows di navigare 
nelle condivisioni Linux (visibili nella cartella Esplora risorse > Rete):

• WSDD opera sulla porta 5357 di TCP e sulla porta 3702 di UDP.

• Attualmente non esistono regole firewall UFW predefinite per WSDD.

AIUTO:
Documentazione 

della homepage

4.5.2 Antivirus

• ClamAV. Utile per impedire che gli utenti di Linux passino inconsapevolmente e-
mail e altri documenti infetti da virus a utenti Windows suscettibili.

Pagina iniziale di ClamAV

4.5.3 AntiRootkit

• chkrootkit. Questa applicazione analizza i sistemi alla ricerca di rootkit, 
backdoor, sniffer ed exploit noti e sconosciuti.

chkrootkit home page

4.5.4 Protezione con password

• Password e chiavi. Un gestore di password e chiavi installato di default. Dettagli 
sull'uso nel Wiki MX/antiX.

Aiuto per password e chiavi

• KeePassX. Un gestore di password o una cassaforte che aiuta a gestire le password in 
modo sicuro. Installatore di pacchetti MX.

Pagina iniziale di KeePassX

https://help.ubuntu.com/community/Gufw
https://costales.github.io/projects/gufw/
https://sourceforge.net/projects/clamav/
http://www.chkrootkit.org/
https://mxlinux.org/wiki/applications/passwords-and-keys
https://help.gnome.org/users/seahorse/stable/
http://www.keepassx.org/


4.5.5 Accesso al web
La maggior parte dei browser moderni dispone di componenti aggiuntivi che consentono di 
filtrare facilmente il web. FoxFilter è un esempio consolidato che si installa su Firefox, 
Chrome e Opera.

Figura 4-11: La scheda preferenze di FoxFilter.

4.6 Accessibilità

Esistono diverse utility open-source per gli utenti di MX Linux con disabilità.

• Tastiera su schermo. Onboard è installata di default e Florence è presente nei repo.

• Lente di ingrandimento dello schermo. Magnus (Xfce) e KTTS (KDE) sono installati di default.

• Lettore di testo. Orca funziona bene con KDE, meno bene con Xfce.

• Applicazioni assistive

• Xfce. Fare clic su Menu applicazioni > Impostazioni > Accessibilità e 
selezionare Abilita tecnologie assistive. Modificare le opzioni 
disponibili in base alle proprie esigenze.

Documentazione di Xfce4: Accessibilità

• KDE gestisce un'ampia raccolta di aiuti all'accessibilità.

Applicazioni per l'accessibilità di KDE

• Debian. Molti altri strumenti sono disponibili all'interno di Debian stessa.

Wiki Debian

http://docs.xfce.org/xfce/xfce4-settings/accessibility
https://userbase.kde.org/Applications/Accessibility
https://wiki.debian.org/accessibility


4.7 Sistema

4.7.1 Privilegi di root

Esistono due comandi comuni per ottenere i privilegi di root (alias amministratore, superutente) 
necessari per apportare modifiche al sistema (ad esempio, installare software) utilizzando un 
terminale.

• su: richiede la password di root e concede i privilegi per l'intera sessione di terminale

• sudo: richiede la password dell'utente e concede i privilegi per un breve periodo di tempo.

In altre parole, su consente di cambiare utente in modo da essere effettivamente connessi come 
root, mentre sudo consente di eseguire comandi nel proprio account utente con privilegi di root. 
Inoltre, su utilizza l'ambiente (configurazione specifica dell'utente) dell'utente root, mentre sudo 
consente di apportare modifiche a livello di root ma mantiene l'ambiente dell'utente che esegue 
il comando. A partire da MX-21, MX Linux utilizza per impostazione predefinita sudo.

L'utente può scegliere se utilizzare "Root" o "User" nella scheda "Other" di MX Tweak.

ALTRO: fare clic su Menu applicazioni > inserire "#su" o "#sudo" (senza le virgolette) nello 
spazio di ricerca e tornare indietro per vedere le pagine man dettagliate.

Esecuzione di un'applicazione root

Alcune applicazioni che si trovano nel menu delle applicazioni richiedono all'utente i privilegi di 
root: gparted, lightdm gtk+ greeter, ecc. A seconda di come è scritto il comando di avvio, la 
finestra di dialogo che si apre può mostrare che l'accesso di root sarà memorizzato (impostazione 
predefinita) per tutta la durata della sessione (cioè fino al logout).

Figura 4-12: Finestra di dialogo quando viene utilizzato il comando pkexec (senza memorizzazione).



4.7.2 Ottenere le specifiche hardware

• Fare clic su Menu Applicazioni > Sistema > Profilatore di sistema e 
Benchmark per ottenere una bella visualizzazione grafica che include i risultati di 
vari test.

• Fare clic su Menu Applicazioni > Strumenti MX > Informazioni rapide sul 
sistema. Il risultato viene automaticamente copiato negli appunti e può essere 
incollato in un post del forum completo di tag di codice.

Per le altre caratteristiche di inxi, si veda la sezione 6.5.

4.7.3 Creare collegamenti 
simbolici

Un collegamento simbolico (anche soft link o symlink) è un tipo speciale di file che punta a un 
altro file o cartella, come un collegamento in Windows o un alias in Macintosh. Un 
collegamento simbolico non contiene dati reali (come un collegamento fisso), ma punta 
semplicemente a un'altra posizione nel sistema.

Esistono due modi per creare un collegamento simbolico: File Manager o la riga di comando.

• Thunar

• Navigare verso il file o la cartella (destinazione del collegamento) a cui si 
vuole puntare da un'altra posizione o con un altro nome.

• Cliccando con il tasto destro del mouse su ciò che si vuole collegare > Crea 
collegamento simbolico, viene creato un collegamento simbolico nel punto 
in cui ci si trova attualmente.

• Fate clic con il tasto destro del mouse sul nuovo collegamento simbolico > Taglia

• Spostarsi nel punto in cui si desidera inserire il collegamento, fare clic con 
il pulsante destro del mouse su un'area aperta> Incolla. Se lo si desidera, 
modificare il nome del collegamento.

• Delfino/KDE-Plasma

• Usare Crea nuovo > Collegamento di base a file o directory

• Linea di comando: Aprire un terminale e digitare:

ln -s FileOrCartella di destinazione NomeCollegamento

• Ad esempio, per creare un collegamento simbolico tra un file chiamato 
"pippo" nella cartella Download e la cartella Documenti, si deve immettere 
questo comando:



ln -s ~/Downloads/foo ~/Documents/foo



4.7.4 Trovare file e cartelle

INTERFACCIA GRAFICA
Xfce - Thunar

Figura 4-13: Schermata di ricerca di Catfish alla ricerca di "MX-" nella cartella Download.

Catfish è installato di default in MX Linux Xfce e può essere lanciato dal Menu 
Applicazioni > Accessori, o semplicemente iniziando a digitare "search" nel campo di 
ricerca in alto. È anche integrato in Thunar, in modo che l'utente possa fare clic con il tasto 
destro del mouse su una cartella > Trova file qui.

Pagina iniziale del pesce gatto

Gli utenti di KDE/Plasma possono accedere alla finestra di dialogo Trova integrata nella barra degli strumenti 
del File Manager di Dolphin.

Figura 4-14: Risultati della ricerca Dolphin Find.

Altri software di ricerca più avanzati, come recoll, sono disponibili nei repo.

CLI

http://www.twotoasts.de/index.php/catfish/
https://www.lesbonscomptes.com/recoll/


Esistono alcuni comandi molto utili da utilizzare in un terminale.



• locate. Per ogni modello dato, locate cerca uno o più database di nomi di file e 
visualizza quelli che contengono il modello. Ad esempio, digitando:

individuare firefox

restituirà un elenco estremamente lungo con tutti i file che hanno la parola "firefox" nel 
nome o nel percorso. Questo comando è simile a find ed è meglio utilizzarlo quando si 
conosce il nome esatto del file.

Individuare gli esempi

• whereis. Un altro strumento a riga di comando, installato per impostazione 
predefinita. Per ogni schema dato, whereis cerca in uno o più database di nomi di file 
e visualizza i nomi di file che contengono lo schema, ma ignora i percorsi, per cui 
l'elenco di ritorno è molto più breve. Ad esempio, digitando:

dove si trova firefox

restituirà un elenco molto più breve, simile a questo:

firefox: /usr/bin/firefox /etc/firefox /usr/lib/firefox
/usr/bin/X11/firefox /usr/share/firefox
/usr/share/man/man1/firefox.1.gz

Esempi di Whereis

• che: Probabilmente lo strumento più comodo di tutti, questo comando cerca di 
identificare l'eseguibile. Ad esempio, digitando:

restituisce un singolo 
elemento:

Quali esempi

quale firefox

/usr/bin/firefox

4.7.5 Uccidere i programmi in fuga

• Desktop

1. Premere Ctrl-Alt-Esc per trasformare il cursore in una "x". Fare clic su 
qualsiasi schermata aperta per eliminarla, fare clic con il pulsante destro del 
mouse per annullarla. Fate attenzione a non fare clic sul desktop o la sessione 
si interromperà bruscamente.

2. Xfce - Task Manager: Menu Applicazioni > Sistema > Task Manager. 
Selezionare il processo desiderato e fare clic con il pulsante destro del mouse 
per arrestarlo, terminarlo o eliminarlo.

3. KDE/Plasma - Menu Applicazioni > Preferiti, oppure fare clic su Menu 
Applicazioni > Sistema > Monitor di sistema

4. È disponibile anche uno strumento tradizionale: fare clic su Menu 

http://www.tecmint.com/35-practical-examples-of-linux-find-command/
http://www.thegeekstuff.com/2012/03/locate-command-examples/
http://www.cyberciti.biz/faq/unix-linux-whereis-command-examples-to-locate-binary/
http://www.thegeekstuff.com/2013/04/linux-which-whatis-whereis/


Applicazioni > Sistema > Htop, che visualizza un terminale con tutti i 
processi in esecuzione. Individuare il programma che si desidera arrestare, 
evidenziarlo, premere F9 e quindi Return.



• Terminale: Premere Ctrl-C, che di solito interrompe un programma/comando 
avviato in una sessione di terminale.

• Se le soluzioni di cui sopra non funzionano, provate questi metodi più estremi 
(elencati in ordine crescente di gravità).

1. Riavviare X. Premere Ctrl-Alt-Bksp per eliminare tutti i processi di 
sessione, tornando alla schermata di accesso. Tutto il lavoro non salvato 
andrà perso.

2. Utilizzare il tasto magico SysRq (REISUB). Tenere premuto il tasto Alt (a 
volte funziona solo il tasto Alt sinistro) e il tasto SysRq (che può anche essere 
etichettato come Print Screen o PrtScrn) con un'altra mano, quindi premere 
lentamente, senza rilasciare Alt-SysRq, i tasti R-E-I-S-U-B uno dopo l'altro. 
Tenete premuto ogni tasto della sequenza REISUB per circa 1 o 2 secondi 
prima di passare al tasto successivo; il sistema dovrebbe spegnersi 
correttamente e riavviarsi. Lo scopo di questa chiave magica è quello di 
attraversare diverse fasi che consentono al sistema di uscire in sicurezza da un 
guasto di qualche tipo, e spesso sono sufficienti solo le prime due lettere. Ecco 
cosa succede quando si passa attraverso le lettere:

• R - cambia la modalità della tastiera. Si dice che "commuta la tastiera 
dalla modalità raw, quella usata da programmi come X11 e svgalib, alla 
modalità XLATE" (da Wikipedia), ma non è certo che questo abbia un 
effetto rilevante.

• E - termina con grazia tutti i programmi in esecuzione. Invia il 
segnale SIGTERM a tutti i processi, eccetto init, chiedendo loro di 
terminare con grazia, dando loro la possibilità di riordinare e liberare le 
risorse, salvare i dati, ecc...

• I - Uccide forzatamente tutti i programmi in esecuzione. È simile a 
E, ma invia il segnale SIGKILL a tutti i processi tranne che a init, 
uccidendoli immediatamente e forzatamente.

• S - sincronizza tutti i dischi e svuota le loro cache. Tutti i dischi hanno 
normalmente una cache di scrittura, una porzione di RAM in cui il sistema 
memorizza i dati che desidera salvare sul dispositivo, per velocizzare 
l'accesso. La sincronizzazione indica al sistema di svuotare queste cache 
ed eseguire tutte le scritture rimanenti. In questo modo non si perdono i 
dati già memorizzati nella cache ma non ancora scritti e si evita di lasciare 
il file system in uno stato incoerente.

• U - smonta tutti i dischi e li rimonta in sola lettura. Anche in questo 
caso si tratta di un'operazione poco spettacolare, che semplicemente rende 
tutti i dischi montati di sola lettura per impedire qualsiasi ulteriore 

https://en.wikipedia.org/wiki/Magic_SysRq_key


scrittura (parziale).



• B - riavvia il sistema. Questa operazione riavvia il sistema. 
Tuttavia, non esegue uno spegnimento pulito, bensì un reset rigido.

Wikipedia: REISUB

3. Se non funziona nient'altro, tenere premuto il pulsante di accensione del 
computer per circa 10 secondi finché non si spegne.

Figura 4-15: Task Manager, pronto a chiudere un processo. A destra: KDE/Plasma A sinistra: Xfce.

4.7.6 Prestazioni del tracciato

Generale

• INTERFACCIA GRAFICA

• Fate clic su Menu Applicazioni > Sistema > Profilatore di sistema e 
Benchmark, dove è possibile non solo visualizzare numerose specifiche, ma 
anche eseguire test sulle prestazioni.

• Molti conky mostrano alcune prestazioni del sistema; utilizzare Conky 
Manager per visualizzarli in anteprima in base alle proprie esigenze e 
preferenze. Vedere la Sezione 3.8.3.

• Plugin Xfce. Nel pannello è possibile inserire una serie di plugin per il 
monitoraggio del sistema, tra cui Battery Monitor, CPU Frequency Monitor, 
CPU Graph, Disk Performance Monitor, Free Space Checker, Network 
Monitor, Sensor plugin, System Load Monitor e Wavelan. Tutti possono 
essere installati con il metapacchetto xfce4-goodies. KDE/plasma ha un 
insieme simile di pannelli e widget per il desktop.

Xfce4 Goodies pagina iniziale

• CLI

https://en.wikipedia.org/wiki/Magic_SysRq_key
http://goodies.xfce.org/projects/panel-plugins/start


• lm-sensors. Questo pacchetto di monitoraggio della salute dell'hardware è 
installato di default in MX Linux. Aprire un terminale ed entrare con su o 
sudo:

sensori-rilevazione

Fare clic su Ritorno per rispondere affermativamente a tutte le domande. Al 
termine, sarà possibile ottenere informazioni dettagliate sulle letture dei sensori 
disponibili sul sistema aprendo un terminale e digitando: sensors.

Lm-sensors home page

Batteria

Il livello della batteria è monitorato dal plugin Power Manager (Xfce) sul pannello. Un plugin 
dedicato al pannello, chiamato Battery Monitor, è disponibile anche facendo clic con il pulsante 
destro del mouse su Pannello > Pannello > Aggiungi nuovi elementi ...

In KDE è installato di default un widget del pannello Battery Monitor.

4.7.7 Programmare le attività

• INTERFACCIA GRAFICA

• MX Job Scheduler, vedere 3.2.11.

• Attività pianificate (gnome-schedule). Un modo molto pratico per 
programmare le attività di sistema senza dover modificare direttamente i file di 
sistema. Home page di Gnome-schedule.

• KDE ha un Task Scheduler con capacità simili.

Figura 4-16: Schermata principale del Task Scheduler di KDE.

• CLI

• È possibile modificare crontab, un file di testo con un elenco di comandi da 
eseguire a orari specifici.

Panoramica di Crontab

https://wiki.archlinux.org/index.php/Lm_sensors
http://gnome-schedule.sourceforge.net/
https://userbase.kde.org/System_Settings/Task_Scheduler
https://mxlinux.org/wiki/system/crontab/


Generatore di crontab facile

4.7.8 Tempo corretto

La corretta impostazione dell'ora viene normalmente effettuata all'avvio di Live o durante 
l'installazione. Se l'ora dell'orologio è sempre sbagliata, ci sono 4 possibili problemi:

• fuso orario sbagliato

• selezione errata dell'ora UTC rispetto a quella locale

• Orologio del BIOS impostato in modo errato

• deriva del tempo

Questi problemi sono più facilmente risolvibili utilizzando MX Data e ora > Menu 
Applicazione > Sistema (Sezione 3.4); per le tecniche da riga di comando, consultare il Wiki 
MX/antiX.

4.7.9 Mostra blocco tasti
Su molti portatili non c'è un indicatore luminoso per l'attivazione dei tasti CapsLock o 
NumLock, il che può essere molto fastidioso. Per risolvere questo problema con un notificatore 
sullo schermo, installare indicator-keylock dai repo.

4.8 Buone pratiche

4.8.1 Backup
La pratica più importante è quella di eseguire regolarmente il backup dei dati e dei file di 
configurazione, un processo che è facile in MX Linux. Si raccomanda vivamente di eseguire il 
backup su un'unità diversa da quella in cui si trovano i dati! L'utente medio troverà comodo uno 
dei seguenti strumenti grafici.

Figura 4-17: Schermata principale di Lucky Backup.

http://crontab-generator.org/
https://mxlinux.org/wiki/system/time-settings
https://mxlinux.org/wiki/system/time-settings
https://wiki.archlinux.org/index.php/Backup_programs
https://wiki.archlinux.org/index.php/Backup_programs


• MX Snapshot, uno strumento MX. Vedere la sezione 3.4.

Panoramica

• gRsync, un frontend grafico per rsync.

Panoramica di gRsync

• LuckyBackup. Un programma semplice per eseguire il backup e la sincronizzazione dei file. Installato 
per impostazione predefinita.

Manuale di LuckyBackup

• Déjà Dup. Uno strumento di backup semplice ma molto efficace.

Déjà Dup home page

• BackInTime. Un'applicazione ben collaudata disponibile da MX Package Installer > 
MX Test Repo (preinstallata su MX KDE).

• Servizio cloud. Esistono molti servizi cloud che possono essere utilizzati per il 
backup o la sincronizzazione dei dati. DropBox e Google Drive sono 
probabilmente i più noti, ma ne esistono molti altri.

• Clonazione. Crea un'immagine completa del disco rigido.

• Clonezilla. Scaricare Clonezilla Live dalla pagina iniziale di Clonezilla e 
riavviarlo.

• Timeshift. Backup/ripristino dell'intero sistema; nei repo. La home page 
di Timeshift include una panoramica dettagliata e le istruzioni per l'uso.

• Salvare il sistema in una ISO live (Sezione 6.6.3).

• Strumenti CLI. Si veda la discussione nel Wiki di Arch: Clonazione

• Comandi CLI per eseguire i backup (rsync, rdiff, cp, dd, tar, ecc.).

Dati

Assicuratevi di eseguire il backup dei dati, compresi documenti, grafica, musica e posta. Per 
impostazione predefinita, la maggior parte di questi dati è memorizzata nella directory /home; si 
consiglia, se possibile, di avere una partizione dati separata, meglio se in una posizione esterna.

File di configurazione

Ecco un elenco di elementi da considerare per il backup.

• /home. Contiene la maggior parte dei file di configurazione personali.

https://mxlinux.org/wiki/help-files/help-mx-save-system-to-iso-snapshot/
https://en.wikipedia.org/wiki/Rsync
https://www.dedoimedo.com/computers/grsync.html
http://luckybackup.sourceforge.net/manual.html
https://launchpad.net/deja-dup
http://clonezilla.org/
http://clonezilla.org/
https://github.com/teejee2008/timeshift
https://github.com/teejee2008/timeshift
https://wiki.archlinux.org/index.php/disk_cloning


• /root. Conserva le modifiche apportate come root.

• /etc/X11/xorg.conf. Il file di configurazione di X, se esiste.

• I file di GRUB2 /etc/grub.d/ e /etc/default/grub.

Elenco dei pacchetti di programmi installati

È anche una buona idea salvare nella directory /home o nel cloud (Dropbox, Google Drive, 
ecc.) un file contenente l'elenco dei programmi installati con Synaptic, apt o Deb Installer. Se in 
futuro sarà necessario reinstallare, sarà possibile recuperare i nomi dei file per la reinstallazione.

INTERFACCIA GRAFICA

Esiste uno strumento dedicato a questo scopo: MX User Installed Packages. Vedere la sezione 3.4.

Nei repo c'è anche uno strumento aptik che può essere utile se usato con cautela. Può essere 
utile per i file di impostazione che tendono a essere trascurati.

CLI

È possibile creare un inventario di tutti i pacchetti presenti sul sistema dopo l'installazione 
copiando questo lungo comando ed eseguendolo in un terminale:

dpkg -l | awk '/^[i|h]i/{ print $2 }' | grep -v -e ̂ lib[0-q\|s-z] -e ̂ libr[0-d\f-z] -e ̂ libre[0-n|p-z] -e -dev$ -e -dev: - e 
linux-image -e linux-headers | awk '{print $1" installed"}' | column -t > apps_installed.txt

Questo creerà un file di testo nella vostra home directory chiamato "apps_installed.txt" che 
contiene tutti i nomi dei pacchetti.

Per reinstallare TUTTI i pacchetti in una volta sola: assicurarsi che tutti i repository necessari 
siano abilitati, quindi eseguire questi comandi uno alla volta:

sudo dpkg \SpecialChar nobreakdash\SpecialChar nobreakdashset-selections < 
apps_installed.txt
apt-get update
apt-get dselect-upgrade

NOTA: questo non dovrebbe essere tentato tra versioni di MX basate su versioni diverse di 
Debian (ad esempio, da MX-19.4 a MX-21).

4.8.2 Manutenzione del disco
Quando un sistema invecchia, spesso accumula dati non più utilizzati e riempie gradualmente il 
disco. Questi problemi possono essere risolti utilizzando periodicamente MX Cleanup.

https://mxlinux.org/wiki/other/application-migration-aptik


Vediamo un esempio. Quando il suo computer stava rallentando, un utente ha controllato lo 
spazio libero sul disco usando inxi -D e ha notato con sorpresa che il disco era pieno al 96%. 
Disk Usage Analyzer ha fornito una buona analisi grafica. Dopo la pulizia con MX User 
Manager, la percentuale è scesa a circa il 63% e la lentezza è scomparsa.

Figura 4-18. A sinistra: Disk Usage Analyzer che mostra una directory principale 
quasi piena. A destra: risultato dell'eliminazione della cache come rappresentato da 
Disk Usage Analyzer.

Deframmentazione
Gli utenti che provengono da Windows potrebbero chiedersi se sia necessario deframmentare 
periodicamente l'unità. È probabile che la deframmentazione non sia necessaria sul file system 
ext4 predefinito di MX, ma se è quasi pieno e non ha un'area contigua abbastanza grande per 
allocare il file, si rischia la frammentazione. Se necessario, è possibile controllare lo stato con 
questo comando:

sudo e4defrag -c /

Dopo pochi secondi verrà visualizzato un punteggio e una semplice indicazione sulla necessità 
o meno di deframmentare il sistema.

4.8.3 Controllo degli errori
Molti messaggi di errore vengono scritti nel file appropriato in /var/log/ e riguardano 
problemi di applicazioni, eventi, servizi e sistema. Alcuni importanti includono:

• /var/log/boot

• /var/log/dmesg

• /var/log/kern.log

• /var/log/messaggi

• /var/log/Xorg.0.log

Questi registri possono essere visualizzati comodamente con Info sistema rapido.

4.9 Giochi
Sfogliando l'ampio elenco di giochi disponibili attraverso Synaptic (fare clic su Sezioni > 
Giochi in fondo al pannello di sinistra) o seguendo i collegamenti riportati di seguito, si 
troveranno molti altri titoli per il vostro divertimento.



Il seguente elenco contiene alcuni esempi per stuzzicare l'appetito.



4.9.1 Giochi di avventura e sparatutto
• Chromium B.S.U.: Uno sparatutto spaziale veloce, in stile arcade e a 

scorrimento dall'alto. Pagina iniziale di Chromium B.S.U.

• Beneath A Steel Sky: Un thriller fantascientifico ambientato in un cupo futuro post-

apocalittico. Home page di Beneath a Steel Sky

• Kq: un gioco di ruolo per console, simile a Final Fantasy. 

Pagina iniziale di Kq

• Marte. "Uno sparatutto ridicolo". Proteggi il pianeta dai tuoi vicini 

gelosi! Pagina iniziale di Marte

Figura 4-19: Navi da guerra nemiche all'attacco nella B.S.U. Cromo.

4.9.2 Giochi arcade
• Defendguin: Un clone di Defender, in cui la vostra missione è difendere i piccoli 

pinguini. Pagina iniziale di Defendguin

• Bolla congelata: Le bolle colorate sono congelate nella parte superiore dello schermo di 
gioco. Mentre la pressa di ghiaccio scende, è necessario far scoppiare gruppi di bolle 
congelate prima che la pressa raggiunga il tiratore.

Pagina iniziale di Frozen Bubble

• Planet Penguin Racer: un divertente gioco di corse con il vostro pinguino preferito.

• Pagina iniziale di Tuxracer

• Ri-li: Un gioco di treni 

giocattolo. Ri-li home 

page

http://chromium-bsu.sourceforge.net/
https://en.wikipedia.org/wiki/Beneath_a_Steel_Sky
http://kqlives.sourceforge.net/
http://mars-game.sourceforge.net/?page_id=972
http://www.newbreedsoftware.com/defendguin
http://www.frozen-bubble.org/
http://tuxracer.sourceforge.net/
http://ri-li.sourceforge.net/
http://ri-li.sourceforge.net/


• Supertux: Un classico gioco 2D a scorrimento laterale con salto e corsa in uno stile 
simile a quello dei giochi originali di SuperMario.

Pagina iniziale di Supertux

• Supertuxkart: Una versione molto migliorata di 

tuxkart. Pagina iniziale di Supertuxcart

Figura 4-20: Il treno Ri-li deve girare presto.

4.9.3 Giochi da tavolo

• I giochi Gottcode sono intelligenti e divertenti.

Pagina iniziale di Gottcode

• Mine (gnomine): Un gioco di mine per 1 giocatore.

Pagina iniziale delle miniere

• Do'SSi Zo'la: L'obiettivo del gioco base Isola è bloccare l'avversario distruggendo le 
caselle che lo circondano.

Pagina iniziale di Do'SSi Zo'la

• Gnuchess: Un gioco di scacchi.

Gnuchess home page

http://supertux.lethargik.org/
http://supertuxkart.sourceforge.net/
http://gottcode.org/
https://wiki.gnome.org/Apps/Mines
http://dossizola.sourceforge.net/
http://www.gnu.org/software/chess


Figura 4-21: Momento di alta tensione nelle miniere.

4.9.4 Giochi di carte

Ecco alcuni divertenti giochi di carte disponibili nei repo.

• AisleRiot offre oltre 80 giochi di solitario.

Pagina iniziale di AisleRiot

• Pysolfc: Oltre 1.000 giochi di solitario da un'unica applicazione.

Pysolfc home page

4.9.5 Divertimento sul desktop

• Xpenguins. I pinguini camminano sullo schermo. Può essere personalizzato 
con altri personaggi come Lemmings e Pooh Bear (è necessario consentire 
l'esecuzione dei programmi nella finestra principale).

Pagina iniziale di Xpenguins

• Oneko. Un gatto (neko) segue il cursore (il mouse) sullo schermo. Può essere 
personalizzato con un cane o un altro animale.

Wikipedia: Neko

https://wiki.gnome.org/Apps/Aisleriot
http://pysolfc.sourceforge.net/
http://xpenguins.seul.org/
https://en.wikipedia.org/wiki/Neko_(software)


• Algodoo. Questo gioco gratuito presenta un sandbox di fisica in 2D in cui è possibile 
giocare con la fisica come mai prima d'ora. La sinergia giocosa tra scienza e arte è 
inedita e rende il gioco tanto educativo quanto divertente.

Pagina iniziale di Algodoo

• Xteddy. Mette un simpatico orsacchiotto sul desktop. In alternativa, è possibile aggiungere la propria 
immagine.

Xteddy homepage

• Tuxpaint. Un programma di disegno per bambini di tutte le età.

Pagina iniziale di Tuxpaint

Figura 4-22: Genio in erba al lavoro in Tuxpaint.

4.9.6 I bambini
• Dal programma di installazione dei pacchetti MX sono disponibili tre pacchetti di 

giochi e applicazioni didattiche.

• Inoltre, Scratch è un linguaggio di programmazione gratuito e una comunità online 
dove è possibile creare storie interattive, giochi e animazioni. Installatore di pacchetti 
MX.

Home page di Scratch

http://www.algodoo.com/
http://staffwww.itn.liu.se/~stegu/xteddy/index.html
http://www.tuxpaint.org/


Figura 4-23: Schermata di codifica di Dance Party con Scratch.

4.9.7 Giochi di tattica e strategia

• Freeciv: Un clone di Sid Meyer's Civilization© (versione I), un gioco di strategia 
multigiocatore a turni, in cui ogni giocatore diventa il leader di una civiltà dell'età della 
pietra, cercando di ottenere l'ascendente con il progredire delle epoche.

Pagina iniziale di Freeciv

• Lbreakout2: LBreakout2 è un gioco arcade in stile breakout in cui si usa la racchetta per 
puntare una palla contro i mattoni fino a distruggerli tutti. Molti livelli e sorprese. 
Installato di default.

Lgames home page

• Lincity: Un clone dell'originale Simcity. Dovete costruire e mantenere una città e 
soddisfare i suoi abitanti in modo che la popolazione cresca.

Pagina iniziale di Lincity

• Battle for Wesnoth: Un apprezzato gioco di strategia a turni a tema fantasy. Costruite il 
vostro esercito e combattete per riconquistare il trono.

Pagina iniziale di Battle for Wesnoth

http://www.freeciv.org/
http://lgames.sourceforge.net/
http://lincity.sourceforge.net/
http://www.wesnoth.org/


Figura 4-24: Tentativo di sfondare il primo muro in Lbreakout.

4.9.8 Giochi per Windows

Alcuni giochi per Windows possono essere giocati in MX Linux utilizzando un emulatore di 
Windows come Cedega o DOSBox, oppure alcuni possono essere eseguiti con Wine: vedere la 
Sezione 6.1.

4.9.9 Servizi di gioco

Figura 4-25: Peccati di un impero solare: Rebellion su Steam con Proton.

Esistono diverse raccolte e servizi per gli utenti che desiderano giocare su MX Linux. Due dei 
più noti sono facilmente installabili con MX Package Installer.

• PlayOnLinux. Un frontend grafico per Wine (Sezione 6.1) che consente agli utenti 
Linux di installare e utilizzare facilmente numerosi giochi e applicazioni progettati 
per funzionare con Microsoft® Windows®.



Homepage di PlayOnLinux.

• Steam. Una piattaforma di distribuzione digitale proprietaria per l'acquisto e la 
riproduzione di videogiochi che prevede l'installazione e l'aggiornamento 
automatico dei giochi. Include Proton, una distribuzione modificata di Wine.

Homepage di Steam

4.10 Strumenti di Google

4.10.1 Gmail

Gmail può essere facilmente configurato in Thunderbird seguendo le istruzioni. Inoltre, è 
possibile accedervi facilmente con qualsiasi browser.

4.10.2 Contatti di Google

I contatti di Google possono essere collegati a Thunderbird utilizzando il componente 

aggiuntivo gContactSync. Pagina iniziale di gContactSync

4.10.3 Google cal

Gcal può essere impostato in una scheda di Thunderbird con i componenti aggiuntivi Lightning e 

Google Calendar Tab. Pagina iniziale del calendario Lightning

4.10.4 Compiti di Google

I task possono essere inclusi in Thunderbird selezionando la voce Tasks del calendario.

4.10.5 Google Earth

Il metodo più semplice per installare Google Earth è utilizzare MX Package Installer, dove si 
trova nella sezione "Misc".

Esiste anche un metodo manuale che può essere utile in alcune installazioni.

• Installare googleearth.package dai repo o direttamente dal repo di Google.

• Aprire un terminale e digitare:

pacchetto make-googleearth

• Una volta terminato, diventare root e digitare:

dpkg -i googleearth*.deb

https://www.playonlinux.com/en/
https://store.steampowered.com/
http://www.pirules.org/addons/gcontactsync/
https://www.mozilla.org/en-US/projects/calendar/
https://www.google.co.uk/earth/download/gep/agree.html


• Sullo schermo apparirà un messaggio di errore relativo a problemi di dipendenza. 
Correggetelo inserendo quest'ultimo comando (sempre come root):

apt-get -f installare

Ora finalmente Google Earth apparirà nel Menu Applicazioni > Internet.

4.10.6 Google Talk

Google Duo può essere eseguito direttamente da Gmail.

4.10.7 Google Drive
Esistono comodi strumenti che consentono di accedere localmente al vostro account GDrive.

• Una semplice applicazione gratuita chiamata Odrive si installa e funziona bene.

• L'applicazione proprietaria multipiattaforma Insync consente la sincronizzazione e 
l'installazione selettiva su più computer.

4.11 Bug, problemi e richieste
I bug sono errori in un programma o sistema informatico che producono risultati errati o 
comportamenti anomali. Le "richieste" o "miglioramenti" sono aggiunte richieste dagli utenti, 
sia come nuove applicazioni che come nuove funzionalità per applicazioni esistenti. MX 
Linux tratta queste richieste nel modo seguente:

• I bug vengono gestiti tramite il Bug Tracker di MX e antiX Linux.

• Le richieste possono essere fatte con un post nel Forum Bugs e Richieste, facendo 
attenzione a fornire informazioni sull'hardware, sul sistema e altri dettagli.

• Gli sviluppatori e i membri della comunità risponderanno a questi messaggi con 
domande, suggerimenti, ecc.

Figura 4-26: dashboard del bug manager

https://duo.google.com/
https://www.omgubuntu.co.uk/2019/02/odrive-google-drive-linux-client
https://www.insynchq.com/google-drive-linux
http://bugs.mxlinux.org/
https://us-bz3.devzing.com/mx_antix/
https://forum.mxlinux.org/viewforum.php?f=97


5.1 Introduzione

5.1.1 Metodi

MX Linux offre due metodi di gestione del software tramite GUI complementari al CLI (vedi 5.5.4):

• MX Package Installer (MXPI) per l'installazione/rimozione con un solo clic delle 
applicazioni più diffuse. Questo include le applicazioni presenti nei repository Debian Stable, 
MX Test, Debian Backports e Flatpaks (Sezione 3.2.11).

• Synaptic Package Manager, uno strumento grafico completo per tutta una serie di azioni 
con i pacchetti Debian. (Nota: al momento i flatpak non sono disponibili tramite Synaptic).

MXPI è consigliato e presenta i seguenti vantaggi rispetto a Synaptic:

• È molto più veloce!

• La scheda Applicazioni più diffuse è limitata ai pacchetti utilizzati più di frequente, per cui 
tutto è facile da trovare.

• Installa correttamente alcuni pacchetti complicati che sono difficili per i nuovi utenti (a d  esempio Wine).

• È un'unica fonte che include i repository menzionati sopra e ha pacchetti più recenti di 
quelli che Synaptic ha di default.

Synaptic ha i suoi vantaggi:

• Dispone di un gran numero di filtri avanzati, come le sezioni (categorie), lo stato, ecc.

• Offre informazioni dettagliate su determinati pacchetti.

• È molto facile aggiungere nuovi repository di software.

Questa sezione 5 si concentra su Synaptic, che è il metodo consigliato ai principianti per gestire i 
pacchetti software al di là delle capacità di MX Package Installer. Verranno inoltre esaminati altri 
metodi disponibili e che possono essere necessari in determinate situazioni.

5Gestione del software



5.1.2 Pacchetti

Le operazioni software in MX sono eseguite dietro le quinte attraverso il sistema Advanced Package 
Tool (APT). Il software viene fornito sotto forma di pacchetto: un insieme discreto di dati non 
eseguibili che include istruzioni per l'installazione da parte del gestore di pacchetti. I pacchetti sono 
memorizzati su server chiamati repository (repo) e possono essere consultati, scaricati e installati 
tramite uno speciale software client chiamato package manager.

La maggior parte dei pacchetti ha una o più dipendenze, cioè uno o più pacchetti che devono essere 
installati per poter funzionare. Il sistema APT è progettato per gestire automaticamente le dipendenze; 
in altre parole, quando si tenta di installare un pacchetto le cui dipendenze non sono già installate, il 
gestore di pacchetti APT contrassegnerà automaticamente anche queste dipendenze per l'installazione. 
Può succedere che queste dipendenze non possano essere soddisfatte, impedendo l'installazione di un 
pacchetto. Se è necessario un aiuto per le dipendenze, si prega di inviare una richiesta di aiuto nel 
forum di MX Linux.

5.2 Repository

I repository APT sono molto più che semplici siti web con software scaricabile. I pacchetti sui siti dei 
repository sono organizzati e indicizzati in modo speciale per essere consultati attraverso un gestore 
di pacchetti, piuttosto che direttamente.

AVVERTENZA: Prestare molta attenzione quando si aggiungono altri repository a MX 
Linux! Questo è particolarmente vero per: Debian Sid o PPA non ufficiali, è molto probabile 
che la vostra installazione venga danneggiata in modo irreparabile.

5.2.1 Repository standard

MX Linux è dotato di una serie di repository abilitati che offrono sicurezza e possibilità di scelta. Se si 
è alle prime armi con MX Linux (e soprattutto se si è alle prime armi con Linux), si raccomanda di 
attenersi inizialmente ai repository predefiniti. Per ragioni di sicurezza, questi repo sono firmati 
digitalmente, il che significa che i pacchetti sono autenticati con una chiave di crittografia per 
assicurarne l'autenticità. Se si installano pacchetti da repository non Debian senza la chiave, si otterrà 
un avviso che non è stato possibile autenticarli. Per eliminare questo avviso e assicurarsi che le 
installazioni siano sicure, è necessario installare le chiavi mancanti usando MX Fix GPG keys.

È più facile aggiungere, attivare/disattivare, rimuovere o modificare i repo tramite Synaptic, anche se 
è possibile modificarli manualmente modificando i file in /etc/apt/ in un terminale root. In Synaptic, 
fare clic su Impostazioni >



quindi fare clic sul pulsante Nuovo e aggiungere le informazioni. Le informazioni sui repo sono 
spesso fornite come una singola riga, come questa:

deb http://mxrepo.com/mx/testrepo/ test del topo di biblioteca

Fate attenzione alla posizione degli spazi, che separano le informazioni in quattro parti da inserire in 
righe separate in Synaptic.

Figura 5-1: Repository, con il repo di test MX evidenziato.

Alcuni depositi hanno etichette speciali:

• contrib, che dipendono o sono accessori a pacchetti non liberi.

• non liberi, che non soddisfano le linee guida Debian per il software libero (DFSG).

• sicurezza, che contengono solo aggiornamenti relativi alla sicurezza.

• backport, che contengono pacchetti di versioni più recenti di Debian che sono stati resi 
retrocompatibili per mantenere il sistema operativo aggiornato.

• MX, che contengono i pacchetti speciali che rendono MX Linux ciò che è.

L'elenco attuale dei repository MX standard è conservato nella Wiki MX/antiX.

5.2.2 Repository della comunità

MX Linux ha i propri Repository comunitari con pacchetti che i nostri pacchettizzatori creano e 
mantengono. Questi pacchetti sono distinti dai pacchetti MX ufficiali provenienti da Debian 
Stable e contengono pacchetti provenienti da altre fonti:

• Debian Backports, da test o addirittura sperimentali.

http://mxrepo.com/mx/testrepo/


• La nostra distro sorella antiX.

• Progetti indipendenti.

• Ospiti open-source come GitHub.

I Repository della Comunità sono fondamentali per MX Linux, poiché consentono a un sistema 
operativo basato su Debian Stable di rimanere al passo con importanti sviluppi software, patch di 
sicurezza e correzioni di bug critici.

Oltre al repo MX Main, il repo MX Test ha lo scopo di ottenere il feedback degli utenti prima che i 
nuovi pacchetti vengano spostati nel Main. Il modo più semplice per installare da MX Test è il 
Package Installer (Sezione 3.2), che gestisce automaticamente molti passaggi.

Per saperne di più su ciò che è disponibile, su chi sono i confezionatori e su come partecipare, vedere 
MX Community Packaging Project.

5.2.3 Repository dedicati

Oltre ai repository generali come Debian, MX e Community, esiste anche un certo numero di 
repository dedicati associati a una singola applicazione. Quando si aggiunge uno di questi, direttamente 
o tramite Synaptic, si ricevono gli aggiornamenti. Alcuni sono precaricati ma non abilitati, altri li 
aggiungerete voi stessi.

Ecco un esempio comune (browser Vivaldi):

deb http://repo.vivaldi.com/stable/deb/ stable main

I nuovi utenti che provengono da Ubuntu o da uno dei suoi derivati spesso chiedono informazioni sui 
repository PPA; Ubuntu si discosta dalla Debian standard, quindi tali repository devono essere 
trattati con cautela. Consultare il Wiki MX/antiX.

5.2.4 Repository di sviluppo

Esiste un'ultima categoria di repository per acquisire la versione più recente (e quindi meno stabile) di 
un'applicazione. Questo avviene attraverso un sistema di controllo di versione come Git, che può essere 
consultato dall'utente finale per rimanere aggiornato sullo sviluppo. Una copia del codice sorgente 
dell'applicazione può essere scaricata in una directory su una macchina locale. I repository software 
sono un metodo comodo per gestire i progetti utilizzando Git, e MX Linux mantiene la maggior parte 
del suo codice nel proprio repo GitHub.

Altro: Wikipedia: Repository di software

http://repo.vivaldi.com/stable/deb/


5.2.5 Specchi

• I repository MX Linux, sia per i pacchetti che per le ISO (file immagine), sono "mirrorati" su 
server in diversi siti nel mondo; lo stesso vale per i repository Debian. Questi siti di mirroring 
forniscono più fonti delle stesse informazioni e servono a ridurre i tempi di download, a 
migliorare l'affidabilità e a fornire una certa resilienza in caso di guasto del server. Durante 
l'installazione, il mirror più probabile viene selezionato automaticamente in base alla posizione 
e alla lingua. Ma l'utente può avere motivi per preferirne un altro:

• In alcuni casi l'assegnazione automatica al momento dell'installazione può essere errata.

• L'utente può cambiare residenza.

• Potrebbe essere disponibile un nuovo specchio molto più vicino, più veloce o più affidabile.

• Un mirror esistente può cambiare il proprio URL.

• Lo specchio utilizzato potrebbe diventare inaffidabile o andare offline.

MX Repo Manager (Sezione 3.2) semplifica il cambio di mirror, consentendo di scegliere quello più 
adatto alle proprie esigenze. Nota: prestare attenzione al pulsante che seleziona il mirror più veloce per 
la propria posizione.

5.3 Gestore di pacchetti Synaptic

La seguente sezione cerca di fornire una panoramica aggiornata sull'uso di Synaptic. Si noti che è 
richiesta la password di root e, naturalmente, è necessario essere connessi a Internet.

5.3.1 Installazione e rimozione dei pacchetti

Installazione

• Ecco i passi fondamentali per l'installazione del software in Synaptic:

• Fate clic sul menu Start > Sistema > Synaptic Package Manager, fornendo la password 
di root se richiesto.

• Premere il pulsante Ricarica. Questo pulsante indica a Synaptic di contattare i server del 
repository online e di scaricare un nuovo file di indice con informazioni su:

◦ Quali sono i pacchetti disponibili?

◦ Che versioni sono.



◦ Quali altri pacchetti sono necessari per l'installazione.

• Se viene visualizzato un messaggio che indica che alcuni repository non sono stati 
contattati, attendere un minuto e riprovare.

• Se si conosce già il nome del pacchetto che si sta cercando, basta fare clic nel riquadro a 
destra e iniziare a digitare; Synaptic effettuerà una ricerca incrementale durante la 
digitazione.

• Se non conoscete il nome del pacchetto, usate la casella di ricerca nell'angolo in alto a destra 
per trovare il software in base al nome o a parole chiave. Questo è uno dei maggiori vantaggi 
di Synaptic rispetto ad altri metodi.

• In alternativa, utilizzare uno dei pulsanti di filtro nell'angolo in basso a sinistra:

◦ Le sezioni forniscono sottoaree come Editori, Giochi e divertimenti, Utilità, ecc. Nel 
riquadro inferiore è presente una descrizione di ogni pacchetto e si possono utilizzare le 
schede per scoprire ulteriori informazioni.

◦ Status raggruppa i pacchetti in base alla loro situazione di installazione.

◦ Origin mostrerà i pacchetti di un repository specifico.

◦ Filtri personalizzati offre varie opzioni di filtro.

◦ Risultati della ricerca mostra un elenco di ricerche precedenti per la sessione di Synaptic in cui ci si 
trova.

• Fate clic sulla casella vuota all'estremità sinistra del pacchetto desiderato e selezionate Segna 
per l'installazione nella schermata a comparsa. Se il pacchetto ha delle dipendenze, ne 
riceverete notifica e anche queste verranno automaticamente contrassegnate per l'installazione. 
Potete anche fare doppio clic sul pacchetto se è l'unico che state installando.

• Alcuni pacchetti hanno anche dei pacchetti "Consigliati" e "Suggeriti" che possono essere 
visualizzati facendo clic con il tasto destro del mouse sul nome del pacchetto. Si tratta di 
pacchetti aggiuntivi che aggiungono funzionalità al pacchetto selezionato e che è bene 
consultare.

• Fare clic su Applica per avviare l'installazione. Potete tranquillamente ignorare qualsiasi 
messaggio di avviso: "Si sta per installare un software che non può essere autenticato!".

• Potrebbero esserci ulteriori passaggi: seguite le indicazioni che vi vengono fornite fino al 
completamento dell'installazione.



Figura 5-2: Controllo dei pacchetti consigliati durante l'installazione dei pacchetti.

Rimozione del software

La rimozione del software dal sistema con Synaptic sembra semplice come l'installazione, ma c'è molto 
di più di quello che si vede:

• Per rimuovere un pacchetto, è sufficiente fare clic sulla stessa casella dell'installazione e 
selezionare Segna per la rimozione o Segna per la rimozione completa.

• La rimozione disinstalla il software, ma lascia i file di configurazione del sistema nel 
caso in cui si vogliano mantenere le impostazioni.

• La Rimozione completa rimuove il software e anche i file di configurazione del 
sistema (epurazione). I file di configurazione personali relativi al pacchetto non 
verranno rimossi. Verificate anche la presenza di altri resti di file di configurazione 
nella categoria Non installato di Synaptic (configurazione residua).

• Se ci sono altri programmi che dipendono dal pacchetto che viene rimosso, anche questi 
pacchetti dovranno essere rimossi. Questo accade solitamente quando si rimuovono librerie 
software, servizi o applicazioni a riga di comando che fungono da back-end per altre 
applicazioni. Assicuratevi di leggere attentamente il riepilogo fornito da Synaptic prima di 
fare clic su OK.

• La rimozione di applicazioni di grandi dimensioni composte da molti pacchetti può 
comportare delle complicazioni. Spesso questi pacchetti vengono installati usando un meta-
pacchetto, che è un pacchetto vuoto che dipende semplicemente da tutti i pacchetti necessari 
per l'applicazione. Il modo migliore per rimuovere un pacchetto complicato come questo è 
ispezionare l'elenco delle dipendenze del meta-pacchetto e rimuovere i pacchetti elencati. 
Fate attenzione, però, a non disinstallare una dipendenza di un'altra applicazione che volete 
mantenere!



• È possibile che la categoria di stato Rimozione automatica inizi ad accumulare pacchetti. 
Questi sono stati installati da altri pacchetti e non sono più necessari, quindi si può fare clic 
su questa categoria di stato, evidenziare tutti i pacchetti nel riquadro di destra e quindi fare 
clic con il pulsante destro del mouse per rimuoverli. Assicuratevi di esaminare attentamente 
l'elenco quando appare la casella di verifica, perché a volte potreste scoprire che le 
dipendenze elencate per la rimozione includono pacchetti che in realtà volete mantenere. Se 
non si è sicuri, si può usare apt -s autoremove per fare una prova simulata (= l'opzione -s).

Figura 5-3: Preparazione per lo svuotamento delle confezioni auto-rimovibili.

5.3.2 Aggiornamento e downgrade del software

Synaptic consente di mantenere aggiornato il sistema in modo rapido e pratico.

Aggiornamento del software

• A meno che non si utilizzi un metodo manuale in Synaptic o un terminale, l'aggiornamento è 
in genere attivato da un cambiamento nell'icona di MX Updater nell'area di notifica (default: la 
casella vuota diventa verde). Ci sono due modi per procedere quando questo accade.

• Fare clic con il tasto sinistro del mouse sull'icona. Questo è il metodo più veloce perché 
non è necessario attendere il caricamento del software, l'esecuzione, ecc. Viene 
visualizzata una finestra di terminale con i pacchetti da aggiornare; esaminateli 
attentamente, quindi fate clic su OK per completare il processo.

• Fare clic con il tasto destro del mouse sull'icona per utilizzare Synaptic.

• Fate clic sull'icona Contrassegna tutti gli aggiornamenti sotto la barra dei menu per 
selezionare tutti i pacchetti disponibili per l'aggiornamento, oppure fate clic sul collegamento 
Installato (aggiornabile) nel pannello di sinistra per rivedere i pacchetti o per selezionare gli 
aggiornamenti singolarmente.

• Fare clic su Applica per iniziare l'aggiornamento, ignorando il messaggio di avvertimento. 



All'inizio del processo di installazione, è possibile osservare i dettagli in un terminale all'interno di 
Synaptic.



• Con alcuni aggiornamenti di pacchetti, potrebbe essere richiesto di confermare una finestra di 
dialogo, di inserire informazioni di configurazione o di decidere se sovrascrivere o meno un file di 
configurazione modificato. Prestate attenzione e seguite le richieste fino al completamento 
dell'aggiornamento.

Downgrade del software

A volte si può desiderare di eseguire il downgrade di un'applicazione a una versione precedente, ad 
esempio a causa di problemi sorti con quella nuova. È facile farlo con Synaptic:

1. Aprire Synaptic, fornire la password di root e fare clic su Reload.

2. Fate clic su Installato nel pannello a sinistra, quindi trovate ed evidenziate il pacchetto 
che volete declassare nel pannello a destra.

3. Nella barra dei menu, fate clic su Pacchetto > Forza versione...

4. Selezionare una delle versioni disponibili nell'elenco a discesa. Potrebbero non esserci opzioni disponibili.

5. Fare clic su Forza versione, quindi installare nel modo consueto.

6. Per evitare che la versione inferiore venga immediatamente aggiornata di nuovo, è necessario bloccarla.

Figura 5-4: Uso di Force version per eseguire il downgrade di un pacchetto.

Appuntare una versione

A volte si può desiderare di bloccare un'applicazione a una versione specifica per evitare che venga 
aggiornata e che si verifichino problemi con quelle più recenti. È facile da fare:



1. Aprire Synaptic, fornire la password di root e fare clic su Reload.

2. Fate clic su Installato nel pannello a sinistra, quindi trovate ed evidenziate il pacchetto 
che volete appuntare nel pannello a destra.

3. Nella barra dei menu, fare clic su Pacchetto > Blocca versione...

4. Synaptic evidenzierà il pacchetto in rosso e aggiungerà un'icona di blocco alla prima colonna.

5. Per sbloccare, evidenziate nuovamente il pacchetto e fate clic su Pacchetto > Blocca 
versione (che avrà un segno di spunta).

6. Si noti che il pinning tramite Synaptic non impedisce l'aggiornamento del pacchetto 
quando si usa la riga di comando.

5.4 Risoluzione dei problemi di Synaptic
Synaptic è molto affidabile, ma a volte può capitare di ricevere un messaggio di errore. Una 
trattazione completa di questi messaggi si trova nella Wiki MX/antiX, quindi in questa sede ci 
limiteremo a citare un paio dei più comuni.

• Viene visualizzato un messaggio che indica che alcuni repo non sono riusciti a scaricare le 
informazioni del repository. Di solito si tratta di un evento transitorio ed è sufficiente 
attendere e ricaricare; oppure si può usare MX Repo Manger per cambiare repository.

• Se l'installazione di un pacchetto mostra che il software che si desidera conservare verrà 
rimosso, fare clic su Annulla per annullare l'operazione.

• Può accadere che con un nuovo repository si veda un messaggio di errore dopo il 
ricaricamento che dice qualcosa come: W: Errore GPG: [URL di qualche repository] 
Release: Non è stato possibile verificare le seguenti firme. Questo messaggio appare perché 
apt include l'autenticazione dei pacchetti per migliorare la sicurezza e la chiave non è 
presente. Per risolvere il problema, fare clic sul menu Start > System
> MX Fix GPG keys e seguire le istruzioni. Se non viene trovata alcuna chiave, chiedere nel forum.

• Occasionalmente, i pacchetti non si installano perché i loro script di installazione falliscono 
uno o più controlli di sicurezza; per esempio, un pacchetto potrebbe tentare di sovrascrivere 
un file che fa parte di un altro pacchetto o richiedere il downgrade di un altro pacchetto a 
causa delle dipendenze. Se un'installazione o un aggiornamento si blocca su uno di questi 
errori, si parla di pacchetto "rotto". Per risolvere il problema, fate clic sulla voce Pacchetti 
rotti nel pannello di sinistra. Evidenziate il pacchetto e provate a risolvere il problema 
facendo clic su Modifica > Correggi pacchetti rotti. Se non si riesce a risolvere il problema, 
fate clic con il tasto destro del mouse sul pacchetto per deselezionarlo o disinstallarlo.



• Durante l'installazione o la disinstallazione, a volte appaiono messaggi importanti sul processo:

• Disinstallare? Occasionalmente, i conflitti nelle dipendenze dei pacchetti possono 
indurre il sistema APT a disinstallare un gran numero di pacchetti importanti per 
installarne altri. Questo è raro con la configurazione predefinita, ma diventa sempre 
più probabile con l'aggiunta di repo non supportati. Fate MOLTA ATTENZIONE 
quando l'installazione di un pacchetto richiede la rimozione di altri! Se un gran 
numero di pacchetti deve essere rimosso, si consiglia di studiare un altro metodo di 
installazione di questa applicazione.

• Mantenere? Durante l'aggiornamento, a volte si viene informati che è disponibile 
un nuovo file di configurazione per un certo pacchetto e viene chiesto se si vuole 
installare la nuova versione o mantenere quella attuale.

• Se il pacchetto in questione proviene da un repository MX, si 
raccomanda di "installare la versione dei manutentori".

• Altrimenti, rispondere "mantenere la versione attuale" (N), che è anche la 
scelta predefinita.

5.5 Altri metodi

5.5.1 Attitudine

Aptitude è un gestore di pacchetti che può essere usato al posto di apt o Synaptic. È disponibile nei 
repo ed è particolarmente utile quando si presentano problemi di dipendenza. Può essere eseguito 
come CLI o GUI.

Figura 5-5: Schermata iniziale di Aptitude (GUI), che mostra il risolutore di dipendenze.



Per maggiori dettagli su questa opzione, consultare il Wiki MX/antiX.

5.5.2 Pacchetti Deb

I pacchetti software installati tramite Synaptic (e APT dietro di esso) sono in un formato chiamato Deb 
(abbreviazione di Debian, la distribuzione Linux che ha ideato APT). È possibile installare 
manualmente i pacchetti Deb scaricati utilizzando lo strumento grafico Deb Installer (sezione 3.2.28) o 
lo strumento a riga di comando dpkg.
Si tratta di semplici strumenti per installare pacchetti deb locali.

NOTA: se le dipendenze non possono essere soddisfatte, si riceverà un avviso e il programma si fermerà.

Installazione di file *.deb con dpkg

1. Navigare nella cartella contenente il pacchetto deb che si desidera installare.

2. Fare clic con il tasto destro del mouse su uno spazio vuoto per aprire un terminale e 
diventare root. In alternativa, fare clic sulla freccia per salire di un livello e fare clic con 
il pulsante destro del mouse sulla cartella con il pacchetto deb > Aprire root Thunar qui.

3. Installate il pacchetto con il comando (sostituendo ovviamente il nome reale del pacchetto):

dpkg -i packagename.deb

4. Se si installano più pacchetti contemporaneamente nella stessa directory (ad esempio se si 
installa manualmente Libreoffice), si può fare tutto in una volta usando:

dpkg -i *.deb

NOTA: In un comando di shell, l'asterisco è un carattere jolly nell'argomento. In questo caso, il 
programma applicherà il comando a qualsiasi file il cui nome finisca con .deb.

5. Se le dipendenze necessarie non sono già installate sul sistema, si otterranno errori di 
dipendenze non soddisfatte, poiché dpkg non se ne occupa automaticamente. Per correggere 
questi errori e terminare l'installazione, eseguire questo codice per forzare l'installazione:

apt -f installare

6. apt cercherà di correggere la situazione installando le dipendenze necessarie (se sono 
disponibili nei repo) o rimuovendo i file .deb (se le dipendenze non possono essere 
installate).

NOTA: il comando utilizzato al punto 5 riflette il cambiamento del nome legacy apt-
ottenere.



5.5.3 Pacchetti autonomi

VIDEO: Lanciatori e Appimages

Appimages, Flatpaks e Snaps sono pacchetti autonomi che non hanno bisogno di essere 
installati nel senso usuale del termine. Si tenga presente che questi pacchetti non sono stati 
testati da Debian o MX Linux, quindi potrebbero non funzionare come previsto.

1. Appimages: è sufficiente scaricarle, spostarle in /opt (consigliato) e renderle eseguibili con 
un clic destro > Permessi.

2. Flatpaks: utilizzare Package Installer per ottenere le applicazioni da Flathub.

3. Snaps. Inaffidabile su MX Linux, a meno che l'utente non abbia avviato systemd. La 
soluzione e i dettagli sono riportati nel riferimento Wiki qui sotto.

Uno dei grandi vantaggi dei pacchetti autocontenuti è che qualsiasi software aggiuntivo di cui hanno 
bisogno è incluso e quindi non avrà un impatto negativo sul software già installato. Questo li rende 
anche molto più grandi dei tradizionali pacchetti installati.

AIUTO: la Wiki MX/antiX

5.5.4 Metodi CLI

È ugualmente possibile usare la riga di comando per installare, rimuovere, aggiornare, cambiare 
repository e in generale per gestire i pacchetti. Invece di lanciare Synaptic per eseguire operazioni 
comuni.

Tabella 5: Comandi comuni per la gestione dei pacchetti.

Comando Azione

apt install packagename Installare un determinato pacchetto

apt rimuove il nome del 
pacchetto

Rimuovere un determinato pacchetto

apt purge packagename Rimuove completamente un pacchetto (ma non la 
configurazione/dati in

/home)

https://snapcraft.io/


apt autoremove Sgomberare i pacchi rimasti dopo un trasloco

aggiornamento apt Aggiornare l'elenco dei pacchetti dai repo

aggiornamento apt Installare tutti gli aggiornamenti disponibili

apt dist-upgrade Gestire in modo intelligente la modifica delle dipendenze con le 
nuove versioni dei pacchetti

I processi e i risultati di Apt vengono visualizzati in un terminale utilizzando la visualizzazione 
predefinita, che molti utenti trovano poco attraente e difficile da leggere. Esiste un formato di 
visualizzazione alternativo, chiamato nala, che è installato per impostazione predefinita, anche se non 
viene utilizzato di default a causa di rari bug che si sono verificati durante i test. Tuttavia, i colori e 
l'organizzazione rendono l'alternativa molto facile da usare e molti la preferiscono. Per attivarlo, 
aprire il file
~/.config/MX-Linux/apt-notifier.conf, cercare "nala" e rimuovere il segno di hash all'inizio della riga in 
modo da ottenere il risultato:

use_nala = true

5.5.5 Altri metodi di installazione

• Prima o poi alcuni software che si desidera installare non saranno disponibili nei repo e 
potrebbe essere necessario utilizzare altri metodi di installazione. Questi metodi 
includono:

• Blob. A volte ciò che si desidera non è un pacchetto installabile, ma un "blob" o una raccolta 
precompilata di dati binari memorizzati come un'unica entità, soprattutto se si tratta di risorse 
chiuse. Tali blob si trovano in genere nella directory /opt. Esempi comuni sono Firefox, 
Thunderbird e LibreOffice. Pacchetti RPM: Alcune distribuzioni di Linux utilizzano il 
sistema di pacchetti RPM. I pacchetti RPM sono simili ai pacchetti deb sotto molti aspetti ed 
esiste un programma a riga di comando disponibile da MX Linux per convertire i pacchetti 
RPM in deb, chiamato alien. Non viene installato con MX Linux, ma è disponibile nei repo 
predefiniti. Dopo averlo installato sul vostro sistema, potete usarlo per installare un pacchetto 
rpm con questo comando (come root): alien -i packagename.rpm. In questo modo verrà 
inserito un file deb con lo stesso nome nella posizione del file rpm, che si potrà poi installare 
come descritto sopra. Per informazioni più dettagliate su alien, consultare la versione Internet 
della sua pagina man nella sezione Link in fondo a questa pagina.

• Codice sorgente: Qualsiasi programma open-source può essere compilato dal codice 
sorgente originale del programmatore, se non c'è altra possibilità. In circostanze ideali, si 
tratta di un'operazione piuttosto semplice, ma a volte si può incorrere in errori che richiedono 
maggiore abilità per essere risolti. I sorgenti sono solitamente distribuiti come tarball (file 
tar.gz o tar.bz2). La soluzione migliore è di solito quella di fare una richiesta di pacchetti sul 



forum, ma si veda la sezione Collegamenti per un tutorial sulla compilazione dei programmi.

• Varie: Molti sviluppatori di software confezionano il software in modo personalizzato, di 
solito distribuito come tarball o file zip. Possono contenere script di installazione, file 
binari pronti per l'esecuzione o programmi di installazione binari simili ai programmi 
setup.exe di Windows. In Linux, il file



Il programma di installazione spesso termina con .bin. Google Earth, ad esempio, viene 
spesso distribuito in questo modo. In caso di dubbio, consultare le istruzioni di installazione 
fornite con il software.

5.5.6 Collegamenti

Wiki MX/antiX: Errori sinaptici

Wiki MX/antiX: Installazione del software

Wiki MX/antiX: Compilazione

Strumenti di gestione dei pacchetti Debian

Guida Debian 

APT Wikipedia: 

Alieno



6.1 Programmi Windows sotto MX Linux

Esiste un certo numero di applicazioni, sia open-source che commerciali, che consentono di eseguire le 
applicazioni Windows su MX Linux. Si tratta di emulatori, che replicano le funzioni di Windows su 
una piattaforma Linux. Molte applicazioni MS Office, giochi e altri programmi possono essere eseguiti 
con un emulatore con vari gradi di successo che vanno dalla velocità e funzionalità quasi nativa alle 
prestazioni di base.

6.1.1 Open-source

Wine è il principale emulatore open-source di Windows per MX Linux. È una sorta di livello di 
compatibilità per l'esecuzione di programmi Windows, ma non richiede Microsoft Windows per 
eseguire le applicazioni. È meglio installarlo tramite MX Package Installer (sotto Misc); se si installa 
con Synaptic, selezionare "winehq- staging" per ottenere tutti i pacchetti wine-staging. Le versioni di 
Wine vengono rapidamente impacchettate dai membri del Community Repository e rese disponibili 
agli utenti; l'ultima versione proviene dall'MX Test Repo.

NOTA: Per eseguire Wine in una sessione Live, è necessario utilizzare la persistenza domestica (Sezione 6.6.3).

• Home page del vino

• Wiki MX/antiX: Vino

DOSBox crea un ambiente simile al DOS per l'esecuzione di programmi basati su MS-DOS, in 
particolare giochi per computer.

• DOSBox homepage

• Wiki DOSBox

DOSEMU è un software disponibile nei repo che permette di avviare il DOS in una macchina 
virtuale, rendendo possibile l'esecuzione di Windows 3.1, Word Perfect per DOS, DOOM, ecc.

• Pagina iniziale di DOSEMU

• Wiki MX/antiX: DOSEMU

6Uso avanzato

https://wine-staging.com/
http://www.winehq.org/
https://mxlinux.org/wiki/system/wine
http://dosbox.sourceforge.net/
http://dosbox.sourceforge.net/wiki
http://www.dosemu.org/
https://mxlinux.org/wiki/system/dosemu


Figura 6-1: Photoshop 5.5 in esecuzione sotto Wine.

6.1.2 Commerciale

CrossOver Office consente di installare molte applicazioni di produttività, plugin e giochi Windows in 
Linux, senza bisogno di una licenza del sistema operativo Microsoft. Supporta particolarmente bene 
Microsoft Word, Excel e PowerPoint (fino al 2003).

• Pagina iniziale di CrossOver Linux

• Wikipedia: Crossover

• Compatibilità delle applicazioni

Collegamenti

• Wikipedia: Emulatore

• Emulatori DOS

6.2 Macchine virtuali

Le applicazioni per macchine virtuali sono una classe di programmi che simulano un computer virtuale 
in memoria, permettendo di eseguire qualsiasi sistema operativo sulla macchina. È utile per effettuare 
test, eseguire applicazioni non native e dare agli utenti la sensazione di avere una macchina propria. 
Molti utenti di MX Linux utilizzano il software della macchina virtuale per eseguire Microsoft 
Windows "in una finestra", in modo da poter accedere senza problemi al software scritto per Windows 
sul proprio desktop. Viene utilizzato anche per i test, per evitare l'installazione.

http://www.codeweavers.com/products/cxoffice
http://en.wikipedia.org/wiki/CrossOver
http://www.codeweavers.com/compatibility/browse/rank
http://en.wikipedia.org/wiki/Emulator
https://en.wikipedia.org/wiki/DOSEMU


6.2.1 Configurazione di VirtualBox

 VIDEO: Virtual Box: impostare una cartella condivisa (14.4)

Esistono numerose applicazioni software per macchine virtuali per Linux, sia open-source che 
proprietarie. MX rende particolarmente facile l'uso di VirtualBox (VB), per cui ci concentreremo su di 
esso. Per i dettagli e gli sviluppi più recenti, vedere la sezione Link qui sotto. Ecco una panoramica dei 
passi fondamentali per configurare ed eseguire VirtualBox:

• Installazione. È preferibile farlo tramite il programma di installazione dei pacchetti MX, 
dove VB appare nella sezione Misc. In questo modo si abilita il repository VB, si scarica e si 
installa l'ultima versione di VB. Il repository rimarrà abilitato, consentendo gli aggiornamenti 
automatici tramite MX Updater.

• 64 bit. Per eseguire un guest a 64 bit, VB richiede il supporto della virtualizzazione hardware, 
le cui impostazioni (se esistono) si trovano nel firmware/BIOS UEFI. I dettagli sono riportati 
nel manuale di VB.

• Riavviare. È buona norma lasciare che VB si configuri completamente riavviando dopo l'installazione.

• Post-installazione. Verificare che l'utente appartenga al gruppo vboxusers. Aprite MX User 
Manager > scheda Group Membership. Selezionate il vostro nome utente e assicuratevi che 
'vboxusers' nell'elenco dei gruppi sia spuntato. Confermare e uscire.

• Pacchetto estensioni. Se si installa VB dal programma di installazione dei pacchetti MX, 
l'Extension Pack sarà incluso automaticamente. Altrimenti, è necessario scaricarlo e installarlo 
dal sito web di Oracle (vedere Collegamenti). Dopo aver scaricato il file, è necessario navigare 
verso di esso con Thunar e fare clic sull'icona del file. L'Extension Pack aprirà VB e si 
installerà automaticamente.

• Posizione. I file delle macchine virtuali sono memorizzati per impostazione predefinita nella 
cartella /home/VirtualBox VMs. Possono essere piuttosto grandi e se si dispone di una 
partizione dati separata, si può considerare di creare la cartella predefinita lì. Andare su File > 
Preferenze > scheda Generale e modificare la posizione della cartella.

https://www.youtube.com/watch?v=adpalUl4LqI
https://www.virtualbox.org/wiki/VirtualBox
https://www.virtualbox.org/manual/ch03.html#intro-64bitguests


Figura 6-2: Windows 2000 in esecuzione in VirtualBox.

6.2.2 Utilizzo di VirtualBox

• Creare una macchina virtuale. Per creare una macchina virtuale, avviare VB e fare clic 
sull'icona Nuovo nella barra degli strumenti. È necessario un CD di Windows o una ISO di 
Linux (solo a 32 bit). Seguite la procedura guidata, accettando tutte le impostazioni suggerite, a 
meno che non sappiate che è sempre possibile modificarle in seguito. Se la vostra ISO ha il 
PAE, fate clic sulla scheda Sistema > Opzioni e abilitatelo. Potrebbe essere necessario 
aumentare la memoria allocata al Guest oltre il valore minimo predefinito, lasciando comunque 
una quantità di memoria sufficiente per il sistema operativo Host. Per i Guest Windows, 
considerate la possibilità di creare un HD virtuale più grande di quello predefinito da 10 GB; 
anche se è possibile aumentare le dimensioni in un secondo momento, non è una procedura 
semplice. Per Windows 10 o 11 sono necessari 60 Gb. Selezionare un'unità host o un file disco 
CD/DVD virtuale

• Selezionare un punto di montaggio. Una volta configurata la macchina, è possibile 
selezionare il punto di montaggio come unità host o come file disco CD/DVD virtuale (ISO). 
Fare clic su Impostazioni > Archiviazione e si aprirà una finestra di dialogo in cui si vedrà al 
centro una struttura di archiviazione con un controller IDE e un controller SATA sotto di esso. 
Facendo clic sull'icona dell'unità CD/DVD nella struttura di memorizzazione, si vedrà apparire 
l'icona dell'unità CD/DVD nella sezione Attributi sul lato destro della finestra. Facendo clic 
sull'icona dell'unità CD/DVD nella sezione Attributi, si apre un menu a discesa in cui è 
possibile assegnare l'unità host o un file di disco CD/DVD virtuale (ISO) da montare sull'unità 
CD/DVD. (È possibile selezionare un file ISO diverso facendo clic su Scegli un file disco 
CD/DVD virtuale e navigando fino al file). Eseguire la macchina. Il dispositivo selezionato 
(ISO o CD/DVD) verrà montato all'avvio della macchina virtuale e il sistema operativo potrà 
essere installato.

• GuestAdditions. Una volta installato il sistema operativo guest, assicurarsi di installare VB 
GuestAdditions avviando il sistema operativo guest, quindi fare clic su Dispositivi > Inserisci 



GuestAdditions e puntare verso la ISO che verrà individuata automaticamente. In questo modo 
è possibile abilitare la condivisione di file tra Guest e Host e regolare la visualizzazione in vari 
modi per adattarla all'ambiente e alle esigenze del cliente.



abitudini. Se l'applicazione non è in grado di localizzarla, potrebbe essere necessario installare 
il pacchetto virtualbox-guest- additions (fatto automaticamente se si è usato Package 
Installer).

• Spostamento. Il modo più sicuro per spostare o modificare le impostazioni di una macchina 
virtuale esistente è clonarla: fare clic con il tasto destro del mouse sul nome di una macchina 
esistente > Clona e compilare le informazioni. Per utilizzare il nuovo clone, creare una nuova 
macchina virtuale e nella procedura guidata, quando si seleziona il disco rigido, scegliere "Usa 
il disco rigido esistente" e selezionare il file *.vdi del nuovo clone.

• Documentazione. La documentazione dettagliata di VB è disponibile attraverso la Guida 
nella barra dei menu o in formato PDF dal sito web.

Figura 6-3: Schermata delle impostazioni in VirtualBox (MX-19.1).

Collegamenti

• Wikipedia: Macchina virtuale

• Wikipedia: Confronto tra software per macchine virtuali

• Pagina iniziale di VirtualBox

• Pacchetto di estensioni per VirtualBox

http://en.wikipedia.org/wiki/Virtual_machine
http://en.wikipedia.org/wiki/Comparison_of_platform_virtualization_software
http://www.virtualbox.org/
http://www.virtualbox.org/wiki/Downloads


6.3 Gestori di finestre alternativi

Figura 6-4: MATE in esecuzione su MX-15 Linux, con il browser YouTube aperto.

Un window manager (originariamente WIMP: Window, Icon, Menu, and Pointing device) in 
Linux è essenzialmente il componente che controlla l'aspetto delle interfacce grafiche (GUI) e 
fornisce i mezzi con cui l'utente può interagire con esse.

Le tre versioni di MX Linux utilizzano Xfce, KDE o Fluxbox per definizione. Ma per gli utenti 
esistono altre possibilità. MX Linux semplifica l'installazione di molte alternative popolari attraverso 
l'MX Package Installer, come descritto di seguito.

• Budgie Desktop, un desktop semplice ed elegante che utilizza GTK+.

• Budgie Desktop

• Compiz, un WM OpenGL con compositing.

• Gestore di finestre Compix

• Gnome Base, un display manager e un desktop basato su GTK+ che fornisce un ambiente 
desktop ultraleggero.

• Gnome Ultra (GOULD), un ambiente desktop ultraleggero

• LXDE è un ambiente desktop veloce e leggero i cui componenti possono essere installati separatamente.

• Pagina iniziale di LXDE

http://en.wikipedia.org/wiki/Window_manager
https://en.wikipedia.org/wiki/Budgie_(desktop_environment)
https://en.wikipedia.org/wiki/Compiz
http://sourceforge.net/projects/gould
http://lxde.org/


• MATE è la continuazione di GNOME 2 e offre un ambiente desktop intuitivo e 
attraente.

• Pagina iniziale di MATE

• IceWM è un ambiente desktop all-in-one molto leggero e un gestore di finestre impilabili.

• Pagina iniziale di IceWM

Una volta installato, è possibile scegliere il gestore di finestre desiderato dal pulsante Sessione al centro 
della barra superiore della schermata di accesso predefinita; accedere come si farebbe normalmente. Se 
si sostituisce il gestore di accesso con un altro dai repo, assicurarsi di averne sempre almeno uno 
disponibile al riavvio.

ALTRO: Wikipedia: Gestori di finestre X

6.4 Linea di comando

Sebbene MX offra una serie completa di strumenti grafici per l'installazione, la configurazione e 
l'utilizzo del sistema, la riga di comando (chiamata anche console, terminale, BASH o shell) è 
ancora uno strumento utile e talvolta indispensabile. Ecco alcuni usi comuni:

• Avviare un'applicazione GUI per vedere l'output degli errori.

• Velocizzare le attività di amministrazione del sistema.

• Configurare o installare applicazioni software avanzate.

• Eseguire più attività in modo rapido e semplice.

• Risoluzione dei problemi dei dispositivi hardware.

Il programma predefinito per eseguire un terminale in una finestra del desktop MX è XFCE Terminal; 
quello di KDE è Konsole. Alcuni comandi sono riconosciuti solo dal superutente (root), mentre altri 
possono variare l'output a seconda dell'utente.

Per ottenere i permessi temporanei di root, utilizzare uno dei metodi descritti nella Sezione 4.7.1. Per 
riconoscere quando il Terminale è in esecuzione con i privilegi di root, osservate la riga del prompt 
subito prima dello spazio in cui digitate. Invece di un $, si vedrà un #; inoltre, il nome utente cambia 
in root e può essere scritto in rosso.

NOTA: se si tenta di eseguire come utente normale un comando che richiede i privilegi di root, come 
iwconfig, è possibile che venga visualizzato un messaggio di errore che indica che il comando non è 
stato trovato, che venga visualizzata una casella di messaggio che indica che il programma deve essere 
eseguito come root o che semplicemente ci si ritrovi di nuovo al prompt senza alcun messaggio.

http://mate-desktop.org/
https://ice-wm.org/
http://en.wikipedia.org/wiki/Comparison_of_X_Window_System_desktop_environments


Figura 6-5: L'utente ha ora privilegi amministrativi (root).

6.4.1 Primi passi

• Per ulteriori informazioni sull'uso del terminale per risolvere i problemi del sistema, 
consultare l'argomento Risoluzione dei problemi alla fine di questa sezione. Inoltre, è 
consigliabile eseguire backup dei file su cui si sta lavorando come utente root con i comandi 
cp e mv (vedere sotto).

• Anche se i comandi del terminale possono essere piuttosto complessi, la comprensione della 
riga di comando è solo una questione di mettere insieme cose semplici. Per vedere quanto può 
essere facile, aprite un terminale e provate alcuni comandi di base. Tutto questo avrà più senso 
se lo farete come esercizio di esercitazione piuttosto che come semplice lettura. Cominciamo 
con un comando semplice: ls, che elenca il contenuto di una directory. Il comando di base 
elenca il contenuto della directory in cui ci si trova:

ls

• È un comando utile, ma si tratta solo di alcune brevi colonne di nomi stampati sullo schermo. 
Supponiamo di volere più informazioni sui file di questa directory. Possiamo aggiungere uno 
switch al comando per far sì che stampi più informazioni. Uno switch è un modificatore che 
si aggiunge a un comando per cambiarne il comportamento. In questo caso, il comando 
desiderato è:

ls -l

• Come potete vedere sul vostro schermo se state seguendo, questo interruttore fornisce 
informazioni più dettagliate (soprattutto sui permessi) sui file di qualsiasi directory.

• Naturalmente, potremmo voler vedere il contenuto di un'altra directory (senza andarci prima). 
Per farlo, aggiungiamo un argomento al comando, specificando il file che vogliamo 
esaminare. Un argomento è un valore o un riferimento che aggiungiamo a un comando per 
indirizzarne il funzionamento. Ad esempio, fornendo come argomento /usr/bin/, possiamo 
elencare il contenuto di quella directory anziché di quella in cui ci troviamo attualmente.



ls -l /usr/bin

• Ci sono molti file in /usr/bin/! Sarebbe bello poter filtrare questo output in modo da elencare 
solo le voci che contengono, per esempio, la parola "fire". È possibile farlo inviando l'output 
del comando ls a un altro comando, grep. Il carattere pipe, o │, viene utilizzato per inviare 
l'output di un comando all'input di un altro. Il comando grep cerca lo schema che gli viene 
fornito e restituisce tutte le corrispondenze, quindi il piping dell'output del comando precedente 
filtra l'output.

ls -l /usr/bin | grep fire

• Infine, supponiamo di voler salvare questi risultati in un file di testo da utilizzare in un 
secondo momento. Quando si impartiscono dei comandi, l'output viene solitamente indirizzato 
al display della console; ma è possibile reindirizzare questo output da qualche altra parte, ad 
esempio in un file, usando il simbolo > (redirect) per istruire il computer a fare un elenco 
dettagliato di tutti i file che contengono la parola "fuoco" in una particolare directory (per 
impostazione predefinita la directory Home) e a creare un file di testo contenente tale elenco, 
in questo caso chiamato "FilesOfFire".

ls -l /usr/bin | grep fire > FilesOfFire.txt

• Come si può vedere, la riga di comando può essere utilizzata per eseguire operazioni 
complesse in modo molto semplice, combinando semplici comandi in modi diversi.

6.4.2 Comandi comuni

Navigazione nel filesystem

Tabella 6: Comandi di navigazione del filesystem.

Comando Commento
cd /usr/share Cambia la directory corrente nel percorso indicato: "/usr/share". Senza 

argomenti, cd
porta alla propria home directory.

pwd Stampa il percorso della directory di lavoro corrente
ls Elenca il contenuto della directory corrente. Utilizzare l'opzione -a per mostrare 

anche i file nascosti e l'opzione -l per mostrare i dettagli di tutti i file. Spesso 
viene combinato con altri termini: lsusb elenca tutti i dispositivi usb, lsmod tutti 

i moduli, ecc.

Gestione dei file

Tabella 7: Comandi di gestione dei file.

Comando Commento
cp <file sorgente>

<file di 
destinazione>

Copia un file in un altro nome di file o in un'altra posizione. 
Utilizzare l'opzione -R ("ricorsivo") per copiare intere 
directory.



mv <file sorgente>
<file di 
destinazione>

Sposta un file o una directory da una posizione a un'altra. Si usa anche per 
rinominare file o directory e per fare un backup: per esempio, prima di 
modificare un file critico come xorg.conf si può usare questo comando 

per spostarlo in qualcosa come xorg.conf_bak.
rm <qualche 

file>
Cancellare un file. Usate l'opzione -R per cancellare una directory e 

l'opzione -f per cancellare un file.
("forza") se non si vuole che venga richiesta la conferma di ogni 

eliminazione.
cat somefile.txt Stampa il contenuto di un file sullo schermo. Da utilizzare solo per i file 

di testo.
grep Trova una determinata stringa di caratteri in un determinato pezzo di testo 

e stampa l'intera riga in cui si trova. Di solito si usa con una pipe, ad 
esempio cat somefile.txt Ⅰ grep

/somestring/ visualizzerà la riga di somefile.txt che contiene 
somestring. Per trovare una scheda usb di rete, ad esempio, si può 
digitare: lsusb | grep -i Network. Il comando grep è sensibile alle 

maiuscole e alle minuscole per impostazione predefinita, quindi l'uso 
dell'opzione -i lo rende insensibile alle maiuscole e alle minuscole.

dd Copia qualsiasi cosa bit per bit, quindi può essere usato per directory, 
partizioni e intere unità. La sintassi di base è dd if=<qualche file> 
of=<qualche altro file>

Simboli

Tabella 8: Simboli.

Comando Commento
| Simbolo di pipe utilizzato per inviare l'output di un comando all'input di un altro.

Alcune tastiere mostrano invece due brevi barre verticali
> Il simbolo di reindirizzamento, utilizzato per inviare l'output di un comando in un 

file di un dispositivo. Il raddoppio del simbolo di reindirizzamento fa sì che 
l'output di un comando venga aggiunto a un file esistente, anziché sostituirlo.

& L'aggiunta dell'ampersand alla fine di un comando (con uno spazio prima) ne 
determina l'esecuzione in background, in modo da non dover attendere il 

completamento del comando per impartire il comando successivo. Il doppio punto 
indica che il secondo comando deve essere eseguito solo se il primo ha avuto 

successo.

Risoluzione dei problemi

Per la maggior parte dei nuovi utenti di Linux, la riga di comando viene utilizzata principalmente come 
strumento di risoluzione dei problemi. I comandi del terminale forniscono informazioni rapide e 
dettagliate che possono essere facilmente incollate in un post di un forum, in una casella di ricerca o in 
un'e-mail quando si cerca aiuto sul web. Si raccomanda vivamente di tenere queste informazioni a 
portata di mano quando si chiede aiuto. La possibilità di fare riferimento alla propria configurazione 
hardware specifica non solo velocizzerà il processo di ricerca di aiuto, ma consentirà agli altri di offrire 



soluzioni più accurate. Ecco alcuni comandi comuni per la risoluzione dei problemi (vedere anche la 
Sezione 3.4.4). Alcuni di essi potrebbero non fornire informazioni o fornirne di meno se non si è 
connessi come root.

Tabella 9: Comandi per la risoluzione dei problemi.

Comando Commento
lspci Mostra un rapido riepilogo dei dispositivi hardware interni rilevati. Se un 

dispositivo viene visualizzato come
/unknown/, di solito si tratta di un problema di driver. L'opzione -v consente di 

visualizzare informazioni più dettagliate.
lsusb Elenca i dispositivi USB collegati.

dmesg Mostra il registro di sistema per la sessione corrente (cioè dall'ultimo avvio). 
L'output è piuttosto lungo e di solito viene passato attraverso grep, less (simile a 
most) o tail.
(per vedere cosa è successo di recente). Ad esempio, per trovare potenziali errori 

relativi all'hardware di rete, provare dmesg | grep -i net.
top Fornisce un elenco in tempo reale dei processi in esecuzione e varie statistiche su di 

essi. È disponibile anche come Htop insieme a una bella versione grafica di 
Task Manager.

Accesso alla documentazione dei comandi.

• Molti comandi stampano un semplice messaggio di "informazioni sull'uso" quando si usa l'opzione --help
o -h. Questo può essere utile per ricordare rapidamente la sintassi di un comando. Ad 

esempio:
cp --help

• Per informazioni più dettagliate sull'uso di un comando, consultare la pagina man del comando 
stesso. Per impostazione predefinita, le pagine man vengono visualizzate nel less pager del 
terminale, il che significa che viene visualizzata solo una schermata del file alla volta. Tenete a 
mente questi trucchi per navigare nella schermata risultante:

• La barra spaziatrice (o il tasto PageDown) fa avanzare la schermata.

• La lettera b (o tasto PageUp) sposta lo schermo all'indietro.

• La lettera q chiude il documento di aiuto.

Alias

È possibile creare un alias (nome di comando personale) per qualsiasi comando, breve o lungo, che si 
desidera; è più facile farlo con lo strumento MX Bash Config. I dettagli nel Wiki MX/antiX.

6.4.3 Collegamenti

http://mxlinux.org/wiki/system/alias


• Guida per i principianti di BASH

• Nozioni di base della riga di comando

6.5 Script

Uno script è un semplice file di testo che può essere scritto direttamente da una tastiera e consiste in 
una serie logicamente sequenziata di comandi del sistema operativo. I comandi vengono gestiti uno alla 
volta da un interprete di comandi che a sua volta richiede servizi al sistema operativo. L'interprete di 
comandi predefinito in MX Linux è Bash. I comandi devono essere comprensibili per Bash e sono stati 
creati degli elenchi di comandi per la programmazione. Uno script di shell è la controparte Linux dei 
programmi batch nel mondo Windows.

http://tldp.org/LDP/Bash-Beginners-Guide/html/index.html
http://www.linuxcommand.org/


Gli script sono utilizzati in tutto il sistema operativo Linux e nelle applicazioni che vi girano come 
metodo economico per eseguire più comandi in modo semplice da creare e modificare. Durante 
l'avvio, ad esempio, molti script vengono invocati per avviare processi specifici come la stampa, la 
rete, ecc. Gli script vengono utilizzati anche per i processi automatizzati, l'amministrazione del 
sistema, le estensioni delle applicazioni, i controlli degli utenti, ecc. Infine, gli utenti di ogni tipo 
possono utilizzare gli script per i propri scopi.

6.5.1 Un semplice script

Eseguiamo uno script molto semplice (e famoso) per ottenere l'idea di base.

1. Aprire l'editor di testo (Menu Start > Accessori) e digitare:

#!/bin/bash 
clear
eco Buongiorno, mondo!

2. Salvate il file nella vostra home directory con il nome SimpleScript.sh

3. Fare clic con il pulsante destro del mouse sul nome del file, selezionare Proprietà e 
selezionare "Consenti l'esecuzione di questo file come programma" nella scheda 
Autorizzazioni.

4. Aprite un terminale e digitate:

sh /home/<username>/SimpleScript.sh

5. Sullo schermo apparirà la riga "Good morning, world!". Questo semplice script non fa molto, 
ma stabilisce il principio che un semplice file di testo può essere usato per inviare comandi per 
controllare il comportamento del sistema.

NOTA: Tutti gli script si aprono con uno shebang come all'inizio della prima riga: si tratta di una 
combinazione di un segno di hash (#), un punto esclamativo e il percorso dell'interprete dei comandi. 
In questo caso, l'interprete è Bash e si trova nella posizione standard per le applicazioni utente.

6.5.2 Uno script utile

Vediamo uno script utile per l'utente comune che riduce tutte le operazioni di backup di più 
gruppi di file in un'unica pressione di tasti. Lo script sottostante si basa su uno script di sistema 
chiamato rdiff-backup, che deve essere installato dai repo per funzionare. Copia una directory in 
un'altra, mantenendo una registrazione delle differenze in una speciale sottodirectory, in modo da 
poter recuperare i file persi tempo fa (per inciso, rdiff-backup si basa a sua volta su uno script 
chiamato diff).

In questo esempio, un utente chiamato "newbie" vuole impostare uno script per eseguire il backup di 
documenti, musica, posta e immagini dalla directory /home a un'unità esterna.

1 #!/bin/bash
2 #
3 # Questo script Rdiff-Backup esegue il backup su un secondo disco rigido

https://en.wikipedia.org/wiki/Shebang_(Unix)


4 # Deve essere eseguito come root per poter montare il secondo disco rigido



5
6 # Per ripristinare i file, eseguire il comando: cp -a /mnt/sda1/username /home
7 # Per ripristinare, ma non sovrascrivere:
8 # cp -a -i \SpecialChar nobreakdash\SpecialChar nobreakdash "reply=no
/mnt/sda1/username /home 
9
10 # Montare i dispositivi 
esterni 11
12 montare /dev/sdb1
13 montare /dev/sdb2
14 montare /dev/sdb3
15
16 # Eseguire il backup 
17
18 rdiff-backup /home/newbie/Documents /mnt/sdb2/Documents
19 rdiff-backup /home/newbie/Music /mnt/sdb1/Music
20 rdiff-backup /home/newbie/Mail /mnt/sdb2/Mail
21 rdiff-backup /home/newbie/Pictures /mnt/sdb3/Pictures 
22
23 # Smontare i dispositivi 
esterni 24
25 umount /dev/sdb1
26 umount /dev/sdb2
27 umount /dev/sdb3

Vediamo ora i componenti di questo script:

• Righe 2-8: davanti a queste righe è stato posto un segno di hash o di numero (chiamato 
"commentarle") per indicare a Bash che non fanno parte della sequenza di comandi da 
eseguire. Il loro scopo è quello di fornire a chiunque guardi questo script informazioni 
sull'origine, il creatore, lo scopo e la licenza dello script (metadati).

• Riga 10: i buoni script separano i comandi in sezioni procedurali chiaramente etichettate, 
anche nelle righe 16 e 22.

• Linee 12-14: i tre dispositivi da utilizzare per il backup devono essere montati in modo da 
essere disponibili per il sistema.

• Righe 18-21: qui si dice a bash di usare lo script di sistema rdiff-backup per confrontare le 
directory originali (sorgenti) con quelle di backup (destinazioni), copiare le differenze che trova 
e tenere un registro delle modifiche.

• Linee 25-27: una volta terminato il lavoro di backup, le unità esterne vengono smontate dal sistema.

Chiunque volesse utilizzare uno script di questo tipo dovrebbe eseguire alcuni passaggi di esecuzione:

1. Copiare l'intero script.

2. Fare clic con il tasto destro del mouse sul desktop e selezionare Crea nuovo > File di testo...



3. Date al file un nome che abbia senso (senza spazi, però) e aggiungete l'estensione "sh" in 
modo da riconoscere che si tratta di uno script. Per questo esempio, si potrebbe scegliere 
Backup_DocsMusicMailPictures.sh

4. Aprite il nuovo file di testo e incollate lo script.

5. Modificare i nomi, le posizioni e così via in base al sistema in uso. Nell'esempio precedente, è 
possibile che le directory di cui eseguire il backup abbiano nomi e/o posizioni diverse e che i 
dispositivi in cui devono essere archiviate siano diversi.

6. Salvate lo script in un luogo in cui sia possibile trovarlo facilmente quando ne avete 
bisogno; ad esempio, create una nuova cartella nella vostra home chiamata "scripts".

7. Fare clic con il pulsante destro del mouse sullo script, selezionare Proprietà, fare clic 
sulla scheda Autorizzazioni, selezionare la casella È eseguibile o Consenti l'esecuzione 
di questo file come programma e fare clic su OK.

8. Quando si è pronti per il backup, aprire un terminale e digitare:

sh /home/scripts/Backup_DocsMusicMailPictures.sh

SUGGERIMENTO: utilizzare il tasto tabulazione per completare automaticamente il nome del file dopo 
aver digitato le prime lettere.

Collegamenti

• Guida per principianti a Bash

• Esercitazione di scripting di shell per Linux

• Comandi Linux

6.5.3 Tipi di script speciali

Alcuni script richiedono un software speciale (linguaggio di scripting) per essere eseguiti, invece di 
essere semplicemente lanciati in Bash. I più comuni per gli utenti abituali sono gli script Python, 
che assumono la forma *.py.

Per eseguirli, è necessario chiamare python per eseguire l'esecuzione fornendo il percorso corretto. 
Se si è scaricato "<somefile>.py" sul desktop, per esempio, si può fare una delle tre cose seguenti:

◦ Basta fare clic su di esso. MX Linux ha un piccolo programma chiamato Py-Loader che 
lo lancerà utilizzando Python.

◦ Aprite un terminale e digitate:

http://www.tldp.org/LDP/Bash-Beginners-Guide/html/Bash-Beginners-Guide.html
http://www.freeos.com/guides/lsst
http://www.linuxcommand.org/
https://en.wikipedia.org/wiki/Scripting_language


python ~/Desktop/<somefile.py

◦ In alternativa, si può aprire un terminale all'interno della cartella stessa, nel qual caso si 
deve digitare:

python ./<somefile>.py

I linguaggi di scripting sono molto avanzati e non rientrano nell'ambito di questo manuale.

6.5.4 Script utente preinstallati

inxi

Inxi è un comodo script di informazioni sul sistema a riga di comando scritto da un 
programmatore noto come "h2". Immettere inxi -h in un terminale per visualizzare tutte le opzioni 
disponibili, che comprendono un'intera gamma di informazioni, dall'output dei sensori al meteo. 
Questo è il comando che sta dietro a MX Quick System Info.

ALTRO: Wiki MX/antiX

6.5.5 Suggerimenti e trucchi

• Per impostazione predefinita, il doppio clic su uno script di shell lo apre nell'editor di 
Featherpad invece di eseguirlo. Questa è una misura di sicurezza per evitare l'esecuzione 
accidentale di script non previsti. Per modificare questo comportamento, fare clic su 
Impostazioni > Editor tipi mimetici. Individuare x- application/x-shellscript e cambiare 
l'applicazione predefinita in bash.

• Un editor più avanzato per la programmazione di script è geany, installato di default. È un 
IDE/editor flessibile e potente, leggero e multipiattaforma.

6.6 Strumenti MX avanzati

Oltre alle applicazioni MX per la configurazione descritte nella Sezione 3.2, MX Linux include utility 
per l'utente avanzato disponibili in MX Tools.

6.6.1 Scansione di salvataggio di Chroot (CLI)

Un insieme di comandi che consentono di entrare in un sistema anche se il file initrd.img è rotto. 
Consente inoltre di entrare in più sistemi senza riavviare. Dettagli e immagini nel file HELP.

AIUTO: qui.

http://smxi.org/
https://mxlinux.org/wiki/antix-faqs-applications/guide-smxisgfxiinxi
https://www.geany.org/
https://en.wikipedia.org/wiki/Integrated_development_environment
https://mxlinux.org/wiki/system/chroot-rescue-scan/


6.6.2 Aggiornamento del kernel tramite Live-usb (CLI)

 VIDEO: Cambiare il kernel su un antiX o MX live-USB

ATTENZIONE: solo per l'uso in una sessione dal vivo!

Questa applicazione da riga di comando può aggiornare il kernel su una MX LiveUSB con qualsiasi 
kernel installato. Questa applicazione viene visualizzata in MX Tools solo quando è in corso una 
sessione Live.

Figura 6-6: Lo strumento di aggiornamento del kernel live-usb pronto a passare a un nuovo kernel.

AIUTO: qui.

6.6.3 C r e a t o r e  di MX Live Usb 

Si usa per creare una Live-USB partendo da un file ISO, da un CD/DVD live, da una Live-USB 
esistente o anche da un sistema live in esecuzione. Sebbene UNetbootin sia disponibile per 
impostazione predefinita (vedere Sezione 2.2.3), Live-USB Maker presenta una serie di vantaggi:

• È più veloce.
• Salva i file di stato tra i vari riavvii.
• LiveUSB-Storage per salvare i file direttamente sulla live-usb.
• Persistenza.
• Rimasterizzazione.
• Ora offre l'opzione dd.
• Aggiornamento del kernel in tempo reale.

https://www.youtube.com/watch?v=UWvwbwTGOZ8&t=2s
https://mxlinux.org/wiki/help-files/help-live-usb-kernel-updater
https://en.wikipedia.org/wiki/Dd_(Unix)


NOTA: il modulo CLI (live-usb-maker, eseguito come root) offre molte opzioni avanzate.

Figura 6-7: Lo strumento live-usb maker pronto a selezionare l'ISO da utilizzare.

AIUTO: qui.

6.6.4 Rimasterizzazione dal vivo (MX Snapshot e RemasterCC)

 VIDEO: Creare un'istantanea di un sistema installato

 VIDEO: MX-17: creare un live-USB con persistenza

 VIDEO: MX-17: installare applicazioni su una USB live con persistenza

NOTA: questa applicazione verrà visualizzata in MX Tools e sarà eseguibile solo quando si esegue una sessione 
Live.

Lo scopo principale della rimasterizzazione live è quello di rendere il più sicuro, facile e conveniente 
possibile per gli utenti creare la propria versione personalizzata di MX Linux che può essere distribuita 
ad altri computer. L'idea è quella di utilizzare una LiveUSB (o una LiveHD, una "installazione 
frugale"; si veda il Wiki MX/antiX) su una partizione del disco rigido come ambiente di sviluppo e 
test. Aggiungete o sottraete pacchetti e poi, quando siete pronti per la rimasterizzazione, usate la GUI o 
lo script e riavviate. Se qualcosa va terribilmente storto, è sufficiente riavviare con l'opzione di 
rollback per avviare l'ambiente precedente.

Molti utenti conosceranno già lo strumento MX Snapshot per la rimasterizzazione (si veda anche 
un'applicazione più vecchia ma ancora utile, RemasterCC). L'ISO rimasterizzata (un "respin") può 
essere messa su un LiveMedium nel modo consueto (si veda la Sezione 2.2) e poi installata, se lo si 
desidera, aprendo un terminale root e inserendo il comando: minstall-launcher.

https://mxlinux.org/wiki/help-files/help-live-usb-maker
https://www.youtube.com/watch?v=ExVkxXcVDAw
https://www.youtube.com/watch?v=2vF_dw6Kpo8
https://www.youtube.com/watch?v=6BsCx1-v3Ro
https://mxlinux.org/wiki/system/frugal-installation
https://mxlinux.org/wiki/help-files/help-live-remasterpersistence-remastercc


Figura 6-9: Schermata di apertura dell'istantanea.

I membri della Comunità MX utilizzano la rimasterizzazione Live con Snapshot per produrre 
versioni non ufficiali di MX Linux che possono essere monitorate sul forum.

 VIDEO: MX 16 - Rimasterizza il tuo Live-USB

 VIDEO: MX Spins: Banco di lavoro!

 VIDEO: MX Spins: Il KDE di Stevo!

La Live ISO può essere eseguita con la cosiddetta "persistenza". La persistenza è un ibrido tra un 
LiveMedium e un'installazione completa; consente di conservare tutti i file installati o aggiunti 
durante una sessione live. I programmi installati o rimossi dai file utente "demo" durante la 
persistenza dal vivo e le personalizzazioni apportate a questi ultimi saranno trasferiti al sistema 
installato.

 VIDEO: USB live con persistenza (modalità legacy)

 VIDEO: USB live con persistenza (modalità UEFI)

https://forum.mxlinux.org/viewforum.php?f=127
https://www.youtube.com/watch?v=LpI_a4xPKdM
https://www.youtube.com/watch?v=zwLz2vLc_qg
https://www.youtube.com/watch?v=87Qb3_S8dGA
https://www.youtube.com/watch?v=RC4SmhsG3K0
https://www.youtube.com/watch?v=DJmukS-bSxw


6.7 SSH (Secure Shell)

SSH (Secure Shell) è un protocollo utilizzato per accedere in modo sicuro ai sistemi remoti. È il modo 
più comune per accedere a computer remoti Linux e Unix-like. MX Linux viene fornito con i 
principali pacchetti necessari per eseguire SSH in modalità attiva, il principale dei quali è OpenSSH, 
un'implementazione gratuita di Secure Shell che consiste in un'intera suite di applicazioni.

• Avviare o riavviare il demone ssh come root con il comando:

/etc/init.d/ssh start

• Per avviare automaticamente il demone ssh all'avvio del computer, fare clic su Tutte le 
impostazioni > Sessione e avvio > Avvio automatico applicazioni. Fate clic sul pulsante 
Aggiungi, quindi nella finestra di dialogo inserite un nome, ad esempio StartSSH, una breve 
descrizione, se lo desiderate, e il comando

/etc/init.d/ssh start

Premere OK e il gioco è fatto. Al successivo riavvio, il demone SSH sarà attivo.

• Gli utenti di KDE su MX Linux possono fare lo stesso utilizzando Preferenze > 
Impostazioni > Avvio e arresto > Avvio automatico.

6.7.1 Risoluzione dei problemi SSH

A volte, SSH non funziona in modalità passiva, inviando un messaggio di connessione negata. Allora si 
può provare quanto segue:

• Modificare come root il file '/etc/ssh/sshd-config'. Alla riga 16 si trova il parametro 
'UsePrivilegeSeparation yes'. Modificarlo in

UsePrivilegeSeparation no

• Aggiungere se stessi (o gli utenti previsti) al gruppo 'ssh' utilizzando MX User Manager o 
modificando come root il file /etc/group.

• A volte i certificati possono essere mancanti o obsoleti; un modo semplice per ricostruirli è 
eseguire (come root) il comando

• Controllare se sshd è in 
esecuzione digitando

ssh-keygen -A

/etc/init.d/ssh status

Il sistema dovrebbe rispondere "[ ok ] sshd è in esecuzione".

• Se si utilizza un firewall, verificare che la porta 22 non sia bloccata. Deve consentire il traffico in entrata e 
in uscita.

http://en.wikipedia.org/wiki/Secure_Shell


ALTRO: Manuale Openssh

6.8 Sincronizzazione

La sincronizzazione dei file (o sincronizzazione) consente di mantenere identici i file in posizioni 
diverse. Si presenta in due forme:

• a senso unico ("mirroring"), in cui un computer sorgente viene copiato su altri, ma non il contrario.

• a due vie, in cui più computer sono mantenuti identici.

Per esempio, gli utenti di MX Linux lo trovano utile per gestire installazioni multiple per se stessi, per 
i membri della famiglia o per altri gruppi, eliminando così la necessità di aggiornare più di una volta. 
Esiste una grande quantità di software di sincronizzazione, ma i due seguenti sono stati testati e si 
sono dimostrati utili per gli utenti di MX Linux:

• unison-gtk (nei repo)

• FreeFileSync

http://www.openssh.com/manual.html
https://en.wikipedia.org/wiki/File_synchronization
https://en.wikipedia.org/wiki/Comparison_of_file_synchronization_software
https://www.cis.upenn.edu/~bcpierce/unison/
https://www.freefilesync.org/


7.1 Introduzione
MX Linux eredita il suo design fondamentale da Unix, un sistema operativo che esiste in varie forme 
dal 1970. Da esso è stato sviluppato Linux, da cui Debian produce la sua distribuzione. Il sistema 
operativo di base è l'argomento di questa sezione. Gli utenti che provengono da sistemi tradizionali, 
come MS Windows, di solito trovano molti concetti sconosciuti e si sentono frustrati nel cercare di 
fare le cose nel modo in cui sono abituati a farle.

Questa sezione fornisce una panoramica di alcuni aspetti di base del sistema operativo MX Linux e 
di come si differenziano da altri sistemi per facilitare la transizione.
Collegamenti

• Wikipedia: Unix

• Pagina iniziale di Linux

• Wikipedia Debian

7.2 La struttura del file system
Esistono due usi fondamentali del termine "file system".

• Il primo è il Filesystem del sistema operativo. Si tratta dei file e della loro organizzazione che il 
sistema operativo utilizza per tenere traccia di tutte le risorse hardware e software a sua 
disposizione durante il funzionamento.

• L'altro uso del termine file system si riferisce al Disk Filesystem, progettato per l'archiviazione 
e il recupero dei file su un dispositivo di archiviazione dati, più comunemente un'unità disco. Il 
file system del disco viene impostato quando la partizione del disco viene formattata per la 
prima volta, prima di scrivere qualsiasi dato sulla partizione.

Il file system del sistema operativo
Se si apre Thunar File Manager e si fa clic su File System nel riquadro di sinistra, si noterà una 
serie di directory con nomi basati sulla gerarchia standard del filesystem Unix.

7Sotto il cofano

https://en.wikipedia.org/wiki/Unix
http://en.wikipedia.org/wiki/Unix
http://www.linux.org/
http://en.wikipedia.org/wiki/Debian
https://refspecs.linuxfoundation.org/FHS_3.0/fhs/index.html


Figura 7-1: Il filesystem MX visualizzato in Thunar.

Ecco una semplice descrizione delle principali directory di MX Linux e un esempio di quando gli utenti 
lavorano comunemente con i file in queste directory:

• /bin

• Questa directory contiene i file di programma binari che vengono utilizzati dal sistema 
durante l'avvio, ma che possono anche essere richiesti dalle azioni dell'utente una 
volta che il sistema è completamente operativo.

• Esempio: Qui si trovano molti programmi di base della riga di comando, come la shell 
Bash, e utility come /dd/, /grep/, /ls/ e /mount/, oltre ai programmi utilizzati solo dal 
sistema operativo.

• /boot

• Come si può intuire, qui si trovano i file necessari a Linux per l'avvio. Il kernel Linux, 
il nucleo del sistema operativo Linux, è conservato qui, così come i bootloader come 
GRUB.

• Esempio: nessun file è comunemente consultato dagli utenti.

• /dev

• /etc

• In questa directory si trovano i file speciali che collegano i vari dispositivi di 
input/output del sistema.

• Esempio: nessun file qui è comunemente accessibile direttamente dagli utenti, tranne 
che nei comandi di montaggio della CLI.



• Questa directory contiene i file di configurazione del sistema e i file di 
configurazione delle applicazioni.

• Esempio: Il file /etc/fstab specifica i punti di montaggio per ulteriori filesystem su 
dispositivi, partizioni, ecc. che possono essere configurati per un uso ottimale.

• Esempio: i problemi di visualizzazione a volte comportano la modifica del file /etc/X11/xorg.conf.

• /home

• Qui risiedono le directory personali dell'utente (dati e impostazioni). Se c'è più di un 
utente, viene creata una sottodirectory separata per ciascuno. Nessun utente (eccetto 
root) può leggere la directory personale di un altro utente. La directory dell'utente 
contiene sia file nascosti (dove il nome del file è preceduto da un punto) sia file 
visibili; i file nascosti possono essere rivelati facendo clic su Visualizza > Mostra file 
nascosti (o Ctrl-H) in Thunar File Manager.

• Esempio: all'inizio gli utenti organizzano i propri file utilizzando le directory 
predefinite come Documenti, Musica, ecc.

• Esempio: un profilo Firefox si trova nella directory nascosta .mozilla/firefox/

• /lib

• Questa directory contiene librerie di oggetti condivisi (analoghe alle DLL di 
Windows) che sono necessarie all'avvio. In particolare, i moduli del kernel si trovano 
qui, sotto la voce
/lib/moduli.

• Esempio: nessun file è comunemente consultato dagli utenti.

• /media

• I file per i supporti rimovibili come CDrom, unità floppy e chiavette USB vengono 
installati qui quando i supporti vengono montati automaticamente.

• Esempio: Dopo aver montato dinamicamente una periferica come un'unità flash, è 
possibile accedervi da qui.

• /mnt

• I dispositivi di archiviazione fisica devono essere montati qui prima di potervi accedere. 
Dopo che le unità o le partizioni sono state definite nel file /etc/fstab, il loro file system 
viene montato qui.

• Esempio: Gli utenti possono accedere ai dischi rigidi e alle loro partizioni montate qui.

• /opt

• È la posizione prevista per i principali sottosistemi applicativi di terze parti installati 
dall'utente. Alcune distro collocano qui anche i programmi installati dall'utente.

• Esempio: se si installa Google Earth, è qui che verrà installato. nelle sottocartelle 
/opt: Anche Firefox, Libre Office e Wine si trovano qui,

• /proc



• La posizione delle informazioni di processo e di sistema.

• Esempio: nessun file è comunemente consultato dagli utenti.

• /root

• È la directory principale dell'utente root (amministratore). Si noti che non è la stessa 
cosa di "/", la radice del file system.

• Esempio: nessun file qui è comunemente accessibile agli utenti, ma i file salvati 
durante l'accesso come utente root possono essere salvati qui.

• /sbin

• Qui vengono installati i programmi richiesti dagli script di avvio del sistema, ma che 
normalmente non vengono eseguiti da utenti diversi da root, ovvero le utilità di 
amministrazione del sistema.

• Esempio: nessun file qui è comunemente consultato dagli utenti, ma è qui che si trovano file come
modprobe e ifconfig.

• /tmp

• È la posizione dei file temporanei prodotti dai programmi, come i compilatori, durante 
la loro esecuzione. In generale, si tratta di file temporanei a breve termine, che servono 
a un programma solo durante la sua esecuzione.

• Esempio: nessun file è comunemente consultato dagli utenti.

• /usr

• /var

• Questa directory contiene molti file per le applicazioni dell'utente ed è per certi versi 
analoga alla directory "Program Files" di Windows.

• Esempio: molti programmi eseguibili (binari) si trovano in /usr/bin

• Esempio: la documentazione (/usr/docs) e i file di configurazione, la grafica e le icone sono in
/usr/share.

• Questa directory contiene i file che cambiano continuamente durante l'esecuzione di 
Linux, ad esempio i log, la posta di sistema e i processi in coda.

• Esempio: si può guardare in /var/log/ usando MX Quick System Info quando si 
cerca di determinare cosa è successo durante un processo come l'installazione 
di un pacchetto.

Il file system del disco
Il file system del disco è qualcosa di cui l'utente medio non deve preoccuparsi più di tanto. Il file 
system predefinito utilizzato da MX Linux si chiama ext4, una versione del file system ext2 che è



journaled, cioè scrive le modifiche in un registro prima di eseguirle, rendendole più robuste. Il file 
system ext4 viene impostato durante l'installazione, quando il disco rigido viene formattato.

In linea di massima, ext4 ha più anni di esperienza rispetto a tutti i suoi rivali e combina stabilità e 
velocità; per queste ragioni, non consigliamo di installare MX Linux su un file system diverso a meno 
che non siate ben informati sulle differenze. Tuttavia, MX Linux è in grado di leggere e scrivere su 
molti altri filesystem formattati e può essere installato su alcuni di essi, se per qualche motivo se ne 
preferisce uno a ext4.

Collegamenti

• Il sistema di file di Wikipedia

• Wikipedia. Confronto tra filesystem

• Wikipedia Ext4

7.3 Permessi
MX Linux è un sistema operativo basato su account. Ciò significa che nessun programma può essere 
eseguito senza un account utente e che qualsiasi programma in esecuzione è limitato dai permessi 
concessi all'utente che lo ha avviato.

NOTA: Gran parte della sicurezza e della stabilità per cui Linux è conosciuto si basa sull'uso corretto 
di account utente limitati e sulla protezione fornita dai permessi predefiniti di file e directory. Per 
questo motivo, si dovrebbe operare come root solo per le procedure che lo richiedono. Non accedete 
mai a MX Linux come root per eseguire le normali attività del computer: l'esecuzione di un browser 
web come utente root, ad esempio, è uno dei pochi modi per contrarre un virus su un sistema Linux!

Informazioni di base
La struttura predefinita dei permessi dei file in Linux è piuttosto semplice, ma più che adeguata per 
la maggior parte delle situazioni. Per ogni file o cartella, ci sono tre permessi che possono essere 
concessi e tre entità (proprietario/creatore, gruppo, altri/mondo) a cui sono concessi. I permessi 
sono:

• Il permesso di lettura significa che i dati possono essere letti dal file; significa anche che il file 
può essere copiato. Se non si ha il permesso di lettura per una directory, non si possono 
nemmeno vedere i nomi dei file in essa elencati.

• Il permesso di scrittura significa che il file o la cartella possono essere modificati, 
aggiunti o eliminati. Per le directory, specifica se un utente può scrivere sui file della 
directory.

http://en.wikipedia.org/wiki/File_system
http://en.wikipedia.org/wiki/File_system
http://en.wikipedia.org/wiki/Ext4


• Il permesso di esecuzione indica se l'utente può eseguire o meno il file come script o 
programma. Per le directory, determina se l'utente può entrare e diventare la directory di 
lavoro corrente.

• Ogni file e cartella acquisisce un singolo utente designato come proprietario quando viene 
creato nel sistema. (Si noti che se si sposta un file da un'altra partizione in cui ha un 
proprietario diverso, manterrà il proprietario originale; ma se lo si copia e incolla, verrà 
assegnato all'utente). Ha anche un singolo gruppo designato come gruppo, per impostazione 
predefinita il gruppo a cui appartiene il proprietario. I permessi concessi agli altri riguardano 
tutti coloro che non sono il proprietario o il gruppo di appartenenza.

NOTA: Per gli utenti avanzati è possibile impostare altri attributi speciali oltre a 
lettura/scrittura/esecuzione: sticky bit, SUID e SGID. Per ulteriori informazioni, vedere la sezione 
Collegamenti di seguito.

Visualizzazione, impostazione e modifica delle autorizzazioni
In MX Linux sono disponibili molti strumenti per visualizzare e gestire i permessi.

• INTERFACCIA GRAFICA

• Thunar. Per visualizzare o modificare le autorizzazioni di un file, fare clic con il 
pulsante destro del mouse sul file e selezionare Proprietà. Fare clic sulla scheda 
Autorizzazioni. Qui è possibile impostare le autorizzazioni concesse al proprietario, al 
gruppo e ad altri utilizzando i menu a discesa. Per alcuni file (come gli script, ad 
esempio), è necessario selezionare la casella per renderli eseguibili, mentre per le 
cartelle è possibile selezionare una casella per limitare l'eliminazione dei file al suo 
interno ai soli proprietari.

NOTA: per modificare i permessi di un file o di una directory il cui proprietario è root è 
necessario operare come root. Per le cartelle più grandi è necessario aggiornare la 
finestra di Thunar, altrimenti i permessi verranno visualizzati in modo errato, anche se i 
permessi sono stati effettivamente modificati. Basta premere F5 per aggiornare la 
finestra, altrimenti si vedranno i permessi originali.

• MX User Manager è un modo semplice per modificare le autorizzazioni 
associando un utente a gruppi specifici.

• CLI

• Partizioni interne. Per impostazione predefinita, per montare le partizioni interne è 
necessaria la password di root/superuser. Per modificare questo comportamento, fare 
clic su MX Tweak, scheda Altro.

• Nuove partizioni esterne. La formattazione di una nuova partizione con ext4 richiede i 
permessi di root, il che può portare a un risultato inaspettato o indesiderato: l'utente 
normale non può scrivere alcun file nella partizione. Per modificare questo 
comportamento, consultare il Wiki MX/antiX.

• Operazioni manuali. Sebbene MX User Manager copra la maggior parte delle situazioni 

https://mxlinux.org/wiki/system/format-ext4-filesystem-be-owned-regular-user
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utilizzare la riga di comando. I permessi di base sono rappresentati da r (lettura), w 
(scrittura) e x (esecuzione); un trattino indica l'assenza di permessi. Per visualizzare i 
permessi di un file alla riga di comando, digitate: ls -l NomeFile. Potrebbe essere 
necessario utilizzare il nome completo



la posizione del file (ad esempio, /usr/bin/gimp). L'opzione -l fa sì che il file venga 
elencato in formato lungo, mostrando i suoi permessi e altre informazioni.

Figura 7-2: Visualizzazione delle autorizzazioni dei file.
I caratteri subito dopo il trattino di apertura (che indica che si tratta di un file regolare) 
contengono le tre autorizzazioni (lettura/scrittura/esecuzione) per il proprietario, il 
gruppo e altri: 9 caratteri in totale. Qui si vede che il proprietario ha i permessi di lettura 
e scrittura ma non di esecuzione (rw-), mentre il gruppo e gli altri possono solo leggere. 
In questo caso il proprietario è "newbie", che appartiene al gruppo "users".

Se per qualche motivo fosse necessario cambiare la proprietà di questo file a root usando 
la riga di comando, l'utente "newbie" userebbe il comando chown come in questo 
esempio:

chown root /home/newbie/.asoundrc
Per i dettagli sull'uso di chown e del più dettagliato chmod, si veda la sezione Collegamenti.

Collegamenti

• Wiki MX/antiX: Permessi

• Permessi dei file

7.4 File di configurazione

7.4.1 File di configurazione utente
I file che contengono le impostazioni individuali dell'utente (come i punteggi più alti dei giochi o la 
disposizione del desktop) sono memorizzati all'interno della home directory di un utente, in genere 
come file o directory nascosti, e possono essere modificati solo da quell'utente o da root. Questi file di 
configurazione personale sono in realtà meno spesso modificati direttamente rispetto ai file di sistema, 
perché la maggior parte della configurazione dell'utente avviene graficamente attraverso le 
applicazioni stesse. Quando si apre un'applicazione e si fa clic su Modifica > Preferenze, ad esempio, 
le selezioni vengono scritte in un file di configurazione (solitamente nascosto) nella propria directory 
utente. Allo stesso modo in Firefox, quando si digita about:config nella barra degli indirizzi, si 
modificano i file di configurazione nascosti. I file di configurazione di Xfce sono memorizzati in 
~/.config/.

https://mxlinux.org/wiki/system/permissions


7.4.2 File di configurazione del sistema
I file che contengono le configurazioni o le impostazioni predefinite del sistema (come il file 

che determina quali servizi vengono avviati automaticamente all'avvio) sono in gran parte 
memorizzati nella directory /etc/ e sono modificabili solo da root. La maggior parte di questi file 
non viene mai toccata direttamente dagli utenti normali, come ad esempio questi:

• /etc/rc.d/rc5.d - Contiene i file per controllare il runlevel 5 in cui MX Linux si avvia dopo il login.

• /etc/sysconfig/keyboard - Utilizzato per configurare la tastiera.

• /etc/network/interfaces - Definisce le interfacce Internet del sistema.

Alcuni file di configurazione possono contenere solo poche righe, o addirittura essere vuoti, mentre 
altri possono essere piuttosto lunghi. L'importante è che se si cerca un file di configurazione per 
un'applicazione o un processo, si vada nella directory /etc e si cerchi. Attenzione: poiché questi file 
influenzano l'intero sistema, 1) fate un backup di qualsiasi file che intendete modificare (la cosa più 
semplice in Thunar: copiate e incollate, aggiungendo facoltativamente BAK alla fine del nome del file) 
e 2) fate molta attenzione!

7.4.3 Esempio
I problemi sonori possono essere risolti con una serie di strumenti grafici e a riga di comando, ma ogni 
tanto l'utente ha bisogno di modificare direttamente il file di configurazione del sistema. Per molti 
sistemi, questo sarà
/etc/modprobe.d/snd-hda-intel.conf. Si tratta di un semplice file il cui paragrafo superiore ha questo aspetto:

# alcuni chip richiedono che il modello sia 
impostato manualmente # per esempio la serie asus 
g71 può richiedere model=g71v

opzioni snd-hda-intel model=auto

Per cercare di ottenere il suono, si potrebbe decidere di sostituire le informazioni esatte sul 
modello di suono con la parola "auto". Per conoscere il proprio modello di suono, si può aprire un 
terminale e digitare:

lspci | grep Audio
L'output dipenderà dal sistema, ma avrà la forma seguente:

00:05.0 Dispositivo audio: nVidia Corporation MCP61 High Definition Audio (rev a2)
Ora è possibile reinserire queste informazioni nel file di configurazione:

# alcuni chip richiedono che il modello sia 
impostato manualmente # per esempio la serie asus 
g71 può richiedere le opzioni model=g71v snd-hda-
intel model=nvidia

Salvare il file, riavviare il computer e, se tutto va bene, l'audio dovrebbe funzionare. Si può anche 
provare con maggiore precisione utilizzando model=nvidia mcp61 al posto di model=nvidia mcp61, 
se il primo non ha funzionato.



Collegamenti



• Conoscere i file di configurazione di Linux

• Permessi dei file

7.5 Livelli di corsa
MX Linux si avvia per impostazione predefinita utilizzando un tipo di processo di inizializzazione 
(init) chiamato sysVinit. Dopo aver completato il processo di avvio, init esegue tutti gli script di 
avvio in una directory specificata dal runlevel predefinito (questo runlevel è dato dalla voce ID in 
/etc/inittab). MX Linux ha 7 runlevel (altri processi come systemd non usano i runlevel nello 
stesso modo):

Tabella 10: Livelli di esecuzione in MX Linux.

Livello 
di 

esecuzio
ne

Commento

0 Arresto del sistema
1 Modalità monoutente: fornisce una console di root senza 

accesso.
Utile se si perde la password di root

2 Multiutente senza rete
3 Accesso da console, senza X (cioè senza GUI)
4 Non utilizzato/personalizzato
5 Accesso predefinito alla GUI
6 Riavviare il sistema

MX Linux ha come impostazione predefinita il livello di esecuzione 5, pertanto qualsiasi script di 
avvio impostato nel file di configurazione di livello 5 verrà eseguito all'avvio.

Utilizzo
La comprensione dei livelli di esecuzione può essere utile. Quando gli utenti hanno un problema con 
X Window Manager, per esempio, non possono correggerlo nel runlevel 5 predefinito, perché X è in 
esecuzione a quel livello. Ma possono accedere al livello di esecuzione 3 per risolvere il problema in 
due modi.

• Dal desktop: premere Ctrl-Alt-F1 per uscire da X. Per passare effettivamente al runlevel 3, 
diventare root e digitare telinit 3; questo arresterà tutti gli altri servizi ancora attivi sul runlevel 
5.

• Dal menu di GRUB: premere e (per modificare) quando si visualizza la schermata di GRUB. 
Nella schermata successiva, aggiungete uno spazio e il numero 3 alla fine della riga (per 
impostazione predefinita dove si trova la parola "quiet") che inizia con "linux" e che si trova 
una volta sopra la riga più bassa (il comando di avvio vero e proprio). Premere F-10 per 
avviare il sistema.

https://mxlinux.org/wiki/system/permissions
https://en.wikipedia.org/wiki/Init


Una volta che il cursore si trova su un prompt, effettuare il login con il proprio nome utente e la 
propria password. Se necessario, è possibile effettuare il login anche come "root" e fornire la 
password amministrativa. I comandi utili quando si guarda il prompt al runlevel 3 sono:



Tabella 11: Comandi comuni del runlevel 3.

Comando Commento
livello di 

esecuzione
Restituisce il numero del runlevel in cui ci si 

trova.
alt Eseguire come root. Spegne il computer. Se il sistema non funziona, provare con 

poweroff.
riavvio Eseguire come root. Riavvia la macchina.

<applicazione
>

Esegue l'applicazione, purché non sia grafica. Ad esempio, è possibile utilizzare il 
comando nano per modificare i file di testo, ma non leafpad.

Ctrl-Alt-F7 Se si è usato Ctrl-Alt-F1 per uscire da un desktop in esecuzione ma non si è 
proseguito fino al livello di esecuzione 3, questo comando riporta al 
desktop.

telinit 5 Eseguire come root. Se si è al runlevel 3, inserire questo comando per accedere 
al gestore di login lightdm.

Collegamenti

• Wikipedia: Runlevel

• Il progetto Linux Information: Definizione del livello di esecuzione

7.6 Il kernel

7.6.1 Introduzione

Questa sezione tratta le interazioni comuni con il kernel da parte dell'utente. Per altri aspetti più 
tecnici, consultare i link

7.6.2 Aggiornamento/Diminuzione

Fasi di base
A differenza di altri software del sistema, il kernel non viene aggiornato automaticamente se non al di 
sotto del livello di revisione minore (indicato dal terzo numero nel nome del kernel). Prima di cambiare 
il kernel attuale, è bene porsi alcune domande:

• Perché voglio aggiornare il kernel? Ad esempio, c'è un driver che mi serve per un nuovo hardware?

• Devo aggiornare il kernel? Ad esempio, i processori Core2 Duo tendono ad avere strani 
problemi con il kernel predefinito di MX-Linux che si risolvono passando al kernel 
predefinito di Debian 4.9 (usando MX Package Installer).

• Sono consapevole che i cambiamenti non necessari potrebbero portare problemi di un tipo o di un altro?

http://en.wikipedia.org/wiki/Runlevel
http://www.linfo.org/runlevel_def.html


MX Linux offre un metodo semplice per aggiornare/ridimensionare il kernel predefinito: aprire MX 
Package Installer e fare clic sulla categoria "Kernel". Lì si vedrà una serie di kernel disponibili per 
l'utente. Selezionate quello che volete usare (chiedete sul forum se non siete sicuri) e installatelo.

Una volta controllato e installato il nuovo kernel, riavviare e verificare che il nuovo kernel sia 
evidenziato; in caso contrario, fare clic sulla riga delle opzioni e selezionare ciò che si desidera.

Figura 7-3: Opzioni del kernel in MX Package Installer per l'architettura a 64 bit.

Avanzato
Molti utenti si rivolgono normalmente a MX Package Installer per aggiornare il kernel, ma è 
possibile farlo anche manualmente. Ecco un approccio di base per aggiornare manualmente il kernel 
Linux sul vostro sistema.

• Per prima cosa, è necessario scoprire cosa è attualmente installato. Aprite un terminale e 
digitate inxi S. Per esempio, un utente della versione MX-19 a 64 bit potrebbe vedere qualcosa 
di simile:

Kernel: 5.8.0-2-amd64 x86_64 bit
Assicurarsi di annotare il nome del kernel dall'output del comando.

• In secondo luogo, selezionare e installare un nuovo kernel. Aprite Synaptic, cercate linux-
image e cercate un numero di kernel più alto che corrisponda all'architettura (ad esempio, 686) 
e al processore (ad esempio, PAE) che avete già, a meno che non abbiate una buona ragione 
per cambiare. Installare quello desiderato o necessario nel modo consueto.

• In terzo luogo, installare il pacchetto linux-headers che corrisponde al nuovo kernel 
selezionato. Ci sono due metodi per farlo.

• Osservare attentamente le voci di Synaptic che iniziano con linux-headers e che corrispondono al 
kernel.

• In alternativa, è possibile installare le intestazioni più facilmente dopo il riavvio del 
nuovo kernel digitando il seguente codice in un terminale root:

apt-get install linux-headers-$(uname -r)
Le intestazioni saranno installate anche se si utilizza un comando come m-a prepare.

• Al riavvio, si dovrebbe avviare automaticamente il kernel più alto disponibile. Se non 
funziona, potete tornare a quello che stavate usando: riavviate e, quando vedete la schermata 
di GRUB, evidenziate Opzioni avanzate per la partizione che volete avviare, quindi 
selezionate il kernel e premete Invio.



7.6.3 Aggiornamento del kernel e dei driver
Il Dynamic Kernel Module Support (DKMS) ricompila automaticamente tutti i moduli driver DKMS 
quando viene installata una nuova versione del kernel. Ciò consente ai driver e ai dispositivi esterni al 
kernel principale di continuare a funzionare dopo un aggiornamento del kernel Linux. L'eccezione 
riguarda i driver grafici proprietari (Sezione 3.3.2).

• Driver NVidia

• Se installati con sgfxi, devono essere ricostruiti con sgfxi, vedere Sezione 6.5.3.

• Se è stato installato con il programma di installazione dei driver MX Nvidia o tramite 
synaptic/apt-get, potrebbe essere necessario ricostruire i moduli del kernel. Il riavvio 
del programma di installazione dei driver MX Nvidia dal menu dovrebbe offrire la 
possibilità di reinstallare e ricostruire i moduli. Se il riavvio si blocca al prompt della 
console, diventare root e inserire "ddm-mx -i nvidia" per reinstallare e ricostruire i 
moduli del driver.

• Driver Intel

• Potrebbe essere necessario aggiornare il driver, a seconda del kernel selezionato per 
l'aggiornamento.

7.6.4 Altre opzioni
Esistono altre considerazioni e scelte in merito ai kernel:

• Esistono altri kernel pre-rollati, come il kernel Liquorix, che è una versione del kernel Zen ed 
è destinato a fornire una migliore esperienza d'uso del desktop in termini di reattività, anche 
sotto carichi pesanti come durante i giochi, oltre a una bassa latenza (importante per l'audio). 
MX Linux aggiorna frequentemente i kernel Liquorix, quindi è più facile installarli tramite 
MX Package Installer > MX Test Repo.

• Le distro (ad esempio, la distro sorella di MX, antiX) spesso si autoproducono.

• Le persone competenti possono compilare un kernel specifico per un determinato hardware.

7.6.5 Collegamenti
• Wikipedia: Kernel Linux

• Anatomia del kernel Linux

• Archivi del kernel Linux

• Mappa interattiva del kernel Linux

https://en.wikipedia.org/wiki/Dynamic_Kernel_Module_Support
http://en.wikipedia.org/wiki/Linux_kernel
https://developer.ibm.com/articles/l-linux-kernel/
http://www.kernel.org/
http://www.makelinux.net/kernel_map


7.6.6 Panico e recupero del kernel
Il kernel panic è un'azione relativamente rara intrapresa dal sistema MX Linux quando rileva un errore 
fatale interno dal quale non può riprendersi in modo sicuro. Può essere causato da una serie di fattori 
diversi che vanno da problemi hardware a un bug del sistema stesso. Quando si verifica un kernel 
panic, provare a riavviare il sistema con MX Linux LiveMedium, che supererà temporaneamente 
qualsiasi problema software e consentirà di vedere e scaricare i dati. Se non funziona, scollegare tutto 
l'hardware non necessario e riprovare.

La prima preoccupazione è quella di accedere e proteggere i dati. Si spera che sia stato eseguito un 
backup da qualche parte. In caso contrario, è possibile utilizzare uno dei programmi di recupero 
dati, come ddrescue, fornito con MX Linux. L'ultima risorsa è portare il disco rigido da un'azienda 
di recupero professionale.

Per ripristinare un sistema MX Linux funzionante, una volta messi al sicuro i dati, è necessario seguire 
una serie di passaggi, anche se alla fine potrebbe essere necessario reinstallare utilizzando 
LiveMedium. A seconda del tipo di guasto, possono essere eseguite le seguenti operazioni:

1. Rimuovere i pacchetti che hanno danneggiato il sistema.

2. Reinstallare il driver grafico.

3. Reinstallare GRUB utilizzando MX Boot Repair.

4. Reimpostare la password di root.

5. Reinstallare MX Linux, selezionando la casella di controllo per mantenere /home 
(vedere Sezione 2.5) in modo da non perdere le configurazioni personali.

Se avete domande su queste procedure, chiedete pure sul Forum.

Collegamenti

• Libreria GNU C Home Page

• Ddrescue

7.7 Le nostre posizioni

7.7.1 Systemd

MX Linux viene fornito con due sistemi di init: SysVinit (predefinito) e systemd. Poiché l'uso di 
"systemd" come gestore di sistemi e servizi è stato controverso, vogliamo essere chiari sulla sua 
funzione in MX Linux: systemd è incluso ma non abilitato. È possibile eseguire una scansione 
del sistema MX e

http://www.gnu.org/software/libc
https://www.gnu.org/software/ddrescue/ddrescue.html
https://en.wikipedia.org/wiki/Systemd


scoprire file con nomi di systemd*, ma questi forniscono semplicemente un aggancio/un punto di 
ingresso per la compatibilità quando necessario. MX Linux utilizza systemd-shim, che emula le 
funzioni di systemd necessarie per l'esecuzione degli helper senza utilizzare effettivamente il 
servizio. Ciò significa che SysVinit rimane l'init predefinito, ma MX Linux può utilizzare i pacchetti 
Debian che hanno dipendenze da systemd, come CUPS e Network Manager. Questo approccio 
consente inoltre all'utente di mantenere la possibilità di scegliere il proprio init preferito all'avvio, 
selezionando la voce systemd.

7.7.2 Software non libero
MX Linux è fondamentalmente orientato all'utente, quindi include una certa quantità di software non 
libero per assicurare che il sistema funzioni il più possibile. L'utente può vedere un elenco aprendo 
una console o un terminale e digitando:

vrms
Esempi:

• Il driver "wl" (broadcom-sta) e il firmware non libero con componenti proprietari.

• Uno strumento dedicato all'installazione dei driver grafici Nvidia.

•

Il nostro ragionamento: per gli utenti avanzati è molto più facile rimuovere questi driver che 
installarli per gli utenti normali. Ed è particolarmente difficile installare un driver per una scheda di 
rete senza accesso a Internet!

https://www.gnu.org/philosophy/categories.en.html
https://www.gnu.org/philosophy/categories.en.html
https://fossbytes.com/difference-between-shell-console-terminal/


Elenco predefinito per MX-23:

Pacchetti non liberi installati su mx

amd64-microcodeFirmware del microcodice del processore per le CPU AMD
atmel-firmwareFirmware per i chip di rete 

wireless Atmel at76c50x.
bluez-firmwareFirmware per dispositivi Bluetooth

sorgente broadcom-sta-dkmsdkms per il driver 
Broadcom STA Wireless

firmware-amd-graphicsFirmware binario per 
i chip grafici AMD/ATI firmware-atherosFirmware binario per le schede wireless 
Qualcomm Atheros
firmware-bnx2Firmware binario per Broadcom NetXtremeII
firmware-bnx2xFirmware binario per Broadcom NetXtreme II 10Gb
firmware-brcm80211Firmware binario per Broadcom/Cypress 802.11 wireless c

firmware-intel-soundBinario per i DSP audio Intel
firmware-ipw2x00Firmware binario per Intel Pro Wireless 2100, 2200 e
firmware-iwlwifiFirmware binario per le schede Intel Wireless
firmware-libertasFirmware binario per le schede wireless Marvell
firmware-linuxFirmware binario per vari driver nel kernel Linux
firmware-linux-nonfreeFirmware binario per vari driver nel kernel Linux
firmware-misc-nonfreeFirmware binario per vari driver nel kernel Linux
firmware-myricomFirmware binario per gli adattatori Ethernet Myri-10G
firmware-netxenFirmware binario per QLogic Intelligent Ethernet (3000
firmware-qlogicFirmware binario per gli HBA QLogic
firmware-realtekFirmware binario per gli adattatori Realtek wired/wifi/BT
firmware-sof-firmatoFirmato del firmware SOF dell'Intel

firmware-zd1211 firmware binario per il 
driver wireless zd1211rw

intel-microcodeProcessore firmware microcodice per CPU 
Intel
nvidia-detectUtilità di rilevamento delle GPU NVIDIA

unrarUnarchiver per file .rar (versione non libera) Motivo: Modifiche 
problematiche

Pacchetti di contribuzione installati su mx

b43-fwcutterutility per l'estrazione del 
firmware Broadcom 43xx firmware-b43-installerfirmware installer per il 
driver b43 firmware-b43legacy-installerfirmware installer per il driver 
b43legacy mx-debian-firmwaremetapackage che dipende dal firmware Debian 
distribuito con

virtualbox-guest-utilsx86 soluzione di 
virtualizzazione - utilità guest non X11

virtualbox-guest-x11x86 soluzione di 
virtualizzazione - utilità X11 guest

25 pacchetti non liberi, l'1,4% dei 1802 pacchetti installati.
6 pacchetti contrib, lo 0,3% dei 1802 pacchetti installati.



I termini di Linux possono essere confusi e sconcertanti all'inizio, quindi questo glossario fornisce un 
elenco di quelli utilizzati in questo manuale per iniziare.

• applet: Un programma progettato per essere eseguito all'interno di un'altra 
applicazione. A differenza di un'applicazione, le applet non possono essere eseguite 
direttamente dal sistema operativo.

• backend: Anche /back-end./ Il backend comprende i vari componenti di un programma 
che elaborano i dati immessi dall'utente attraverso il frontend. Vedi anche frontend.

• backport: I backport sono nuovi pacchetti che sono stati ricompilati per essere 
eseguiti su una distribuzione rilasciata, al fine di mantenerla aggiornata.

• BASH: la shell (interprete della riga di comando) predefinita sulla maggior parte dei sistemi 
Linux e su Mac OS X, BASH è l'acronimo di Bourne-again shell.

• BitTorrent: Anche/bit torrent/ o /torrent./ Metodo inventato da Bram Cohen per distribuire 
file di grandi dimensioni senza che un singolo individuo debba fornire le risorse hardware, di 
hosting e di larghezza di banda necessarie.

• blocco di avvio: Un'area del disco al di fuori dell'MBR contenente le informazioni per il 
caricamento del sistema operativo necessarie per avviare il computer.

• bootloader: Programma che sceglie inizialmente un sistema operativo da caricare dopo che il 
BIOS ha terminato l'inizializzazione dell'hardware. Di dimensioni estremamente ridotte, il 
bootloader ha il solo compito di passare il controllo del computer al kernel del sistema 
operativo. I bootloader avanzati offrono un menu per scegliere tra diversi sistemi operativi 
installati.

• caricamento a catena: Invece di caricare direttamente un sistema operativo, un gestore di 
avvio come GRUB può utilizzare il caricamento a catena per passare il controllo da se stesso a 
un settore di avvio su una partizione del disco rigido. Il settore di avvio di destinazione viene 
caricato dal disco (sostituendo il settore di avvio da cui è stato caricato il boot manager stesso) 
e viene eseguito il nuovo programma di avvio. Oltre a quando è necessario, come nel caso 
dell'avvio di Windows da GRUB, il vantaggio del chainloading è che ogni sistema operativo 
sul disco rigido - e potrebbero essercene decine - può essere responsabile di avere i dati corretti 
nel proprio settore di avvio. In questo modo GRUB, che risiede nell'MBR, non deve essere 
riscritto a ogni modifica. GRUB può semplicemente caricare a catena le informazioni rilevanti 
dal settore di avvio di una determinata partizione, sia che questa sia cambiata sia che sia 
rimasta la stessa dall'ultimo avvio.

• codice cheat: I codici possono essere inseriti all'avvio di un LiveMedium per modificare il 
comportamento di avvio. Vengono utilizzati per passare opzioni al sistema operativo MX 
Linux e impostare parametri per ambienti particolari.

• interfaccia a riga di comando (CLI): Conosciuta anche come console, terminale, prompt dei 
comandi, shell o bash. Si tratta di un'interfaccia di testo in stile UNIX, a cui anche MS-DOS è 
stato progettato per assomigliare. Una console di root è quella in cui sono stati acquisiti i 
privilegi amministrativi dopo aver inserito la password di root.

• ambiente desktop: il software che fornisce un desktop grafico (finestre, icone, desktop, 
barra delle applicazioni, ecc.) all'utente di un sistema operativo.

8 Glossario



• immagine del disco: Un file contenente il contenuto completo e la struttura di un supporto o 
dispositivo di memorizzazione dei dati, come un disco rigido o un DVD. Vedere anche ISO.

• Distribuzione: Una distribuzione Linux, o distro, è una particolare confezione del kernel 
Linux con vari pacchetti software GNU e diversi desktop o window manager. Poiché, a 
differenza del codice proprietario utilizzato nei sistemi operativi di Microsoft e Apple, 
GNU/Linux è un software libero e open-source, chiunque al mondo ne abbia la possibilità può 
liberamente costruire su ciò che è stato fatto e innovare una nuova visione del sistema operativo 
GNU/Linux. MX Linux è una distro basata sulla famiglia Debian Linux.

• file system: Anche file system. Si riferisce al modo in cui i file e le cartelle sono disposti 
logicamente sui dispositivi di archiviazione di un computer in modo da poter essere trovati dal 
sistema operativo. Può anche riferirsi al tipo di formattazione di un dispositivo di 
archiviazione, come i comuni formati Windows NTFS e FAT32, o i formati Linux ext3, ext4 o 
ReiserFS, e in questo senso si riferisce al metodo effettivamente utilizzato per codificare i dati 
binari sul disco rigido, sul floppy, sull'unità flash, ecc.

• Firmware. I piccoli programmi e le strutture di dati che controllano internamente i 
componenti elettronici.

• libero come il linguaggio: La parola inglese "free" ha due possibili significati: 1) senza costi e 
2) senza restrizioni. In parte della comunità del software open-source, un'analogia utilizzata 
per spiegare la differenza è 1) "free" come la birra vs. 2) "free" come il linguaggio. La parola 
/freeware/ è usata universalmente per riferirsi al software che è semplicemente senza costi, 
mentre la frase /free software/ si riferisce vagamente al software che è più propriamente 
chiamato software open-source, concesso in licenza sotto qualche tipo di licenza open source.

• frontend: Anche front-end. Il frontend è la parte di un sistema software che interagisce 
direttamente con l'utente. Vedi anche backend.

• GPL: Licenza pubblica generale GNU. È una licenza con cui vengono rilasciate molte 
applicazioni open-source. Specifica che è possibile visualizzare, modificare e ridistribuire il 
codice sorgente delle applicazioni rilasciate sotto questa licenza, entro certi limiti; ma non è 
possibile distribuire il codice eseguibile a meno che non si distribuisca anche il codice 
sorgente a chiunque lo richieda.

• GPT: Schema di partizionamento utilizzato da UEFI nativo.
• Interfaccia grafica utente (GUI): Si riferisce all'interfaccia di un programma o di un 

sistema operativo che utilizza immagini (icone, finestre, ecc.), in contrapposizione alle 
interfacce testuali (a riga di comando).

• directory home: Una delle 17 directory di primo livello che si diramano dalla directory 
principale in MX Linux, /home contiene una sottodirectory per ogni utente registrato nel 
sistema. All'interno di ogni directory home gli utenti hanno privilegi di lettura e scrittura 
completi. Inoltre, la maggior parte dei file di configurazione specifici dell'utente per i vari 
programmi installati sono memorizzati in sottodirectory nascoste all'interno di
la directory /home/username/ come viene scaricata la posta elettronica. Gli altri file scaricati 
vengono solitamente inseriti per impostazione predefinita nelle sottodirectory 
home/username/Documents o /home/username/Desktop.

• IMAP: L'Internet Message Access Protocol è un protocollo che consente a un client di 
posta elettronica di accedere a un server di posta remoto. Supporta modalità di 
funzionamento sia on-line che off-line.

• interfaccia: Punto di interazione tra i componenti di un computer, spesso riferito al 



collegamento tra un computer e una rete. Esempi di nomi di interfaccia in MX Linux sono 
WLAN (wireless) e eth0 (cablata di base).

• IRC: Internet Relay Chat, un vecchio protocollo per facilitare lo scambio di messaggi di testo.



• ISO: un'immagine del disco conforme a uno standard internazionale che contiene file di dati 
e metadati del file system, compresi codice di avvio, strutture e attributi. È il metodo 
normale per distribuire versioni di Linux come MX Linux su Internet. Vedere anche 
immagine disco.

• kernel: Il livello di software di un sistema operativo che interagisce direttamente con l'hardware.
• LiveCD/DVD: Disco compatto avviabile da cui è possibile eseguire un sistema operativo, 

solitamente con un ambiente desktop completo, applicazioni e funzionalità hardware 
essenziali.

• LiveMedium: un termine generale che include sia LiveCD/DVD che LiveUSB.
• LiveUSB: Un'unità flash USB su cui è stato caricato un sistema operativo in modo da poterlo 

avviare ed eseguire. Vedere LiveDVD.
• indirizzo mac: indirizzo hardware che identifica in modo univoco ogni nodo (punto di 

connessione) di una rete. È formato da una stringa di solito di sei serie di due cifre o 
caratteri, separati da due punti.

• pagina man: Abbreviazione di manuale, le pagine man contengono in genere informazioni 
dettagliate su interruttori, argomenti e talvolta sul funzionamento interno di un comando. 
Anche i programmi dell'interfaccia grafica hanno spesso pagine man, che descrivono in 
dettaglio le opzioni disponibili sulla riga di comando. È disponibile nel menu Start digitando 
un # prima del nome della pagina man desiderata nella casella di ricerca, ad esempio: 
#pulseaudio.

• MBR: Master Boot Record: il primo settore di 512 byte di un disco rigido avviabile. I dati 
speciali scritti nel MBR consentono al BIOS del computer di passare il processo di avvio a una 
partizione con un sistema operativo installato.

• md5sum: Programma che calcola e verifica l'integrità dei dati di un file. L'hash MD5 (o 
checksum) funziona come un'impronta digitale compatta di un file. È estremamente 
improbabile che due file non identici abbiano lo stesso hash MD5. Poiché quasi tutte le 
modifiche apportate a un file causano la modifica del suo hash MD5, l'hash MD5 è 
comunemente utilizzato per verificare l'integrità dei file.

• specchio: Anche sito mirror. Copia esatta di un altro sito Internet, comunemente utilizzata 
per fornire più fonti delle stesse informazioni e per fornire un accesso affidabile a 
download di grandi dimensioni.

• modulo: I moduli sono pezzi di codice che possono essere caricati e scaricati nel kernel 
su richiesta. Estendono le funzionalità del kernel senza la necessità di riavviare il sistema.

• mountpoint: Il punto del file system principale in cui un dispositivo fisso o rimovibile è 
collegato (montato) e accessibile come sottodirectory. Tutto l'hardware del computer deve 
avere un punto di montaggio nel file system per essere utilizzabile. La maggior parte dei 
dispositivi standard, come la tastiera, il monitor e il disco rigido principale, vengono montati 
automaticamente all'avvio.

• mtp: MTP è l'acronimo di Media Transfer Protocol e opera a livello di file in modo che il 
dispositivo non esponga l'intero dispositivo di archiviazione. I vecchi dispositivi Android 
utilizzavano la memoria di massa USB per trasferire i file da un computer all'altro.

• NTFS®: Il New Technology File System di Microsoft ha debuttato nel 1993 sul sistema 
operativo Windows NT, destinato alle reti aziendali, e con le successive revisioni è entrato nei 
computer desktop degli utenti Windows con le versioni successive di Windows 2000. È il file 
system standard dall'introduzione di Windows XP alla fine del 2001. Le persone orientate a 



Unix/Linux dicono che sta per "Nice Try File System"!



• open-source: Software il cui codice sorgente è stato reso disponibile al pubblico con una 
licenza che consente ai singoli di modificare e ridistribuire il codice sorgente. In alcuni casi, le 
licenze open-source limitano la distribuzione del codice binario eseguibile.

• pacchetto: Un pacchetto è un insieme discreto di dati non eseguibili che include istruzioni per 
il gestore di pacchetti sull'installazione. Un pacchetto non sempre contiene una singola 
applicazione; potrebbe contenere solo una parte di un'applicazione di grandi dimensioni, diverse 
piccole utility, dati di font, grafica o file di aiuto.

• gestore di pacchetti: Un gestore di pacchetti, come Synaptic o Gdebi, è un insieme di 
strumenti per automatizzare il processo di installazione, aggiornamento, configurazione e 
rimozione dei pacchetti software.

• Pannello: Il pannello altamente configurabile di Xfce4 appare di default sul lato sinistro 
dello schermo e contiene le icone di navigazione, i programmi aperti e le notifiche di sistema.

• Tabella delle partizioni: Una tabella di partizione è un'architettura del disco rigido che amplia 
il vecchio schema di partizionamento Master Boot Record (MBR) utilizzando identificatori 
unici globali (GUID) per consentire l'esistenza di più delle quattro partizioni originali.

• persistenza: la capacità di mantenere le modifiche apportate durante la sessione live di LiveUSB.
• porta: Una connessione dati virtuale che può essere utilizzata dai programmi per scambiare 

dati direttamente, invece di passare attraverso un file o un'altra posizione di archiviazione 
temporanea. Le porte hanno numeri assegnati a protocolli e applicazioni specifici, come 80 
per HTTP, 5190 per AIM, ecc.

• purge: Un comando che rimuove non solo il pacchetto nominato, ma anche tutti i file di 
configurazione e di dati ad esso associati (ma non quelli nella home directory dell'utente).

• repo: Forma abbreviata di repository.
• repository: Un repository software è un luogo di archiviazione su Internet da cui è possibile 

recuperare e installare pacchetti software tramite un gestore di pacchetti.
• root: Root ha due significati comuni in un sistema operativo UNIX/Linux; sono intimamente 

connessi, ma la distinzione è importante da capire.
• Il file system principale è la struttura logica di base di tutti i file a cui il sistema 

operativo può accedere, siano essi programmi, processi, pipe o dati. Deve seguire lo 
standard della gerarchia dei file system di Unix, che specifica la posizione nella 
gerarchia di tutti i tipi di file.

• L'utente root è il proprietario del file system root e quindi ha tutti i permessi necessari 
per fare qualsiasi cosa a qualsiasi file. Sebbene a volte sia necessario assumere 
temporaneamente i poteri dell'utente /root/ per installare o configurare programmi, è 
pericoloso e viola la struttura di sicurezza di base di Unix/Linux accedere e operare 
come /root/ se non è assolutamente necessario. In un'interfaccia a riga di comando, un 
utente normale può diventare temporaneamente root lanciando il comando su e 
inserendo la password di root.

• runlevel: Un runlevel è uno stato operativo preimpostato in un sistema operativo Unix-like. Un 
sistema può essere avviato in uno dei diversi livelli di esecuzione, ognuno dei quali è 
rappresentato da un numero intero a una cifra. Ogni runlevel designa una diversa 
configurazione del sistema e consente l'accesso a una diversa combinazione di processi (cioè 
istanze di programmi in esecuzione). Si veda la Sezione 7.5.

•script: Un file di testo eseguibile, contenente comandi in un linguaggio interpretato. Di 
solito si riferisce agli script BASH, molto utilizzati "sotto il cofano" del sistema operativo 



Linux, ma possono essere utilizzati anche altri linguaggi.



• sessione: Una sessione di login è il periodo di attività che intercorre tra il login e il logout di 
un utente da un sistema. In MX Linux, questo indica tipicamente la durata di un particolare 
"processo" dell'utente (il codice del programma e la sua attività corrente) che Xfce invoca.

• SSD: Un'unità a stato solido (SSD) è un dispositivo di archiviazione non volatile che 
memorizza dati persistenti su una memoria flash a stato solido.

• codice sorgente: Il codice leggibile dall'uomo in cui il software è scritto prima di essere 
assemblato o compilato in codice di linguaggio macchina.

• switch: Uno switch (anche /flag/, /option/ o /parameter/) è un modificatore aggiunto a un 
comando per cambiarne il comportamento. Un esempio comune è -R (ricorsivo), che indica al 
computer di eseguire il comando attraverso tutte le sottodirectory.

• symlink: Anche link simbolico e soft link. Un tipo speciale di file che punta a un altro file o 
directory e non a dati. Permette allo stesso file di avere nomi e/o posizioni diverse.

• tarball: Un formato di archiviazione, come lo zip, molto diffuso sulla piattaforma Linux. A 
differenza dei file zip, però, i tarball possono utilizzare uno dei diversi formati di 
compressione, come gzip o bzip2. Di solito terminano con estensioni di file come .tgz, .tar.gz o 
.tar.bz2.
Molti formati di archivio sono supportati in MX con un'applicazione grafica chiamata 
Archive Manager. Di solito un archivio può essere estratto semplicemente facendo clic con 
il tasto destro del mouse su di esso in Thunar.

• (U)EFI: Unified Extensible Firmware Interface è un tipo di firmware di sistema utilizzato 
nelle macchine recenti. Definisce un'interfaccia software tra un sistema operativo e il 
firmware della piattaforma e rappresenta il successore del vecchio BIOS.

• Unix: Anche UNIX. Il sistema operativo su cui si basa Linux, sviluppato alla fine degli anni 
'60 presso i Bell Labs e utilizzato principalmente per server e mainframe. Come Linux, Unix 
ha molte varianti.

• UUID (Universally Unique IDentifier). Un identificatore univoco universale (UUID) è un 
numero di 128 bit che identifica oggetti o dati Internet unici.

• gestore di finestre: Un componente di un ambiente desktop che fornisce le funzioni di base 
di massimizzazione/minimizzazione/chiusura/spostamento delle finestre nell'ambiente GUI. 
A volte può essere usato come alternativa a un ambiente desktop completo. In MX Linux, il 
window manager predefinito è Xfce4.

• X: anche X11, xorg. Il sistema X Window è un protocollo di rete e di visualizzazione che 
fornisce finestre su display bitmap. Fornisce il toolkit e il protocollo standard per la creazione 
di interfacce grafiche (GUI) su sistemi operativi Unix-like e OpenVMS ed è supportato da 
quasi tutti gli altri sistemi operativi moderni.


